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HIPAA Enrollment Master

1.1

Introduction

About HIPAA Enrollment Master

Electronic Data Interchange (EDI) is standardized in the USA and behind much of the
economic success of this country. From ATM transactions over phone bills between
carriers to Wal-Mart's supply chain, commerce relies on standardized electronic data
interchange.

The HIPAA act mandates that "Benefit Enrollment and Maintenance” transactions need to
be transmitted in a standardized way. The 834 standard is designated to contain benefit
enrollment and personal maintenance data. Typically, such information is exchanged
between a benefit sponsor such as a government program or private employer, and an
insurance company or a trade union and its third party administrator (TPA). The 834
Transaction is the HIPAA-compliant Benefit Enrollment and Maintenance Transaction. Its
purpose is to electronically transmit enrollment and dis-enrollment information.

The HIPAA Enrollment Master is a powerful tool to work with EDI 834 enrollment
transaction files.

What is an EDI file?

X12 is an ASCII standard. This means that all the content of a transmission consists of
ASCII characters. ASCII or text files can be viewed and edited with a regular text editor.
Below you see an EDI file opened with Notepad. It opens alright but since EDI does not
use line feeds and carriage returns to mark the end of a line, an EDI document is usually
very hard to view.

© <2003> Martin Scholl Consulting, Inc.



Introduction 3

534 _09.edi - Notepad

File Edt Format Wiew Help

[sasoow woow OG0 2345720000 %01¥Q0E3877320000 -
02100712100 002 00% 000000038 0 T 1 ~GS¥BE¥S0L2 34 57 2000% 90888773 2000% 2002100716
15885 T*004 010x:09581~ST¥E534 %1234 5~BaN¥00%L24 56% 20021007 L200%*¥* 2 .REF*38%*11111~D
TP¥007%08% 20030101 ~N1YPS¥*SPONSORYFIY1 234 56654~ N1 YINYPAYERYFIY6544 565654 ~NL¥TV¥BRO
KERYFI%2344 56654 - aCTY¥I55% Wbt udd 55554 ~INSYy ¥ 1BY021 ¥ 20%ak Ak Aoy ¥y ¥ D% 20030602 ~RE
F*OF*11111 ~REF*1L*2111]1~REF*23%3000L~REF*:O*L2~DTP*3 506%D8* 200301 01~-DTP¥357¥DE¥20
030401 ~DTP*336%DE% 200304 0L ~MML*T L ¥*1 “GONZAL ES*FRANKYA¥¥H34 %] 234 567B9-N3*584 DORO¥S
UITE 225-N4%SAN JOSE¥CAYOIGZ2WWIYWSANTA
CLARA~PER*IP¥*WP*7o37 072081 *HP*111111112] ~DMG*DE* 197 S0L0L *M*M*C ¥ LI CM%1%4 25, 25%4
O¥ITH*F LM T D2 *LO0=AMT P33 % 2 0eiM T *Z L% 5 Qe T ¥ B 9% Qe HLH* ¥ 74 ¥ 50 2L 0L UT ¥LD™ 12 3% ¥ 3=
M1%31%]1~M3I*MATLING ADDRESS¥SUITE 225-MA¥SAN JOSEXCAWOIO22WHCYy SANTA
CLARA~NML *ESY 2 *EMP
LASTH*FIRSTHMI**SUFFIX*ZZ %12 34~PERYER**HP* Q021234 567 *WP 0021234 560~NI¥6E40 VIA
DEL ORO%SUITE 225-mM4%San JOSEXCAWOIGZ2WHCYHSANTA
CLARA~NML ¥MEY 2 ¥ SCHOOL~PERYEP¥HTEWS021234 567T¥F=¥0021 234 560~N3 %6840 VIA DEL
OROSUITE 225~-N4¥SaN JOSE¥CAYG3022%%Cy¥SANTA CLARA~MML*SI*1%CUST PARENT
LASTH*FIRST*MI**SUFFIX*ZZ%1234d~PERYPQ¥**HP 6021234 567 *WP*9021 234 565~-N3%CUS PARENT
ADDRESSL~-N4%SAN JOSEXCAWOIO22WW YRS aANTA CLARA-MML*EL*1*RESPONSIELE PARTY
LAST*FIRST*MI**#34%]1 234 58560-PER*RP**TEXG021234 56T*Fx¥60212 34 560-N3*RESP
ADDRESSHSULITE 2253~MN4%SAMN JOSE¥CANO30Z2%SCY*SANTA
CLARA~DSBY L WW M E RO B3~ DTP¥I60%DE*200302L0-DTP¥36L¥DE¥ 200304 LO~HD¥ Q2L ¥ ¥HLT*PLAN
b BCD®FAM~HD¥021¥4PLG¥PLAN A
BCD¥ESP~DTP*343%D3% 20030531 0~-DTP*349%03%* 2003 06L0--AMT*CL ¥ 2 0--REF~*LL %1234 56~IDC*PLAN
COVERAGE ¥H¥ L% L~ L~NML*P3 1% JOHNSON*BARBARAX ¥ ¥ ¥FI %54 255555 9%2 S~Nd “SAN
JOSERCAMS3E22%¥CYHSANTA
CLARA~PER®IC**TE*S021124 564 ~PLAZ*LP*20030212%%2 2~COB*P*334 56 L~REF“AP*112 3 2~N1¥
IN“OTHER INSURER
NAME®FI*334 56--DTP¥344 ¥*DE*20030L0L--DTP¥345%D3% 200304 0L ~SE¥1O%]1 234 5-GE¥1¥E3~IEAV]L™
QOO0Q008~-

=

A view of raw EDI data

The HIPAA Enrollment Master parses 834 EDI files and the information for each individual
transaction is extracted. Code sets are translated into their descriptions. The result can
either be:

e displayed on the screen,

printed to image, PDF and paper,

saved as delimited ASCII file,

saved as MS Excel spreadsheet,

exported to any ODBC-compliant database like MS SQL Server, Oracle or IBM AS400.
Enrollment records can be viewed from the database and packaged in a new EDI 834 file.

The HIPAA Enrollment Master is a configurable EDI translator as well as it allows to view
and "read" EDI information without much training and without wading through obscure
EDI files. EDI files that contain Benefit Enrollment and Maintenance Records can now be
parsed with the HIPAA Enrollment Master.

© <2003> Martin Scholl Consulting, Inc.
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2 Getting Started

2.1  Starting the Application

Once the HIPAA Enrollment Master is installed, you can launch it from the "Start” menu:

Start » Programs (All Programs) » HIPAASuite » HIPAA Enrollment Master » HIPAA
Enrollment Master.

HIPAASuike
% HIP&A Claim Payment Master
=L Manual For HIPAA Claim Payient Maste
HIPAS Buthorizer
HIFAS Claim Master
HIPAA Comm Center
HIPAA Ebgibilty Responder
HIPAA Enrollrent Mastar

r—] HIPAA Enroliment Master

& Manual For HIPAA Enroliment Master
HIPAA Presmium Payrent Master
HIPAAC laimSkabusResponder

HIPAGsyibe
i |
L Back.
I Search programs and files 2]

The HIPAA Enrollment Master is launched from the "Start” menu

The following screen will appear:

© <2003> Martin Scholl Consulting, Inc.
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B21 HIPAA Enrollment Master - 64bit

File  View Datsbase CodeSets Image Setup Log  EDIExchange Help

—Output Mode ———————

¥ Screen

" Prirter

™ Spreadshest File
= ASCIl File

™ Image File

[ Data Export
— Counter

Run ” |

Run with
compliance check

Mo update available .:

The HIPAA Enrollment Master main window

Once the main program window is opened, the normal operation now would be to open
an EDI file or a folder. See:

¢ Processing a Benefit Enrollment File

e Working through an Entire Directory

Processing a Benefit Enrollment File

Follow the instructions below to open a single EDI 834 file, parse it and display its details
on screen in easy-to-read table format.

1. Go to File » Open in the main menu.

© <2003> Martin Scholl Consulting, Inc.
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F,—'l HIPAA Enrollment Master - 64bit

Sedect Printer

Exit
RS T

" ASCI File
" Image Fie

The "Open” menu

Alternatively, click on the "Open Document” icon shortcut located on the program
toolbar.

FAHIPAA Enroliment Master - 64bit

View Database CodeSets Image Setup Log EDIExchange Help

Open Document® |
¥ Screen

The "Open” button

2. The Windows "Open File" dialog box will come up and you can select the file that you want
to process. Browse through the folders and select a file with . edi extension. Click
"Open.”

Note: Only claim files in "ANSI 834" format can be opened via the HIPAA Enrollment Master. The
program will display an error message if you select a file in a different format.

Reference: The 834 Transaction is the HIPAA-compliant Benefit Enrollment and Maintenance
Transaction. Its purpose is to electronically transmit enrollment and dis-enrollment information.
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8 HIPAA Enrollment Master

A choose EDI file =

()L ) |1 - riPAAsste - HIPAA Enrolment Master ~ Sangies v K83 [ search Sampes 10)

Organize v  Mew folder

I Favorites I—
B Ceskiop
% Co - A a34_09.edi 2/5/2012 12:07 PM EDI File
| Recent Places

|Datamu-|fied Type |

2(5/2012 12:07 PM EDT Fils

ol Libraries
#| Documents
o Music
= Pictures

H videos

M Connpuber
&% Local Disk (C:)
3 DATAPARTL (D:)

t‘ﬂ Mebwork LI ‘I

| |
File name: |334.edi E' [ files () =l

Com Y. ome

S
The "Choose EDI File" window

3. Make sure the program tool bar is displayed in the left area. To display the left
program bar with options, select View » Info Bar.

4. The filename of the opened file is displayed in the "Counter” pane.

© <2003> Martin Scholl Consulting, Inc.
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EAHIPAA Enroliment Master -

File  Wiew Database Cod

- > Ver]

Dutput Mode
¥ Screen

" Printer

" Spieadshest File
" ASCH File
 Image File

[ Data Export
-~ Courter

((3es

Records

Run > ‘

A filename displayed in the "Counter” pane

5. Select one of the following modes in the "Output Mode" box. The Output mode defines
the destination where the result file will be sent to. In our example, we select the
"Screen” mode.

The HIPAA Enrollment Master goes through an 834 EDI file and puts out the individual
enrollment records according to the following options:

e Screen — Allows to display the records one by one on the screen in a preview
window. The default output mode is "Screen.” This mode is not available while
working with a directory.

¢ Printer — Allows to send the opened file(s) as batch to the selected printer. Read
more in Printing the Records.

e Spreadsheet File — Allows to save the opened file(s) to a spreadsheet file. Read
more in Creating Spreadsheets.

e ASCII File — Allows to save the opened file(s) to a tab delimited ASCII file. Read
more in Creating ASCII Flat Files.

¢ Image File — Allows to save the opened file(s) as TIFF or PDF file. Read more in
Creating Image Files.

e Data Export — Allows to export the opened file(s) to an external ODBC/OleDB-
compliant database. This function works together with the output modes other

© <2003> Martin Scholl Consulting, Inc.
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than "Screen.” When you select the "Data Export” check-box, an output mode option
can be selected. This allows you to print/create files and export to a database
simultaneously. Read more in Exporting the Data.

E]Hlpn.ﬂ. Enrollment Master -

File  Wiew Database Cod

| >
Qutput Mode
Screen
Printer
Spreadshest File
ASCI File:

"}*.I".l"}'i‘.']

Im=ge File

[ Data Export
— Counter
B34 edi

S —
Run ?

The "Output Mode" options

6. Click on the "Run" button.

© <2003> Martin Scholl Consulting, Inc.
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E‘!HIPAA Enrollment Master -
Wiew Database Cod

Dutput Mode
&+ Screen

" Printer

" Spreadshest Fis
" ASCH File

" Image File

[ Data Export
— Counter

Aucats [ ]

=% )

The "Run” buttons

7. When you click on the "Run” button, the file will be parsed and the information
displayed. The HIPAA Enrollment Master recognizes the type of the EDI transaction and
displays Benefit Enrollment and Maintenance Records. In our example where the output
mode is "Screen,” the Benefit Enrollment and Maintenance Transaction is displayed in a
preview window.

© <2003> Martin Scholl Consulting, Inc.
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HIPAA Enrollment Master

View Enrollment Record

* Print | Close | Mext

Enroliment Record

The display of a Benefit Enrollment and Maintenance Transaction

Transaction: Purpose |ID Date Time Transaction D Action Code | Policy Number Effective Date
Original Jm&s 10/7/2002 12:00:00 PM J luwm 11111 |1mzoos
Sponsor SPONSOR Fayer PAYER TRaBroker BROKER Account Numbe
D FI 123456654 D Fl 654456654 L] 234456654 365 : 4456654
Insured Information

SubfDep Relationship Maint. Typs Maint. Reason Ben. Status Medicare Plan Code Handicap
Subscriber | Self Addition Active Active Medicare Part A | Yes
COBRA Qualitying Event Employment Status Student Status |B-1h Order Death Date

Medicare Active Military- Mot Student 61212003

Subscriber Number Member Policy Humber | Chent Number | |

1111 21111 30001

Eligibilty Begin Elgibilty End Employ Begin Prior Months. Cov.

1:%!2:%3 . |4ﬁrz%3 |l.|‘1!2ll|:|3i | |12

Member Last Mame First Name I Maciclie 55N ¥ork Phone Mumber Home Phone Number

NZALES FRANK A 123456789 (763) 797-2981 (111) 111111

Address El‘"y State [Zip Country [Courﬂv Birth Date ISex
68400R0 SUITE 225 N JOSE CA 93822 SANTA CLARA 111975 (M
Maritial Status Face Citizanship Language Health related Codes Height Weight
Marriad Caucasian U.5.Citizen 12:;i Hative |Tobacco and Substance A|74 |M

Member income | income Frequency | Hours Worked |Denarh'nen: Salary Grade Dsabl; Type Disability ICD-9 Code
425.25 Weekly 40 T F1 Short Term Disbity 585

Pramium Amaunt Deductible Amount Co-Payment Amount | Co-Insurance - Actual | | Disabilgy From Disability To

20.00 |1l}ﬂ.Dﬂ |5I]M |au.m 2102003 41002003

Mailing Address Information

Mailing Address City State Zip

MAILING ADDRESS SUITE 225 | SAN JOSE CA 93822 | [
Employer Information

Employer Hame Employer D Home Phone Humber Work Phone Humber

EMP LAST FIRST M1 I1234 {902) 123-4567 |[902] 123-4569 |
Address City State Zip |

6840 V1A DEL ORO SUITE 225 SAN JOSE CA 93922

School Information

School Name IScnoalD |'e|eg!1ane |Faumte |
SCHOOL {902) 123-456T7 (902) 1234569
Address City [Slm Zip

6840 VIA DEL QRO SUITE 225 SAN JOSE CA 93922

T T P TP Y e PN B

See also: Understanding Benefit Enrollment and Maintenance Records.

8. The number of records in the opened file is displayed in the "Counter” pane.

_'-'"':_!I_HIPH.II. Enrollment Master

Fie Wiew Database Cod

= > |

 Dutput Mode
* Screen

" Piinker

" Spreadshest File
" ASCIl File

" Imaoe File

The number of records

© <2003> Martin Scholl Consulting, Inc.
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2.3 Working through an Entire Directory

The "Open Directory” function works only when the output mode is not "Screen” as it does
not make sense to open a whole directory to view a file on the screen.

Tip: Once the EDI files have been printed or exported, it makes sense to remove the source files. It is
recommended to do when the HIPAA Enrollment Master is run automatically through the Windows
Scheduler. In the "Setup” window you can specify if to delete the files after processing.

Follow the instructions below to open a batch of EDI files located in one folder.

1. Make sure the "Output Mode" option is not "Screen.” The Output mode defines the
destination where the result file will be sent to. The output modes are described in
Processing a Benefit Enrollment File.

Note: You cannot display a batch of EDI files on screen in a preview window, it is possible only for one
file. See Processing a Benefit Enrollment File.

Dutput Mode
P

™ |Printer

1+ |Spreadshest Fie
" |ASCI File

r

Image File

The "Output Mode" options

2. Go to File » Open Directory in the main menu.

FEIHIPAA Enrollment Master - 64b

Select Printer

Exk
T F SeToReetT e

" ASCI File

The "Open Directory” menu

3. Browse for the folder containing EDI files. Click on that folder and then click "OK."

Note: Only claim files in "ANSI 834" format can be opened via the HIPAA Enrollment Master. The

© <2003> Martin Scholl Consulting, Inc.



14 HIPAA Enrollment Master

program will display an error message if you select a file in a different format.

Reference: The 834 Transaction is the HIPAA-compliant Benefit Enrollment and Maintenance
Transaction. Its purpose is to electronically transmit enrollment and dis-enrollment information.

Browse For Folder

Choose Folder

2l

H’ Deskiop
# (L) My Documents
= § My Computer
A (A 3.5 Floppy
B < (C:) SYSTEM
H# Doguments and Settings

2

The "Browse for Folder" popup

4. Click on the "Run" button to send all files from the folder to the destination.

Note: The pre-defined settings will be applied. See also: Configuring Program Options.

_!"'?-J_HIPAA Enrollment Master -

II'"
" ASCH File
-

Irnage File

™ Data Export
~ Counter

ST —
e —

=5 )

The "Run" buttons

© <2003> Martin Scholl Consulting, Inc.



Getting Started 15

5. The displayed "Processing Results” popup will report the results of the operation.

Frocessing of the file 334 edi began at 2/25/2013 7.56:36 P -
Enrollment Records will be expored to Excel
The file 'FA31834_1 xls' has been created
1 Records have been processed
Murmber of Records in File: 1
[t ook 0 minutes, 3812 seconds to process this file
The average time was 3.813 seconds per record
Processing ended at 2/25/2013 7:56:43 P

Frocessing of the file 334_09.edi began af 2/25/2013 7:56:43 Fi
Enrollment Records will be exported to Excel
The file 'F\34534_09 xl=' has been created
1 Records have been processed
Mumber of Records in File: 1
Ittock O minutes, 2.875 seconds to process this file
The average time was 2 875 seconds perrecord
Frocessing ended at 2/25/2013 75646 Ftd

The "Processing Results” window

6. The number of processed files and records is displayed in the "Counter” pane.

FAHIPAA Enrollment Master -
File Wiew Database Cod

=

 Dutput Mode -
' Seeen

" Prinker

" Spreadshest Fis
% ASCI File

" Image File

[ Data Export
Counter

coes

Reconds

The "Counter” pane

2.4 Understanding Benefit Enrolilment and Maintenance Records

Benefit Enroliment and Maintenance Records and EDI files are displayed on screen like in the
form below.

© <2003> Martin Scholl Consulting, Inc.



HIPAA Enrollment Master

Yiew Enrollment Record ﬂ
: Print | Close | MNext = 1/1 — Help
Enrollment Record
Transaction: Purpose [ID Date Tima Transaction D Action Code | Policy Number Effectiva Date
riginal Jmss 10/7/2002_12:00:00 PM J JUpdm 1111 |1mzoos

Sponsor SPONSOR Payer PAYER TR Broker BROKER Account Humbe,

D Fl 123456654 D Fl 654456654 L] 234456654 365 : 4456654

Insured Information

SubDep iRelM-onsnn Waint. Type Maint. Reason |Ben_.s1atus Wedicare Plan Code | Handicap

Subscriber | Self Addition Active Active Medicare Part A | Yes

COBRA Quakfying Event Employment Status Student Status Birth Order Death Date

Medicare |m:m Military- Not Student | ISFZI?I'.IM

Subscriber Number Member Policy Humber Chent Humber

11111 | 2111 30001 |

Elgibiity Begin Elgibilty End E Hagn Prior Months Cov.

1:%!2 3 . |4ﬁrz'353 |ﬂ£5030 | |12

Member Last Name First Name Middie 55N Work Phone Humber Home Phone Number

GOMNZALES FRANK A 123456789 (T63) 797-2981 (111) 1111111

Address Igg State |Zip Country [coum Biih Date | Sex

68400R0 SUITE 225 N JOSE CA 93922 SANTA CLARA 111975 (M

Maritial Status Race Ciizenship Language Health related Codes Height ‘Weight

Married Caucasian |U.S.Etlmn 123u Native |Tobacco and Substance A 74 |GD

Member Income 1 income Frequency | Hours Worked [Department Salary Grade Dsann}ﬁ-ne Y Disabity ICD-9 Code

425.25 Weekly 40 T F1 Short Term Disbity 585

Premium Amount Deductible Amount Co-Payment Amount | Co-insurance - Actual | | Disabilgy From Disabily To

20.00 100.00 |5|'.I'DD |40.DD 2102003 41002003

Mailing Address Information

Mailing Address City State ZIip

MAILING ADDRESS SUITE 225 SAN JOSE CA 939822 | [

Employer Information

Employer Name Emgployer D Home Phone Numbser Work Phone Humber

EMP LAST FIRST MI I123¢ | (902) 1234567 (902) 1234569 |

Address City Etate Zip

6840 VIA DEL ORO SUITE 225 SAN JOSE CA I93922

School Information

School Name IScnwl [3] | Telephone Facsimie |

SCHOOL {902) 123-456T7 (902) 123-4569

Address City [Slm Zip |

6840 VIA DEL ORO SUITE 225 SAN JOSE CA 93922

e e P P T L WL i

The Benefit Enrollment and Maintenance and Benefit Window, the header record

This form displays most of the possible information that an 834-transaction set can contain.
Usually many of the fields are blank. If there is no "School" or no "Employer" information, the
whole block on the screen will not be displayed.

Most EDI code set are translated into their descriptions, so they are easily understandable.
Each enroliment record can contain up to 99 benefit records.

Below you see the screen for 2 benefits.

Coverage Information:

1 WMantenance Type Insurance Line Description Coverage Level
Addition Health PLAN A BCD Family
Mamtenance Type Insurance Line Description Coverage Level
Addition Prescription Drug PLAN A BCD Employee And Spouse
Benefit Begin Benefit End
5110/200 61012003
Co-Paymant &mount
Group/Policy Mumber 1234.56
identification Cards | Description: PLAN COVERAGE | Type: Health Insurance |Quantey: 1 [Action: Add
2 Primary Care Provider JOHN SON BARBARA |F=ﬂ=fI|TﬂH 0 542555555 [Rtl. Established Patient
City State Zp ICuquy | County
A SAN JOSE CA 93922 SANTA CLARA
Telephone  (502) 1123564 |
PCP Change Reason: Plan Change | Etfective Date: 21212003
COB Type Palicy Number Coordination of Banefits Code | Group Numbér
Primary |334£6 COB |I1 232
a Hame Federal Tax D Coordination of Benefis Begin |cnnrdnamn of Banefits End
OTHER INSURER HAME 33456 1M1/2003 4172003
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Benefit Enrollment Preview

To print this form, click on the "Print" button. Read more in Printing the Records.

View Enrollment Record x|

@ Close | Mest — 1/1 — | Help |

Enroliment Record |

The "Print” button

2.5 Printing the Records

The same forms that you see on the screen can be printed. Files from the opened folder
can be batch printed. Follow the instructions below.

1. Open an EDI file or directory containing the EDI files in the HIPAA Enrollment Master.
Read more in Processing a Benefit Enrollment File, Working through an Entire
Directory.

FAH1IPAA Enrollment Master - 64bit

Select Printer

Exit

= ASCI Fie

The "Open Directory” menu

2. Select the "Printer” option in the "Output Mode" block.
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HIPAA Enrollment Master

— Dulput Mode

" Screen
\q__ﬁ' Printer )
" Speeadshest Fie
" ASCI File
" Image File

The "Printer” option

3. Click on the "Run” button.

mHIPAA Enrollment Master -

The "Run” buttons

4. The "Save the file as" window appears. You can save file as XPS document.
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{:),,;:, ||~ HIPAAsute ~ HIPAA Envoliment Master » Somples v K23 [[search samples 0]
Organize + | Mew folder = - ®
- Eaverites Name ~ | Date modified Type

Mo items match your search.

-~ Libraries
% Computer
€l Network
| |
Fie name: | B EI
Save as type: |31:P‘E. Document {*.xps) j

= Hida Foldars I Save I Cancel |

5. The records will be spooled and your selected printer will start to output the file. Be
aware that some EDI files contain thousands of records.

Tip: You can choose the color of the underlying form to be red or black. See Configuring Program

Options.
Processing Results [_ O] x]

Processing of the file 834.edi began at 117/2013 25238 PM
Enroliment Records will be printed
1 Records have been processed
Mumber of Records in File: 1
[ttaok O minutes, 37 937 seconds to process this file
The average time was 37938 seconds perrecord
Processing ended at 1/17/2013 25316 PM

The "Processing Results” window

2.6 Requesting a Trial Extension

Once your trial period has expired, the application will stop working. If you want to
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20 HIPAA Enrollment Master

continue your trial of the product, then you will need to send your request to the support
team. Follow the instructions below.

1. Launch the application. Read more in Starting the Application.

2. Click on the "Ask for trial Extension” button on the displayed window.

HIPAA. Enrollment Master
324
_Daﬂu] remaining for trial 0

This software is for evaluation purposes only and has limited

functionality
You will have to purchase this software if you want to continue using it
after a free evaluation has expired.
285CDES2 Ask for tial extension ||| Order Regster |

— —

The "Ask for trial extension” link

3. The "Features and Licenses" window opens. Define the necessary options and click the
"Request Trial License” button.

Features and Licenses

HIPAA Enrollment Master

Trial Key: Erter License Key |

Product Features: ( Request Trial License w
Image Creation C On © Of F;d to License Request I"
Work with Database ¢ 0n  © Of Add to License Request [
File Creation © On © Of Addto Licenss Request [

EDI Exchange:

Evaluation version Enter EDI Exchange Key |

@ on C Of Request EDI Exchange License |

Save Close I
b

-,

The "Features and Licenses” window with highlighted "Request Trial License” button

Note: The "Features and Licenses" window can also be accessed via the "Features and Licenses" menu
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under the "Help" main menu.
4. The following options are available:

* Product Features — The list of features that can be enabled/disabled. The "Add to
License Request” checkbox allows you to request a license for the current feature. A
trial license covers all these features by default. The capabilities of the software are
split into licensed features. The base model allows the viewing and printing of
enrollment records. Image file creation, database connectivity, and 834 creation
are separately licensed features:

¢ Image Creation — Find more information about the feature in Creating Image
Files.

e Work with Database — Find more information about the feature in Exporting
the Data.

¢ File Creation — Find more information about the feature in Creating ASCII Flat
Files.

e EDI Exchange — Find more information in the "EDI Exchange" chapter.

5. Clicking on the "Request Trial License” button will create an email to HIPAAsuite with
the registration number so they can then create the extension key. For example, this
will open Outlook with the following data inserted:

e To: info@HIPAAsuite.com
e Subject: [HIPAA Enrollment Master][123456789]: Request for trial extension key

* Message:
Request for Trial License Extension
Product: H PAA Enrol |l ment Master
Vol une | D 123456789
Al ready |icensed features:
| mage Creation,
File Creation,
Work with Dat abase
Required new features: No new features selected to request for |icense
Current Key:
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22 HIPAA Enrollment Master

[HIPAA Claim Payment Master][2Z83AEFTA]: Request for trial extension key - Message [HTM.. -8 X

Message

To... | |n|‘u@t-|[PAA5uhe.cum
Send Cen | |

Subject: |i|-|P,c..,..'.. Enroliment Master |[123456785]: Request for trial extension key

»

Volume ID: 123456789

The trial extension request email
5. The response from the support team should include an activation key.

6. Once you have received the activation key, click "Register” on the program welcome

window.
Q License
HIPAA Enrollment Master
324
Day(z) remainireg for trial 0
This software is for evaluation purposes only and has limited
functionality
You will have to purchase this software if you want to continue using it
after a free evaluation has expired.
285CDES2 Aok fortialextension | Order [ Register
e ——

The "Register” button

7. Paste the activation key into the field on the Registration Form and then click
"Register.”
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icense Registration Form
HIPAA Enrollment Master

e
License Key ([111-111-111-111] )
| Regteter I:I Cosa

‘:"'I—r"',

The "Registration Form" window with entered license key and highlighted "Register” button

8. The success message will appear in the "Result” border.

icense Registration Form
HIPAA Enrollment Master

License Key  [111-111-111-111

m Closs

Result

Thank you for evaluating HIP&A Enrcliment M asted

Thiz iz a full functional version of HIP&A Ennoliment Master for evaleation wuse only.
Thiz evaluation version expires in 15 days

EDI_Exchange component iz nol registened.

The license activation result

Click "Close".

9. Once the license key has been entered, click "Try" on the welcome window to continue
using the program for another 15 days.
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24 HIPAA Enrollment Master

HIPAA Enrollment Master
324
Daﬂ:] remaining for trial 15

This software is for evaluabion purposes only and has limited

functionality
You will have to purchase this software if you want to continue using it
after a free evaluation has expired.
2E2F5160 Try Order Regater

The "Try" button
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26 HIPAA Enrollment Master

3 Configuring the Application

3.1 Configuring Program Options

The HIPAA Enrollment Master has a setup screen where you can configure the most

common options.

1. To configure the program options, select Setup » Options in the main menu.

FAHIPAA Enrollment Master - 64bit

File View Database CodeSsts

A
~ Output Mode

™ Screen

% Printer

The "Options” menu

Irmge_Eau.p Log EDIExchange Help

Spreadshest File Sstup
Company Setup

Create Company Setup Table

Alternatively, you can click on the "Options” button located on the main toolbar.

F’!_]HIPAA Enrollment Master - G4bit

File View Database CodeSets Image Setup Log EDIExchange Help

>

The "Options” button

@9 e

2. The following screen will appear.

[H options

M[=] E3

— Excel Files

Output Path for xis Files |

"~ ASCII Files

Output Path for ASCH Files |

Browse )
_Browse |

Browse

& |eave in Place © Move ™ Delats
oved File Director
~Log [~ Document Color
I Keep a log of every file processed ‘ [~ On Screen | [ On Paper
- Update # Red ' Red

r Never check for update

" Black " Black

__sme |

Help |

The "Options” window
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You can configure the following options:
e Set the directory to which ASCII text files will be saved
e Set the directory to which Excel files will be saved
e Determine what to do with processed files
e Determine the document background color for screen, and prints
e Set up whether you want to log every activity apart from viewing
e Check whether to suppress the update check

Read the detailed descriptions further.

3. Once you have finished editing the options, click "Save."

Troubleshooting: The settings are saved to the Windows registry and will be retained for the next time
you run the program. Check your permissions to write to the registry if you encounter any problems
with saving settings. Your administrator might help you.

Excel Files

e Output Path for XLS Files — Define the destination folder where the Excel files will
be stored. See also Creating Spreadsheets.

ASCII Files

e Output Path for ACSII Files — Define the destination folder where the ACSII files
will be stored. See also Creating ASCII Flat Files.

Processed Files

Since the HIPAA Claim Payment Master program can be launched by the Windows
scheduler (see Running the Application via Scheduler), it is important to either move or
delete processed files, so that they will not be picked up again. Processed files will only be
moved for output options other than "Screen.” You have the choice to either do nothing,
move the processed files to a specific folder or delete the files:

e Leave in Place — Select this option to do nothing with processed files.
Note: Not recommended.

* Move — Select this option to move the processed files to a specified folder
("Moved File Directory").
e Delete — Select this option to delete the processed files.
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HIPAA Enrollment Master

3.2

Document Color

You have the choice to render the form in red or in black. The following options may be
defined:

Note: The data values are always black.
e On Screen — Choose a color for the form when displaying claims on screen.
e On Paper — Choose a color for the form when printing claims.

Log

The HIPAA Enrollment Master has the ability to keep a log of EDI file processing. The log
writing is mandatory in the program. See Accessing Logs.

The following option is available:

e Keep a Log of Every File Processed

Update

The following option is available:

¢ Never Check for Update — Select this option in order not to automatically connect
to HIPAAsuite.com server and check for program updates. Read more in Upgrading
the Program.

Using the EDI Editor

EDI files are often hard to read, especially if they have no carriage returns and line feeds
to put each segment on a line of its own.

The EDI Editor available in the HIPAA Enrollment Master replaces all element separators
with a star "*", all sub element separators with a colon ":" and all segment separators
with a tilde "~" even if the original file uses different delimiters.

To Open EDI Editor

To access the EDI Editor, select the "EDI Editor" option under the "View" menu item.

FAHiPAA Enrollment Master - 321

Fibe | t'ieu_a_ | Dwatabase  CodeSe
@E’_] Info Bar _
3
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The "EDI Editor" menu

Alternatively, you can click on the "EDI" icon on the toolbar to invoke the EDI Editor.

This option is only enabled when you have opened an EDI file.

FAHIPAA Enrollment Master - 64bit

The "EDI Editor" button

The following screen will appear:

! File: 2,02 DHCSE34-DAZDL 10T 12-Dental-495-HCP-001.edi

=10 x|

Save |

1
2
a
4
5
b
7
B
9
D
2
3
4
b

16
17
13
20
21
22
23
24
25
26
27
28
29
30
3

32
33
K
35
36
37
38
39
40
42
43

ISA=00™ 00~ =ZZ*CALIFORMIA-DHCS=ZZ*777888999  *111025"1127~"00501=0000000071 0T~
GS*BE*CALIFORNIA-DHCS*77788599920111025™1127551"x*00501 022041
ST=B34*0007+005010X22041

m‘;m‘gHC%M-DA—WI 10712-777888999-001*20111025*1 12755002~
QT "3~

M1*P&*California Department of Health Care Services *Fleg-0317191™~
N1*IN*Dental Plan 495*FI*7 77888969

INS™Y*15"001*AI"A"E™AC™

REF*0F*23456789E™

REF™1L=222222222™

REF*17=201205;~

REF*23*1;20061214.™

REF*3H"193Mx2XC7 772101 SMITH AMY:038™

REF"60™ A AY 11~

NMT*IL*T"PLANK*FRAN™M™

PER*IP=TE*2135551212™

NI*THIS IS LINE ONE OF THE ADDRESS*123 FRANCIS LANE™

N4*LOS ANGELES CA*CA™300391111™CY™19™

DMG*DE* 19841125 F~RET-2106-3™

HO*021DEN"485.01™

DTP*345*D&8~20110701™

OTP*349°D3%20110731™

REF*CE*3N:401:::::™

REF*RE*3N™

REF*ZX*19™

HD*021**DEN"495.01™

DTP*345*Da*20110801™

DTP349°D&8~20110630™

REF*CE*3N:401;:::™

REF*RB*3N™

REF*ZX*19™

HO*021**DEN*"495;01"

DTP348*D&8~20110501™

DTP*349 08720110531~

REF*RB*3N™
REFZx*19~
HO021**DEN*495.01™
DTP 345 D8*20110401™
DTP*349"D3%20110430™
REFCE=3N:401:::™
REF*RB*3IN™
REF*ZX*19™

BB e A A S e
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The EDI Editor window

To Cut, Copy, Paste

When you right-click anywhere in the text, a context menu will appear with typical text
edit options such as cut, copy and paste.

5 QTYTO3™

30 Mg %-5 California Department of Health Care Servic *rinrn noy)

Unda

7 H1*IN*Dental Plan 495°F1*7 7 78538999™

8 INS*Y"18"001"AI"ATE"AC™

9 REF"0F*23456789E™
10 REF=1L*222222222™
11 REF177201205.™

12 REF"23*1:20061214.™

13 REF3H"193MO0CT 772101 5MITH AMY;038™
14 REF60™ACAY:11™

15 NMTEIL*T*PLANKF RAN"M™

16 PER®IP™TE"2135551212™

17 N3*THIS IS LINE ONE OF THE ADDRESS*123FR.  Replace

18 N4A"LOS ANGELES CACAS003591111™CY™19™
19 DMG*DE* 19841125 F*RET:2106-3™

Context menu

To Find and Replace

The "Find" and "Replace” utilities work as in a common text editor. To use them, right-
click somewhere in the document and then from the displayed context menu select the
"Find" or "Replace” command. Alternatively, you can press Ctrl F simultaneously on your
keyboard to bring up the text search utility.

Find 21 x|

Finnd what: | Eimd West

_ Cocel |

e

™ Maich gase FU“FQ““‘|

The "Find" pop-up
Pressing Ctrl H simultaneously will bring up the Replace utility.

Fodwhat |
Reglace with: |

™ Matchcaze

The "Replace” popup
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To Save the Changes

As long as you don't save, there will be no changes to the file.

If you make changes to the file, the "Save" button becomes enabled and you can save any
changes. The HIPAA Enrollment Master will further on work with those changed files, so
you don't have to open the original file again.

Notice: Changing EDI files can be a tricky undertaking. You should be experienced in the format of the
834 and understand that an 834 claim file could be a legal document that should not be altered
without the consent of the originator.

[ File: 2.02 DHCSE34-DAZ0110712-Dental-495-HCP-001.edi =10] x|
Help '/—d_; Save )
ISA™D0" 0o~ *ZZ*CALIFORNIA-DHCS*ZZ*777888999  *111025"1127*™00501*000000001*0*T*:~ -

2 GS*BE*CALIFORNIA-DHCS*777838999*20111025%112755™1"x(* 00501022041~
ST834*00071=005010X22041™
4 BGN"00*"DHCSE34-DA-20110712-777888935-001"201 11025*11 275500~ 2™
QT TO*3™~
The "Save" button

3.3 Selecting a Code Set

EDI relies on transaction code sets. A transaction code is a basic EDI message type. The
HIPAA Claim Payment Master translates HIPAA code sets into meaningful words (a
corresponding longer explanation or description). For example, facility code "25" means a
Birthing Center, gender code "M" means Male.

At the onset of EDI one of the main design ideas was to make the EDI files as short as
possible and to allow different languages to use the same descriptions by reducing long
verbose explanations to 2-3 byte long codes. Computer storage was incredibly expensive
and making any file larger than it absolutely had to was considered wasteful.

The code sets are stored in the file codesets. xn in the Confi guration subdirectory:

Windows XP: C\ Docunents and Settings\Al | Users\Application Data\H PAAsuite\ H PAA
Enrol | ment Master\ Confi gurati on\

Windows 7, Vista: C \DrogranbDat a\ H PAAsui t e\ H PAA Enrol | nent Master\ Confi gurati on\
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. C:ProgramData’ HIPAAsuite' HIPAA Enrollment Master Configuration

@,{}, ||~ HiPAAsute ~ HIPAA Ervolment Master = Configuration » 23 [ search configuration )
Organize »  Inchudein library ~  Sharewith =  Mew Folder z + [ &
= Pictures = Name = |D.5u:rnoqﬁ|ed I Type Size | I
B videos
=" Codesets,xml ) BI4/2011 12:29 PM XML Document &1 KB
(B Computer
£ Local Disk (C:)

5 DATAPARTI (D:)

€l Metwork

1item

The Configuration folder in Windows XP

Tip: The folder is hidden.

To view/edit transaction code sets in HIPAA Enrollment Master, follow the instructions

below.

1. Go to the "Code Sets" item in the main menu.

mHIPAA Enrollment Master - Gb4bit

The "Code Sets" menu

2. From the sub-menu select a code set name. The following menu items are available via

the "Code Sets” menu:
AtoE
e ActionCode
e AmountQualifierCode
¢ BenefitStatusCode
e CardAction
e CardType

e CitizenShipStatusCode
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e COBCode

e CobraEvent

¢ CoordinationBenefitsCode

¢ ContactCode

e CoveragelevelCode

e DisabilityTypeCode

e DTPCode

e EmployeeStatusCode

e EntityldentifierCode
FtoP

e FileTypeCode

¢ FrequencyCode

¢ GenderCode

¢ IDCode

e InsuranceLineCode

¢ HealthRelatedCauses

¢ LanguageUse

¢ LocationQualifier

e MaintenanceTypeCode

¢ MaintenanceReasonCode

¢ MaritalStatusCode

* MedicarePlanCode

¢ PayerSequenceCode

¢ ProviderRelationship

¢ ProviderTypeCode

e Purpose

33
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QtoZ
¢ RaceCode
e REFCode
¢ RelationshipCode
¢ StudentStatusCode

* YesNo

The following screen-shot illustrates how to select the "InsuranceLineCode" code set for
display.

EAHIPAA Enroliment Master - 64bit

File \View Database | CodeSets | Image Setup Log EDIExchange Help

[P AtoE k i ?
& P ] Ff.,ﬁ.:)_&ﬁ

Output Mode - QteZ » FrequencyCode
¢ Screen GenderCode
% Printer IDCode
" Spreadsheet Fle (| mewancelinecode
 ASCH Fie [ HealthRelatedCauses
¢ image Fe Languagelise
LocationQualfier
I Data Export MairtenanceTypeCode
. MantenanceReasonCode
[ Counter MaritalStatusCode
B ed MedicarePlanCode '
Recos [ 1] PayerSequenceCode
ProviderRelationship
Run = ProviderTypeCade
Purpose |

The "InsurenceLineCode" sub-menu

3. The Code Set configuration window will be displayed. Below you can see the window
for InsuranceLineCode. The window displays the following fields:

e Record Count — The total number of codes. For example, for InsuranceLineCode it
is equal to 22.

¢ Codes and their corresponding descriptions. The codes are indicated in the source
EDI files. The descriptions are displayed instead of codes in the resultant easy-to-
read files. For example, for InsuranceLineCode there are the following codes and
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corresponding descriptions:
e AG — Preventitive Care
e AH — 24 Hour Care
e AJ — Medicare Risk

InsurancelineCode

Record Count |22

Code Description

L3 Preventitive Care
AH _2# Hour Care
A Medicare Rizk
AK .Mental Health
DCP iDBntaI Capitation
DEN | Dental
EFOQ Exclusive Provider Org
FAC jFa cility
.HE . Hearing
HLT Health
HMO 'Health Maint Org
LTC jLung-Tsrm Care
LTD Long-Term Disblty
[ELE] .Mainr Medical
MOD jMaiIﬁrdur Drug
PDG _F‘rucrintinn Drug
POS Point of Service
PPO iF"mi"l:l Provider Org
PRA _ Practitioners
STD Short-Term Dishlty
UR Utilization Review
VIS I'il'i:iun

Save | Help I
ﬁ.

The "EnsurancelLineCode” code set configuration window

4. Click on the "Save" button to save the changes.
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3.4

InsurancelineCode M=
Record Count |22

Code Description

L4 _ Preventitive Care
AH _2# Hour Care
Ad Medicare Risk
AK .Mental Health
DCP il'_'lnntal Capitation
DEMN _Dentul
EFOQ Excluzive Provider Org
FAG | Facility
HE . Hearing
HLT Health
HMO Health Maint Org
LTC _Lung-Tsrm Care
LTD Long-Term Dizhity
[ELE] .Mainr Medical
MOD jMailﬂrdur Drug
PDG _F‘rc:criptinn Drug
POS Point of Service
PPO Pref'd Provider Org
PRA _ Practitionérs
STD Short-Term Disbity
UR |Utilization Review
VIS Vizion

{ Save | ) Help I

The "Save" button

Accessing Logs

The HIPAA Enrollment Master can log its activities. This is especially helpful when running
the program automatically through the scheduler (see Running the Application via

Scheduler).

Notice: To start logging the activity, activate the "Log All Processing Except Viewing" option. See
Configuring Program Options.

In case of any problem, the first thing is checking the log, where all actions and all error
messages related to an EDI file or written down and saved.

Follow the instructions below to access the log files for your HIPAA Enrollment Master.

Click Log » Daily Log in the main menu.
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EAHIPAA Enroliment Master - 64bit

File View Database
i > e
I

The "Log" menu

This menu allows you to see today’s log if it exists. You can select other dates using the
date picker or by typing in the date box.

Log files are simple text files, one for each day that are stored in date hashed folders.
Alternatively, access the Logs folder in the following directory:

Windows XP: C:\ Documents and Settings\All Users\Application Data\Hl PAAsuit e\ H PAA
Enrol | ment Master\Logs

Windows 7, Vista: C:\ DrogranDat a\ H PAAsui t e\ Hl PAA Enrol | ment Master\ Logs

. C:\ProgramData’ HIPAAsuite\HIPAA Enrollment Master

G’\ J= | 1. = ProgramData ~ HIPAAsuke ~ HIPAA Enrolment Master ~ - | search HIPAA Enroliment Master 2]
Organize * o Open Inchadeinlbrary = Sharewith =  New folder = ~ [ &
b Pictures ;I Name =~ |D&emﬂiﬁd | Type Size | I
B videos
Configuration 4J232M2Z 12:00PM  Fibe Folder

B 4f2312012 12:00 PM Fie Folder

N Compuker ]
£7. L ocal Disk (C2) Samples 41232012 12:00PM  File Folder
5 DATAPRRTL (D) Seripts 232012 12:00 P File Folder

€l Mebwork

-

Logs Date modifed: 4/23/2012 12:00 PM
File Fiolder

The Logs folder in Windows XP
Tip: The folder is hidden.

Tip: The ProgranDat a folder contains all your application data, like program settings, user data, etc,
for all of the installed programs on the computer. The Pr ogr anDat a folder holds the same files that

were contained in the \ Docunments and Settings\Al |l Users and \Docunents and Settings
\Al'l Users\Application Data folders in XP.

Within the directory, find the folder for the year of the log you are looking for. Then
find the sub-folder for the necessary month with files for each day. Double-click the file
which has the name equal to the necessary date. The log will look like this:
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3.5

[ Transaction Log =10] x|

| Tuesday . May 29,2012 =] Get Log Help

Processing of the tile 202 DHCSE34-DA2011 071 2-Dental-491 2-Vendor-001 e began et 5292012 11:16:23 AM
Enroliment Record Images will be created
The file 'C\Documents and Settings\Wiudmin Wy Document s\ EDI images Output 30 ey 200 02 DHCSE34-DA2T1071 2D
The file 'C'Documents and Settings\Admin Wy Documents'E01 Images Output20 2iay 2002 02 DHCSE34-DA20T1071 2D
2 Records have bean processed
Processzing ended at 52972002 11:16:24 AM

Processing of the file 2,02 DHCSE34-DA2011 071 2-Dental-495-HCP-001 Jedi began at 52972012 11:16:24 AM
Enroliment Record Images will be created
The tile 'CiDocuments and Settings Admin Wy Document 3 ED Images OutputQ0n ey 2900 02 DHCSEE4-DAZ0T10712-D
The file 'CDocuments and Settings\Jiudmind Wy Document s\ S0 images Output\ @0 2iey' 200 02 DHCSE34-DA2T1071 2D
The file 'C:\Documents and SettingsWi.dmind Wy Document (80 Images Outputi 201 2%ey' 292 02 DHCSE34-DA20110712-Dn
3 Records have bean processed
Processzing ended at 5292012 11:16:24 AM

Processing of the file 2)02 DHCSE34-DA2011071 2-Medical-111-HCP-001 edi began ab Si29/20012 11:16:24 AM
Enroliment Record Images will be created
The tile 'CDocuments and Settings Admin Wy Document $'ED] Images Output20n ey 2902 02 DHCSEE4-DAZIT107T1 2-M
The file 'CiDocuments and Settings\Jidmin Wy Docusment s S0 mages Outpu a0 2Wiey'200 02 DHCSES4-DAOTI0TI 2-M
The file 'C:\Documents and SettingsWiudmind Wy Document S0 images Outputi 201 2y 292 02 DHCSE34-DA20110712-M
3 Records have been processed
Processzing ended at 5292012 11:16:24 AM

The transaction log for a specific day

Running the Application via Scheduler

The HIPAA Enrollment Master can be automated through the Scheduler. A scheduler is
software that can be programmed to execute a certain task at a certain time
repeatedly. Windows has such a scheduler built in.

The Windows scheduler can be used to let the HIPAA Enrollment Master execute in regular
intervals without user intervention. Usually one would let the HIPAA Enrollment Master
scan a directory and then print, create image files or export the data and remove the
files to prevent duplicate processing.

1. If the task scheduler is installed on your system, you will find it in the "Control Panel'.
To open Scheduled Tasks, click Start » Control Panel » Scheduled Tasks.

Note: In different Windows versions, the way to access the Task Scheduler can differ. Consult your
Windows version documentation.
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8 Scheduled Tasks =10l =]
File Edt View Favorites Tools Advanced Help | &
Qeeck - () - :j‘.|f_jm:h | Folders ‘-
Address |4 schedued Tasks B> E
Name = | Scheduls | mecct Run Time | Last Bun Time | Status
|.2] Add Scheduled Task
Other Places & phGooglelpdateTashlserS-1-5-... At 12:07 PMevery ... 12:07:00FM ... Never Couid not skark

@ Control Panel
(L) My Documents
{25 Shared Documents
W) My Network Places

Details ¥

4| |

a =

[z objects

The Windows Task Scheduler

2. Click on "Add Scheduled Task™ and "Scheduled Task Wizard" will guide you through the
setup process.

3. In the first window, read the welcome message and click "Next."

Scheduled Task Wizard x|

This wizard helps you schedule a task for Windows
to perform.

You select the program you want Windows to run,
and then schedule & for a conveniant tims,

Click Neot to continue.

The "Scheduled Task Wizard" window

4. Browse to the HI PAAENr ol | nent Mast er . exe executable file.
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Scheduled Task Wizard

x|
Click: the: progeam pou want Windows bo fur.
To see mole progams, Browse.
| Version [-]
7Zip Filz Manager 457 -
& Accessibilty Wizard 5.1.2600.551...
B ACDSee Pro 25
W) Addiress Book £.00.2300.55...
I 4.dcbe Bridge 53 20
) &dcbe Device Cenbial C53 1,00
Th A el CodmendC maimt Tomsllis 3 TN ED :]
]
[ <Back | neis | Concel |

The "Scheduled Task Wizard" window

By default, the application is located in c:\ Program Fi | es\ HI PAAsui t e\ Hl PAA Enrol | ment

Mast er \ H PAAENnr ol | ment Mast er . exe

My Recent

Dezktop

4

My Documents

My Compites

|

-

My Network
Places

Select Program to Schedule ,,ilil
Look in: [ 3 HIPAA Envoliment Master o N N A s
) Heln | ] 15Licensesn. dl
| %] acroPoF.di | %] pdfsharp.dil
N | (%] Axinterop. AcroPDFLb.dI ) ProjectHistory.txt
| %] Battviracle. LibTiFF.NET.di | %] imLicenseLib.di
| %] CustomactionLibrary.di 8 shorbout o HIPAAENrolmentiaster
= CustomactionLibrary. Instalistate |2 Template.ods
B Templake.xls
,ﬂ:cs.hapcodu.mm.:l
| %] triterop. AcroPDFLib.dI
%] 1onic. Zip.di
File: ruarne: [HIPAAE riolimenth aster axe > (| Open |
i

Selecting a program to schedule

Click "Next."

5. Type in a name for this task. Choose a time interval:

e Daily

© <2003> Martin Scholl Consulting, Inc.



Configuring the Application 41

e Weekly
e Monthly
¢ One time only
e When my computer starts
e When | log on
Click "Next."

Scheduled Task Wizard EI

Twpe aname for this task. The task name can be
the same name as the program name.

J;IPME FI'O'IIT‘EI'MG&IET‘
@ )

Perfiorm this task:

[ |paiy

Weekly

Monkhly

Dirves brne: cnly

When my compuler starts
When | log on

Back ([ Net> |)  comel |

The "Scheduled Task Wizard" window

™5 )

6. Enter the name and password of a user. The task will run as if it were started by that
user. Click "Next."”
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Scheduled Task Wizard

Enter the name and password of 3 user. The task wil
run as f it wars staded by that usar.

o —

Enter the user name: |L.==er

Enter the password:

Il!'l.'l'

Confirm password:

Ilil.'&ll

If & password is not anterad, schadulad tasks might
not run.

x|

The "Scheduled Task Wizard" window

7. In the last screen, make sure you have specified all data correctly. Click "Finish" to

save your task.

Scheduled Task Wizard EI

“fou have successiuly scheduled the folowing task:
48  HIPAAEreolinenthaster

windowes will perform thes tagh:
R at Lisat kogon

r Open advanced properties fios this tack whan | chck
Finish.

Click Finizh to add thes tazk to your Windows scheduls.

<Back ([ Fwan |) Concel |

e

The "Scheduled Task Wizard" window

8. The scheduled task has been added to the system. Now let’s edit the new task and
add the desired command line arguments with the appropriate options. Double-click the
newly created task in the "Scheduled Tasks" window.
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=10/ x|
File Edt View Favorites Tools Advanced  Help |.'.','
Qesck - () - | T | I semen | Folders | [T7]- | () Fokdersync
Address |4) Schedued Tasks | Edse
Name = | schedule | Mext Run Time | Last Run Time | Status
| ndd scheduled Task
Other Places 2 BlccoglelpdateTasklsers-1-5-.., AL7:42PMeveryd... T:A4Z:00PM ...
G ControlPanel B GooglelpdateTaskisers-1-5-.., AL 3:07 PMevery d... J07:00PM ...

é; HIPALClamPaymentaster Run at user logon AL user logon
@HIPMEM:IMMMH } Run &t user logon A user logon

S

() My Documents
| Shared Documents
& My Network Flaces

The Windows Task Scheduler

9. Enter parameters to the "Run” field after the application path and click "OK." Refer to
Using the Command Line Arguments (CLI) for more information.

Example:

"C:\ Program Fil es\ Hl PAAsui t e\ H PAA Enrol | nent Mast er\ Hl PAAEnr ol | ment Mast er. exe" C:\ EDI
\'I nbox, X

2|

Tatk | Schedue | Seitings |

&] CAWINDOWSAT asks\HIPAAE reclimentM aster job

Run: (Ii'lt M azber\HIFASE raollmeriM aster s C:‘I.EDI'\Inb-J:-ef()
EBrowze. . I

Stat inc I"C:'HPlugam Files\HIPALzute\HIPAS Ercoliment Master”

Comments: ‘

Run as: I user Set passwond ..

™ Run only if logged on
¥ Enabled (scheduled task nuns af speciied time)

ok | cancel | apy |

The "HIPAAEnrollmentMaster” task window

You can see, the path to the executable is in quotes and then the arguments follow. In
this example, the directory c:\ Epi\ 1 nbox Will be processed. The "X" option indicates that
the data will be exported to the database.
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Tip: Logs may be helpful when running the program automatically through the scheduler. See
Accessing Logs.

Tip: When running the HIPAA Enrollment Master through automation, either through the scheduler or
through shell call from other programs, it is important to remove processed files to prevent them from
running again. In the Program Options you can determine if processed files should be deleted or
moved and into which directory. See Configuring Program Options.
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HIPAA Enrollment Master

4.1

Creating Spreadsheets

Creating Spreadsheets

The HIPAA Enrollment Master can export the enrollment data to spreadsheet file:
e Microsoft Excel . xI s and . xI sx formats
e Open Document (a non-proprietary) . ods format.

You do not need to have Excel or Open Office installed on your computer; the Enrollment
Master comes with the necessary drivers to accomplish this.

You can create spreadsheet files manually or automatically using the command line
arguments and Windows Scheduler. Read more in:

e Using the Command Line Arguments (CLI)

e Running the Application via Scheduler

Before creating spreadsheet files, make sure all settings are defined correctly. The
following options can be defined:

e The directory in which to save the resulting files. See Configuring Program Options.

e File format and columns. See Configuring Spreadsheet Options.

Follow the instructions below to create spreadsheet file(s) from EDI file(s).

1. Open an EDI file or directory containing the EDI files in the HIPAA Enrollment Master.
Read more in Processing a Benefit Enrollment File, Working through an Entire
Directory.

FEIHIPAA Enrollment Master - G4bit

Select Prinber

Exit
¥ Seeeee e

" ASCI File
" Image Fie

The "Open” button
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;.ﬁﬁHIPAA Enrollment Master - 64b

File | Wiew  Datshsse  CodeSal
Open Sample File

QL_

[ openprectory )

Sedect Printer

Exit

" ASCIl Fie

The "Open Directory” menu

2. Select the "Spreadsheet” option in the "Output Mode" block.

~ Dutput Mode

" Screen
~ Pi
T Speeadsheet Fie
(G D,
™ ASCH Fie
" Image File

The "Spreadsheet” option

3. Click on the "Run” button.

mHIPﬂ.A Enrollment Master -

Y —

(_m.,L.,D

The "Run” buttons

47
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HIPAA Enrollment Master

4. The process will start. While running, you will see the "Stop" button instead of "Run.”

_EHHIPAA Enrollment Master -

— Dutput Mode
' Sreen
= Prnter
% Soreadsiest Fie
€ ASCI File

| Irnage File

IC pata Expaort
-~ Counter

cores [
e —

o O

The "Stop" buttons

5. The "Processing Results” window displays the report. You can find the result XLS, XLSX
or ODS files in the specified folder.

Erucessing af the file 834 .edi began at 2252013 74716 Pk -

Enrollment Records will be exponed to Excel

The file 'FAN34xl=' has been created

1 Records have been processed

Murmber of Records in File: 1

[t ook D minutes, 24 843 seconds to process this file
The average time was £4.844 seconds per record
Frocessing ended at 2/25/2013 7:47:47 P

The "Processing Results” window
6. You will be asked to if to open the resulting file. Click "Yes" to view the data.

Excel e

Do wous want bo ses the Excel Spread shest now?
T v D w |
e ——

The "Yes" button in the "Excel File" popup
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7. The resulting spreadsheet will look like this.
| A B | C | [1] | E | F G
File File Date File Type Palicy Mumber OTPM Descnplion  DTPOY Value Employer
1 |Header Mame
2 | 534 172002 Change (Update) 11111 Effectie 11,2003 SPONSOR
3
4 Member Level Benefit
T | Subseribes Felstiocnzhip Ind, Action Code Maistenance Reazon Code Bleneiit Statuz Code Biedicse Plan Code Emplogmant
5 |Reacrd? Status Code
Yes Self Addition Active Active Medicare Pat A Actie Military-
[
7l
g

Excel spreadsheet example

e The first two rows contain EDI file information that is applicable to all records. Row

1 has the column or field names, row 2 has the data.

e Row 4 has group headings usually representing loop identifiers in the standard such

as 2010C, etc.
e Row 5 contains column or field names.

e Row 6 and beyond contain the individual records.

There are fields that have multiple lines. The information is separated with ASCII(10)

characters.

4.2  Configuring Spreadsheet Options

You can select a spreadsheet format and configure the columns that you want to have in

your spreadsheet. Follow the instructions below.

1. Select Setup » Spreadsheet File Setup in the main menu.

FAHIPAA Envollment Master - 32bit

File Wiew Databsse CodeSets Image | Setup | Log  EDIExchange Help

- &4 Options
E - |.r
-

Spresdshest File Sstup :j
gﬂpﬂ Mode Company Setup
*  Screen

Create Compamy Setup Table
" Printer

The "Spreadsheet File Setup” menu

2. The following screen will appear.
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[ Spreadsheet Document setup

. Spreadzheet Documents format:

T ¥LS - for all versions of Micsosolt Excel

0 ¥LSH - for Miciosolt Excel 2007 o higher
" 0DS - Open Document Spread Shest

 Fields to be exported in Spreadsheet File

Header Tahle
O = [ Wemiber Level Beneti -]
[CJFile Date [ Subscriver inicator
OFile Type [ relatioreskip
[ Poiicy tumier Oinat. Action Code
O oTPot Description [ mairtenance Reason Code
ot value [ Benett Status Code
[ Emploryer Mame [ Medicars Plan Code
DTax D DEmp’ﬂ:-'.'msrrt Stafues Code
Oea O Studert Status Code |
[ rumber of Records on File [ Handicap Indicator
[ File Masme = [ wemiber i
[ Processing Date O subscriber ©
DPrl:u:sssing Tieme Dﬁrmh,lrbu
[ REFM Code Description
CJREFM ahe
= [ Memiber Level Dafes
OoTPiM Code Description
OotP Walse
= [ Memiber Name
[ Last Hame
0 First passme
[ icicle Mame
[ Mame Prefi:
O Hame Sutii
Osub. s5M
=[] Contact Numbers
[ Phore #1
Phone #2
;ﬂuqnwhu_ﬂ.dnhmm o
Select All Select Hone Select All Select Hone

Help |

The "Spreadsheet File Setup” window

You can define the following image options:

Spreadsheet Document Format

e XLS - Suitable for all versions of Microsoft Excel

e XSLX - Suitable for Microsoft Excel 2007 or Higher

e ODS - Open Document Spreadsheet

Fields to Be Exported to Spreadsheet File

e Header

¢ File Header
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e File Date
e File Type
e Policy Number
e DTPO1 Description
e DTPO1 Value
e Employer Name
e Tax ID
e TPA
¢ Number of Records On File
e File Name
¢ Processing Date
¢ Processing Time
e Table
e Member Level Benefit
e Subscriber Indicator
e Relationship
¢ Ind. Action Code
¢ Maintenance Reason Code
¢ Benefit Status Code
* Medicare Plan Code
e Employment Status Code
e Student Status Code
e Handicap Indicator
¢ Birth Sequence
e Member ID

e Subscriber 1D

51
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e GroupNumber
e REFO1 Code Description
e REFO1 Value
e Member Level Dates
e DTPO1 Code Description
e DTPO1 Value
e Member Name
e Last Name
e First Name
¢ Middle Name
e Name Prefix
e Name Suffix
e Sub. SSN
e Contact Numbers
e Phone #1
e Phone #2
e Member Address
e Street Address 1
e Street Address 2
e City
e State
e Zip
e Country
e Member Demographics
e Birth Day

e Gender
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¢ Maritial Status

¢ Previous Name
¢ Old Last Name
e Old First Name
e SSN

e Mailing Address
e Street Address 1
e Street Address 2
e City
e State
e Zip
e Country

¢ Custodial Parent Information
e Last Name
e First Name
¢ Middle Name
e SSN
e Street Address 1
e Street Address 2
e City
e State
e Zip

e Disability
e Disability Type
¢ Begin Date

¢ End Date

53
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e Hearth Coverage
¢ Ind. Action Code
* Type
e Coverage Description
e Coverage Level
e Maint. Effective Date
¢ Benefit Begin Date
¢ Benefit End Date
e Group ID
¢ PCP Information
¢ Provider Number
e Provider Type
e Last Name
e First Name
¢ Middle Name
¢ Federal Tax ID
e Current Patient?
e City
e State
e PCP Action Code
e Effective Date
e Reason
¢ COB Information
e COB Sequence
e COB Group/Policy Number
¢ COB Code

© <2003> Martin Scholl Consulting, Inc.



Creating Spreadsheets 55

e SSN
¢ Begin Date

¢ End Date

Notice: Before creating spreadsheet files, determine the directory in which you want to save the
resulting files. See Configuring Program Options.

3. Once the options have been configured, click "Save."

4.3 Spreadsheet Limitations

Excel basically has a two-dimensional display of the data: columns and rows. EDI data is
hierarchical and nested which does not allow a true two-dimensional representation.

HIPAAsuite tries to accommodate this using multiple values. For example, REF and DTP
segments are translated into multi-line cells. In this way the spreadsheet displays multiple
Benefits that a record might contain. For each Benefit, an Excel spreadsheet displays only
one COB record and only one Provider.

Health Coverage
Imd. Action Code Type Cowverage Description Coverage Lewel ]
[
Addition Health PLAMN A BCD Family
L Addition Prescription Drug PLAN & BCD PLAN & BCD | |

Multi-line cells in Excel

Note: The record separator in Excel is ASCIl 10 or Linefeed.
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5 Creating ASCII Files

5.1 Creating ASCII Flat Files

You can create ASCII flat files manually or automatically using the command line
arguments and Windows Scheduler. Read more in:

¢ Using the Command Line Arguments (CLI)

e Running the Application via Scheduler

Before creating ASCII flat files, make sure all settings are defined correctly. The
following options can be defined:

57

e The directory where you want to save the resulting files. See Configuring Program

Options.

Follow the instructions below to create ASCII flat file(s) from EDI file(s).

1. Open an EDI file or directory containing the EDI files in the HIPAA Enrollment Master.

Read more in Processing a Benefit Enrollment File, Working through an Entire
Directory.

FAHIPAA Enrollment Master - 64bit

The "Open” button

FEIHIPAA Enrollment Master - 64b
Fle | View Database CodeSel
Open Sample File

EE i
[ openprecory )

Select Prinker

Exit
Y o e

" ASCI File

The "Open Directory” menu

2. Select the "ASCII" option in the "Output Mode" block.
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HIPAA Enrollment Master

— Dutput Mode

" Screen
" Prirter
" Spreadshest Fie
| —
=
(( astiiFie —D

™ Image File

The "ASCII File" option

3. Click on the "Run" button.

FAHIPAA Enrollment Master -

The "Run" buttons

4. The "Processing Results” window displays the report. You can find the resulting XLS,

XLSX or ODS files in the specified folder.

Processing Results

Processing of the file 834.edi began at 118/2013 3:55:15 PM
Enrcliment Records will be exported to ASCI file
The file 'CAZE34_1. &t has been created
1 Records have been processed
Mumber of Records in File: 1
Ittook O minutes, 0.20 seconds to process this file
The average time was 0.020 seconds perrecord
Processing ended at 1/18/2013 35515 PM

The "Processing Results” window

= ES
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5. Open the resulting file to view the data.

B 2.02 DHCSB34-DAZ0110712-Dental-495-HCP-001 - Notepad =1k

File Edt Format View Help

HMaster Policy Number subscriber ves/nNo relationship Maintenance Type Main';]

1 PCP Action Code 1 Effective Date 1 ] PCP Change Reason 1 COB Sequence
Ves self Change Mo Reason Given Active No Medicare Active 234%
Ves self Change mNo Reason Given Active Mo Medicare Active 5678
Ves self change wNo rReason Given active wNo Medicare Active G7

A single record as ASCII flat file

The HIPAA Enrollment Master uses a tab ASCII(9) delimited flat file with CarriageReturn/
Linefeed ASCII(10) and ASCII(13) as line end. The first line contains column names, the
second and all following lines list the information.

52 Limitations of the ASCII Flat File
Not all the information that can be contained in the 834 transaction set is written to the
file. The following limitations apply.

e Loop 2300: "Health Coverage”; only three different coverages are listed. The
standard allows 99. The IDC segment, “ldentification Card", is disregarded.

e Loop 2310: "Provider Information”; only 1 provider per health coverage is displayed.
30 are allowed in the 834.

e Loop 2320: "Coordination of Benefits"; only one COB payer is listed. 5 are allowed
under the standard.

HIPAAsuite believes that we display the most common elements that fit on a single page.
If you need additional information, please contact us so that we can make necessary
changes.

Below is a list of the exported fields.
Header Information

e Subscriber Yes/No

e Relationship

e Maintenance Type

* Maintenance Reasaon
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¢ Benefit Status
* Medicare Plan Code
e Employment Status
e Student Status
e Subscriber Number

e Group Number

Additional Identifiers
e ID Type 1"
eID1"

e |ID Type 2"

e D2

e |ID Type 3"

e D 3"

e Dates

¢ Date Type 1"
e Date 1"

e Date Type 2"
e Date 2"

e Date Type 3"

e Date 3"

Member Info
e Member Last Name
¢ Member First Name

¢ Member Middle Name
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e Member NM1_09

e First Comm Number

e Second Comm Number
e Address 1

e Address 2

e City

e State

e Zip

e Birthdate

e Gender

e Marital Status

Incorrect Information
® |ncorrect Last Name
® |ncorrect First Name

® |ncorrect ID

Mailing Address
¢ Mailing Address 1
e Mailing Address 2
e Mailing City
¢ Mailing State

e Mailing Zip

Custodian

e Custodian Last Name

61
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¢ Custodian First Name
¢ Custodian Middle Name
e Custodian ID

e Address 1

e Address 2

e City

e State

e Zip

Disability
e Disability Type"
e Disability Begin”
e Disability End"

Coverage

Note: Three Benefits maximum in ASCII file.

¢ Maintenance Type

Insurance Type

Description

Coverage Level

Effective Date

¢ Benefit Begin

Benefit End

Policy Number

Provider Type

Provider Last Name
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¢ Provider First Name
¢ Provider Middle Name
e Provider ID

e Relationship

e Provider City

* Provider State

e PCP Action Code

e Effective Date

* PCP Change Reason
e COB Sequence

e Group Number

e First Ref Value

e COB From

e COBTo

63
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6.1

Creating Image Files and PDFs
Creating Image Files

The HIPAA Enrollment Master displays the EDI document in a page that makes it easy to
read the 834 transactions. Sometimes it might be useful to have an image of an
enrollment record stored for later retrieval. You can create image files containing the
data that you see in Screen mode. The following formats are supported:

* TIFF
* PDF

No third party software is needed as this feature is integrated into the software.The
image file name comes either from the EDI file name or the subscriber's ID which is
mandatory and unique within a file.

You can create image files manually or automatically using the command line arguments
and Windows Scheduler. Read more in:

e Using the Command Line Arguments (CLI)

e Running the Application via Scheduler

Before creating image files, make sure all settings are defined correctly. The following
options can be defined:

e Put all the images into a single file with multiple pages or have an image file for
each enrollment record.

e The form or background color.
e The image format, TIFF or PDF.

e The image file directory. In order to avoid having all images in one folder, the
images can hashed across folders based on the date.

Read more in:

e Configuring Program Options

¢ Adjusting Image Options

Follow the instructions below to create an image file from EDI file.
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Notice: The image file will be created based on the pre-defined settings. Read more in Configuring

Program Options, Adjusting Image Options.

1. Open an EDI file or directory containing the EDI files in the HIPAA Enrollment Master.
Read more in Processing a Benefit Enrollment File, Working through an Entire

Directory.

EHiPaa Enrollment Master - 64bit

Select Printer

Exit

= ASCI File

The "Open Directory” meﬁu

2. Select the "Image File" option in the "Output Mode" block.

— Dutput Mode
r‘ = CTEET

" Printer
™ Smeadshest Fie
" ASCI File

(e

The "Image File" option

3. Click on the "Run” button.
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mHIPﬁA Enrollment Master -

The "Run" buttons

4. The "Processing Results” window displays the report. You can find the result TIFF or
PDF files in the specified folder.

Processing Results =101 ]
Pracessing of the file 2.02 DHCS834-DA2011071 2-Dental-495-HCP-001 edi began &t
B/28/2012 5:06:30 P

Enraliment Record Images will be created

The file 'CADocuments and SettingshAdminl\Wy Documents\EDI Images Outputy2 02
DHCS834-DA2011071 2-Dental-495-HCP-001 pdf has been created

I Records have been processed

Frocessing ended at 5/28/2012 6:06:32 P

The "Processing Results” window

6.2 Adjusting Image Options

The HIPAA Enrollment Master allows you to predetermine the most common image file
options.

1. To configure the image options, select Image » Image File Options in the main menu.
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File View Database CodeSets | Image | Setup Log EDIExchange Help

@ > [
[ ompatode |
The "Options” menu

2. The following screen will appear.

Options E
~ Image Files

Output Path For Image Files |

Image Format
" TIFF Fermat ¢ PDF Format

~ Image File Opbions
= Allimages in one File with EDI
File Name as Image File Name

Image folder options
 Mone
" Sub-Folders for Year, Month and Day
" Sub-Folders for Year and Week
" Sub-Folders for Year and Day

' One Image File per Record ~ Color On Images
Options for PDF - © Red
™ Use content compression " Black
~ Options for TIFF
Color Depth; Compression: Image Resolution; Set defaut vahses
T BlackWhite & | Zw Horizontal resolution: 200 dpi
L
T 4bpp " Packbits -
 Sbpp OO G v IR =H ! Flasol
& 24 bpp AT T (4 Vertical resolution: 200 dpi
= CCITT Group 4 I
C 32bpp CITT T8 .

__sawe |

The "Options" window
You can configure the following options:

¢ Set the directory where image files will be saved

¢ Set image file and folder options

e Determine image format

e Determine options for PDF and TIFF files

e Determine the document background color for images
Read the detailed descriptions further.

3. Once you have finished editing the options, click "Save."
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The settings are saved to the Windows registry and will be retained for the next time you
run the program. Check your permissions to write to the registry if you encounter any
problems with saving settings. Your administrator might help you.

Image Files

e Output Path for Image Files — Define the destination folder where the images will
be stored. See also Creating Image Files.

Image Format

Choose whether to create PDF or TIFF files.

Notice: You will need the Peernet image printers installed.
o TIFF
* PDF

Image File Options
The following options are available:

¢ All Images in One File with EDI File Name as Image File Name

e One Image File per Enrollment Record
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"One Image File per Enrollment Record” mode

"All Images in One File" mode

Image Folder Options

When you create a lot of images, it is important not to place them all in the same folder.
Microsoft Windows has issues handling more than 1000 files in a folder. That is the
reason why the HIPAA Claim Payment Master can hash the image files over many sub-
folders. You have the following choice to use:

e None — Default value.

e Sub-folders for Year-Month and Day — The sub-folders will be created within the
Image File Location. Example: \ 2012\ Febr uary\ 29\ .

(& Deshtop
= L My Documents

1) EDT ASCIT Cuitput

= ) ECI Images Cutput:
B = 2012
B i May
=29
| EDI Spreadshest Cutput
The folder structure in "Year, Month and Day" mode
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6.3

e Sub-folders for Year and Week — The sub-folders will be created within the Image
File Location. Example: 2012\ 9\.
e Sub-folders for Year and Day — The sub-folders will be created within the Image

File Location. Example: 2012\ 20120229\ .

Color on Images

¢ Choose a color for the form when saving claims to image files. You have the choice to
render the form in red or in black.

Note: The data is always black.

Options for PDF

e Use Content Compression — Checking this option does result in considerably smaller
files.

Options for TIFF

e Color Depth — You can change color depth of the image (black / white, 4 bpp /
8bpp / 24bpp / 32bpp).

Note: TIFF in Window's GDI library does not work with 16 bpp (bits per pixel). Color depths set lower
than 16 bpp results in some losses in image quality.

e Compression Algorithm — You can use compression with TIFF files: LZW and
Packbits is used for all Colors, CCITT4 for black and white.

¢ Image Resolution — You can change the resolution of image from 96 to 300 dpi
(dots per inch).

Note: Theoretically we could use even higher resolutions, but it will slow down processing significantly
and result in approximately the same result in quality.

Viewing Images

HIPAA Enrollment Master Image Viewer allows you to view images stored in the output
folder, defined in the image options. See Adjusting Image .

Follow the instructions below to view images.

1. To access Image Viewer, select the "Image Viewer" option under "Image" menu item.
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FAHipaa Enrollment Master - 64bit

EDIExchange  Heslp

File Wiew Database CodeSets =
] > Viewer
1 AN T e
Image Fie Optons
— Dutput Mode
" Screen ‘

The "Image Viewer" menu

o

Alternatively, you can select the "Image Viewer" option under "View" menu item.

FAHIPAA Enrollment Master - 64bit

File | View | Database CodeSets Image Setup Log EDIExchange Help

TS P
Form - hlll

" Printer
The "EDI Editor" button

2. The "Image Viewer" window will open.

g

2K
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Image Viewer !El

=1 P e 171 > - 3% 4
= B34 =
= B34 pdf

Enrollment Record
Trarmacton F Lt e T -
Original 12456 12raae0 12:00:00 PM
Update '
Lpowae § L a '
BT
a5 Paye Feders SEpayeT N .
Insured Information
Subscriber  Sell Addition Active Active
BT Meacars Py Lozl Mascane 3 Mo A Ciaplfyng L] SOyl S el
Full-Tire
1T 123458001 05TV
AT 341 Pl ut Mama g Cilk 2 ry tu =
DOE SOHN P 123438789
[TIT) 2242004 {.';'“'I 2.“.-12‘!0
CEER LY
100 MARKET ST APT 3G
CAMP HILL PA 1ro11 CUMBERLAND
th Cate Bets Crder | Doath Cute | Martsl Stata Hyce oo
1B 040 ]
wegte | Weght | Healn relased Cooe Cesatiny Typs aabeity 1D | Doplin m | Denatedety T
Y & ™ al - - 1
CGUQT-\)Q! Information
laniecgnce Type s gnce »rage
additicn Health d
1 o1017002
1o |, a2} =
a Secondary 890111 Winknawn
l‘.ﬂ:IIHIJMECD
tatengace Tope g @ | o sage Leve
9 Addtion Dental -
1 a0d
Mantemgnca Tyra vorance | ne wrage Leve
3 Mgditien Wislon
B10172001
-
< | +0

3. Select the necessary image in the left navigation pane.

a1

= 834 pdf

4. For pages navigation, use the arrow buttons.

5. To scale the image, use "+" or "-" buttons or define the percent manually.
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7.1

Using the Database
Exporting the Data

The HIPAA Enrollment Master can export enrollment records into any ODBC- or OleDB-
compliant database. Exchanges with Microsoft SQL Server and IBM AS400 have been
successfully demonstrated. The HIPAA Enrollment Master uses two tables, ED _Enrol | nent
and ED _Benefits, that serve as staging tables for your own system. We recommend that
you establish these two tables and process the data from these staging tables into your
system and apply your business rules. Once you have the data in a format that is legible
to your specific system and experts, you can easily work from those tables.

The HIPAA Enrollment Master relies on Open Database connectivity (ODBC) or in the case
of Microsoft SQL Server on OleDB to connect to a database. This means that any
database that adheres to the standards of ODBC is suitable to interact with the HIPAA
Enrollment Master. ODBC connections have to be set up in Windows first, before you can
use this feature. Typically, ODBC connection is established in the Windows Control Panel,
with newer versions having the ODBC Data Source Setup under the "Administrative Tools."

OleDB connections use a database specific data access object or di I . The Enrollment
Master comes by default with MS SQL Server's data access object. Contact us for a
modification if you have a different OleDB provider.

The following setting need to be configured before the database export can be run:

e Creating Tables

e Setting up Database Connection

e Selecting Fields to Export

See also: Creating Company Setup Table.

Follow the instructions below to export the data to a database.

1. Open an EDI file or directory containing the EDI files in the HIPAA Enrollment Master.
Read more in Processing a Benefit Enrollment File, Working through an Entire
Directory.
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FAHiraa Enroliment Master - 64bit

View Database CodeSets Image Setup Log EDIExchange Hep

L A 90

=] VSRR
@ Soreen -

The "Open” button

mHIPAA Enrollment Master - G4b)

| Fie | View Datsbase  CodeSel

| Open Sample Fie

il oo |8

[(__openprecory )
Select Prinker

Exit

= ASCI Fie

The "Open Directory” menu

2. Select the "Data Export” checkbox.

EHiPaa Enrollment Master -
File Wiew Datsbase Cod

ﬁ F £

— Dutput Mode

' Screen

" Prinker

@ [SpisadhastFie]
" ASCI File

" Image File

(pas o

— Counter

coties [
O

Run > ‘

The "Data Export” option

3. Click on the "Run” button.
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EHipaA Enrollment Master -

File ¥iew Database Cod

& ®) s

~ Dutput Mode

' Screen

" Prinker

@ [SpisadhastFie]
" ASCH File

" Image File

¥ Data Export
— Courter

S —
T —

=* )

The "Run" buttons

4. The "Processing Results” window displays the report.

Frocessing of the file 2.02 DHCS834-DA20110712-Dental-491 2-Vendor-001 .edi began at

5/30/2012 12:19:59 AM
Enrollment Fecords will be exported
2 Enrollment Recards have been exported o Live database
2 Records have been processed
Fracessing ended st 5/30/2012 12:20:00 AM

Frocessing of the file 202 DHCS834-0A20110712-Dental-495-HCP-001 edi began at

5/30/2012 12:20:00 AM
Enroliment Riecords will be exported
3 Enroliment Recards have been exported ta Lrie database
3 Records hawve been processed
Frocessing ended at 5/30/201212:20:07 A

Frocessing of the file 2.02 DHCS834-DA2011071 2-Medical-111-HCP-001 edi began at

5A30/2012 12:20:01 AM
Enroliment Records will be exported
3 Enrollment Records have been exported ta Lre database
3 Records hawve been processed
Frocessing ended at §/30/201212:20:02 A

Frocessing of the file 2,02 DHC3834-0A20110712-Medical-123-HCP-001 edi began at

5302012 12:20:02 AM
Enrollment Records will be expored
B Enrollment Records have been exported to Live database
b Records hawve been processed
Processing ended at 57302012 12:20:04 AM

o=

77

© <2003> Martin Scholl Consulting, Inc.




78

HIPAA Enrollment Master

7.2

The "Processing Results” window

Setting up Database Connection

The HIPAA Enrollment Master can translate and export data into any ODBC-compliant
database such as Microsoft SQL Server, Oracle, etc.

Tip: The default fields that come with the product can be extended; customizations are possible.

1. Select Database » Connection and Data Fields in the main menu.

FAHIPAA Enrollment Master - 68bit

File iew | Database | CodeSets Image Setup Llog EDIExchange Hep

E » Connection and Data Fields ﬂ @

Stored Enroliments —
 Output Table Creation
" Screen
Create 334 ED] Fles
" Prnter |

The "Connection and Data Fields" menu

2. You will be confronted with the following screen where you can set up the database
connection and enter the names of the database tables.

Database Server Setup for OLE/ODBC Connection
—HIPAAsuite's Enrollment Extract Capabilities — | | Fields to be exported
HIFAAs uite natively stores an Enrollment as a single Object, | | Header Detail Reparting Categoties
HIFAAS Uite can extract the Enrollment data and write those [=I- [ File Level Data = riefit Diata = (= [F] Member Reporting Categaries
into a narmaized Database like Microsoft SGL Server. TradingPartner|D rrolimentlD (Header Table's Key) EnrollmentlD (Header Table's Hey)
Customizations are possible. Ask Vendor for details. taintenanceType Mame
suranceling Referencetuall
G ion Properties ImageFilehlame - Escription Referencell
Database Type - [#] LoacDate overagel evel Referencequal?
IMS SOL Server Integrated Security j 1= [F]Header Dats onditionResponzeCace Referencell
Purpose gratureDate o ReferenceQuall
Datahaze Server Mame fectiveDate ReferencelD
I.\SQLEXpreSS Test Connection | emiumPaictoDateEnd Referenceuakd
Diatabase enefitBegin ReferencelDd
enefitEnd Referencetuals
Jhipaasuite Tl e ReferenceiDs
Lsername EtfectiveDateStart
I - [#] EtfectiveDateEnd
Pasgward MairtenanceEffectiveDate
I EnrollmentDate
PaymertCommencementDate
Enrollment Header Tahle Name
|EDI7EnrnIIment
Enrollment Detail Table Name You can create the
tables through a
|EDI Benefits separate screen
Reporting Catecories Table Mame
|EDI_Rep0mngCategories - [ Braoker
- ErorerETvpe «||4]
Save Connection Information | Seleet Al | Select Hone Select All ‘ Select Hone Select All Select Hone:
Help | Test Configuration | Save Field Configuration |
4

The "Data and Field Setup” window

Connection Properties

Tip: If you use ODBC for the connection, you will need to set up the ODBC connection first in the
Windows F Control Panel ¥ Administrative Tools ¥ Data Sources (ODBC) setup screen. Setting up the
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ODBC connection varies from database to database.

B 0DBC Data Source Administrabor

Use DS | System DSM | Fie DSN | Drivers | Tracing | Connection Pooing | About |

Uzer Data Sources:

Mame | Diiver | Add. |
IGEEEN
_"|

iy - An0DBC User data sounce shores informabion abouwt howe bo connect to
the indicated data provader, A User data sowrce is only visible to pou,
and can only be used on the current machne

[ ok ]| cocet | - Help

The ODBC Administration screen in Windows

Define the database connection properties:

e Database Type — Select ODBC or Microsoft SQL Server type:

Note: If you need other types, please contact us for customizations.

e MS SQL Server

e MS SQL Server Integrated Security
e ODBC Connection

e ODBC Connection for Oracle

e Database Server Name or DSN — If you use SQL Server, then enter the IP address
or the name of the database server. If you use ODBC, then specify the Data Source
Name (DSN) that is defined through the ODBC in the Control Panel of Windows.

Latest MySQL ODBC driver can be downloaded on http://dev.mysql.com/downloads/
connector/odbc/.

e Database — Define the database under the above connection. For Microsoft SQL
Server Integrated Security, leave the field empty.

e Username — A defined user that has privileges to the database. For Microsoft SQL
Server Integrated Security, leave the field empty.

e Password — Enter the user's password. Not required for Microsoft SQL Server
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Integrated Security.

Tip: Normally, database, username and password are configured in the Windows Data Sources (ODBC)

Manager and are not required to be provided in these fields.

¢ Enrollment Header Table Name — Enter the name that you give to your Claim
header table. A default name is suggested, you can overwrite it.

¢ Enrollment Detail Table Name — Define the name of the table that contains the
line information. A default name is suggested, you can overwrite it.

[ patabase Server Setup for OLE/ODBC Connection

— HIFAAsuite's Enrollment Extract Capabilities

HIPAAsuite natively stores an Enrollment as a single Object.
HIPAAsuite can extract the Enrallment data and write those
into & normaized Database like Microsoft SGL Senver
Customizations are possible. Ask Vendor for details,

- Connection Properties

Database Type

[Ms S0L Server

Database Sener Mame

[WiIN2003XE4

Database

|Enralments

semame

IAdminislratu:

Password

[

Enrollment Header Table Name

IEDI_E nrollrnent

Enrollment Detail Table Mame

|EDI_Benefits

Save Connection Information |

| Cancel |

Test Connection I

[ Checked

You can create the
tables through a
separate screen

Help |

The connection properties fields

Note: Consult Windows Help or the internet on specific data source setups.

To create tables in your database, click on the "You can create the tables through a
separate screen” link. For instructions, refer to Creating Tables.
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;'g.'a:nataha-w Server Sebtup for OLE/ODBC Connection

— HiPAAsuite's Enrollment Extract Capabilities

HIPAAsuite natively stores an Enrollment as a single Object.
HIPAAsuite can extract the Enrollment data and write those
into @ normaized Database like Microsoft SCL Senver.
Customizations are possible. Ask Vendor for details,

-~ Connection Properties
Database Type
|MS SQL Server =

Database Sener Mame
[WiN2003XE4 Test Connection

Database
[Enraliments ™| Checkad

semame
|&dministrator

Pazsword
[~

Enrollment Header Table Name

|EDI_Enroliment (

- You can create the
Enroliment Detail Table Name tables througha
|EDI_Benefits

Save Connection Information

Cancel | Help |

A link to create tables

Once the connection parameters have been entered, click "Save Connection Information.”
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;'-_::;nataha-w Server Sebtup for OLE/ODBC Connection

— HiPAAsuite's Enrollment Extract Capabilities

HIPAAsuite natively stores an Enrollment as a single Object.
HIPAAsuite can extract the Enrollment data and write those
into @ normaized Database like Microsoft SCL Senver.
Customizations are possible. Ask Vendor for details,

-~ Connection Properties
Database Type
|MS SQL Server =

Database Sener Mame
[WiN2003XE4 Test Connection

Database
[Enraliments ™| Checkad

semame
|&dministrator

Pazsword
[~

Enrollment Header Table Name

|EDI_Enroliment
You can create the

Enrollment Detail Table Name tables through a
separate screen
|EDI_Benefits

C Save Connection Information 7)

Cancel | Help |

The "Save Connection Information” button

To verify if the entered parameters are correct, click on the "Test Connection” button.
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[ Database Server Setup for OLE/ODBC Connection

— HiPAAsuite's Enrollment Extract Capabilities

HIPAAsuite natively stores an Enrollment as a single Object.
HIPAAsuite can extract the Enmllment data and write those
into & normaized Database like Microsoft SGL Senver
Customizations are possible. Ask Vendor for details,

- Connection Properties
Database Type
|MS SQL Server =
Database Sener Mame
et (etcorn]
I
Database
|Enrallments ™| Checkad
Usemame
|&dministrator
Password
-
Enrollment Header Table Name
|EDI_Enroliment
= You can create the.
Enrollment Detail Table Name tables through a
separate scresn

|EDI_Benefits

Save Connection Information |

Cancel | Help |

The "Test Connection” button

If the test has passed successfully, you will see the following notification:

Success establching connection
Irvezbd object narme ‘EDI_Ensoliment’,
Invabd object name ‘EDI_Benefits',

([T

The success message

Once the test has passed successfully, the "Connection not checked" message changes to
"Connection checked."”
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— HIPAAsuite's Enrollment Extract Capabilities
HIPAAsuite natively stores an Enrollment as a single Object.
HIPAAsuite can extract the Enrollment data and write those
into a normaized Database like Microsoft SCL Server.
Customizations are possible. Ask Vendor for details,
— Connection Properties -
Database Type
|MS S0L Server Integrated Security j
Database Server Name
[VWIN2003 54 Test Connection |
[Database
]Enrn!lments
4
[ Database Server Setup for OLE/ODEC Connection
— HIPAAsuite's Enrollment Extract Capabilities -
HIPAAsuite natively stores an Enrollment as a single Object.
HIPAAsuite can extract the Enmllment data and write thosa
into @ normaized Database like Microsoft SQL Server.
Customizations are possible. Ask VWendor for details.
- Connection Properties
Database Type
IME SOL Semver Integrated Security j
Database Server Name
[WiN2003E4
Database
|Enrollments
The "Connection not checked" checkbox
Once you have the database connection defined and tested, you can enter the table
names. See Selecting Fields to Export.
If you need to create the tables first, then see Creating Tables.
7.3  Selecting Fields to Export

Once you have created your tables and tested connection and table names, you can select
which fields to export. The HIPAA Enrollment Master can export most of the elements in
an 834 file.

Follow the instructions below.

1. Select Data Export » Connection and Data Fields in the main menu.
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E 1 HipAA Enroliment Master - 64bit

Stored Enroliments
Table Creation

Create 334 ED] Files

" Printer |

The "Connection and Data Fields" menu

9

o

Datasbase | CodeSets Image Setup log EDIExchange Heb
Connection and Data Fields ?

2. You will be confronted with the following screen where you can set up the database
connection and enter the names of the database tables.

atabase Server Setup for OLE/ODBC Connection

~HIPAAsuite's Enrollment Extract Capabilities

HIFAAs uite natively stores an Enrallment as a single Ohject.
HIPAAsUite can extract the Enroliment data and wiite those
into a normaized Database like Microsoft QL Server

—Fields to be exported
Header

Detail

Reporting Categories

[ [ File Level Data

TradingPartnerlD

= [ABeneft Data =
EnrolmentlD (Header Table's Key)

-

- [ Member Reporting Categories
EnrolmentlD (Header Table's Key)

Custamizations are possible. Ask vendor for details. [AMaintenanceType ame:
Inzsuranceling eferencecual!
T ion Properties Description eferencellr
Database Type LoadDate [ coverageLevel [ Referencetualz
IMS SOL Server Integrated Security j [ (A Header Data [ conditionResponseCode (A Referencelbz
Purpose SignatureDate — Referenceuals
Database Server Name [#] Transactionid [A Ettectivebate (A Referencells
I VWSGELExpress Test Connection | TransactionDate [ PremiumpPaictalateEnd [ Referencetuald
Database TransactionTime [ Benetitbegin (A Referencelbd
ction BeneftEnd eferencetiuals
Ih‘PaaSU'te ¥ Checked asterPolicyNumber & LastPremiumPsicDate eferencelDs
Lsername trectiveDate PreviousPeriod tectiveDateStart
I eporStarDate PalicyMumber EtfectiveDateEnd
epotEndDate CligntReportingCategory
Passwaord mintenanceE fectiveDate PaymentPlanType
I nrolmentDate CountyCode
PaymentCommencementDiate PrintCoveragehonths
Enraliment Header Table Mame [ sponsor [ coinsurance
IEDl Emoliment [F SponsoriDType CnPayrrvervt
- SponsoriD Deductible
Enrolliment Detail Table Name W [A Payer 4 EIPP_;E’“;U;“ ”
Lalilzs Il = =- [# Provider Information
|EDI_Benefits ST B movioortyne
Reporting Catecories Table Mame ProviderLasthlame
|EDI_RepomngCateg0ries [& ProviderFirstivame: =
BrokerDType [ TP .
Geen 4 of
Save Connection Information | SelectAl |  SelectHione SelectAll | Select Hone Select All Select Hone
Help | Test Configuration | Save Field Configuration |

The "Database and Field Export” window

3. Choose the fields to be exported by selecting checkboxes in front of the fields.

Tip: We recommend selecting all fields. This will ensure that the individual enrollment record can be

re-created and displayed or the proper EDI file can be created from the database.

Tip: Make sure that you have that field in the database. Otherwise a database error will occur.

Header

File Level Data

Header Data

Insured Information

Incorrect Information
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e Mailing Address

e Employer Information

e School Information

¢ Custodian Information

e Responsible Party Information
e Drop off Location

e Disability Information

Detail

¢ Benefit Data

¢ Provider Information

¢ COB Information

Tip: Sometimes it might be necessary to rename a field or fields. Some legacy databases want upper
case only or lower case only field names. The HIPAA Enrollment Master allows you to rename any field
in any table. Click twice (not double-click) on a field to enter to the "Edit" mode.

Fields to be exported

Header

= [ File LexelData .
Fa

EOFIEREmE
[] mageFierath
[0 mageFietame
[ LoadDate
=1 [] Header Data
[ eurpose
[ TransactioniD

The field selection list in "Edit" Mode
Reporting Categories

e Name

e Other identifiers and reports

o Effective Dates

4. Once you have made your selection or selected all you have to test your setup. Click on
the "Test Configuration” button. The program will go through each table and check if the
selected field exists.

© <2003> Martin Scholl Consulting, Inc.



Using the Database 87

—Fields to be exported

Header Detail Reporting Categories
= [#File Level Data | = E| Benefit Data | = E| Member Reparting Categories
- [#] TradingPartneriD - [#] EnralimentiD (Header Tahle's Hey) - [#] EnralmentiD (Header Takle's HKey)
- [#] ECIFilename — [#] MaintenanceType - [ Mame
- |w] ImageFilePath - Insuranceline - W] ReferenceCuall
- [#] ImageFietame — - Description - [¥] ReferencelD
- [#] LoadDate : Coveragelevel : ReferenceCal:
=- E|Header Data - [¥] ConditionResponseode - [¢] Referencell2
- [#] Purpose - SignatureDate — - [¥] ReferenceGual3
- [¥] TranzactioniD - [w] EffectiveDate - [¥] Referencell3
- [¥] TransactionDate - [#] PremiumPaictolateEnd - [¥] Referenceuald
- [¥] TranzactionTime - [] BenefitBegin - [¥] Referencelld
- [#] #ction - ] BeneftEnd - [#] Referencetuals
- [#] MasterPolicyMumber - [#] LagtPremiumPaidDate - [¥] ReferencelDs
- [w] EffectiveDate - [] PreviousPeriod - [w] EtfectiveDateStart
- |v] ReportStartDate - PalicyMumber - |w] EffectiveDateEnd
- [#] ReportEndDate : ClientReportingCategory
- [#] MairtenanceEftectiveDate : PaymentPlanType
- [¥] EnralimentDate - [#] CountyCode
- |w] PaymentCommencementDate - PriorCoverageionths
- ] Sponsar - ] Colnsurance
- [#] SponsoriDType : CoPayment
- [#] SponsariD . Deductible
- [#] Paver — [#] Premium
- W] PayerlDType =- E| Provider Information
- [#] PayeriD - [#] Provider Type
- [#] BrakerEntityCode - [#] ProviderLastMame
- [#] Broker - [#] ProviderFirstiame =
Ll Flem sislm b disladlmh L= =
Ern?er!EType 4] |_’|_I
Select All | Select Hone Select All | Select Hone Select All Select Hone
Test Configuration | Save Field Configuration |

The "Test Configuration” button

5. You should receive this message. Click "OK."

E x

Setup checks okay!
D

The success message

If you have any errors, refer to Troubleshooting.

6. Only after the configuration checks out are you allows to save it. Click the "Save Field

Configuration” button.
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el Broker [ Coinzurance
EleeokerDType [ coPayment
EAevokerD [ Devhactivie
i [T [A Premium
A evoker Accourt = [#] Prowides Information
=1 ] Insured Information [ Provider Type
[l sutscriberindcatar [#] PreviderLastiame
Bl Retstionzhip [HAprovidesFirsthame ‘
EMuintl:numcIﬂ:c «f |l Lo L e | LI_‘
Select All Select Hone Select All Select Hone

|| Test Configuration f Save Field Configuration b

The "Save Field Configuration” button

7.4 Creating Tab

les

Before data export, you need to create the database tables to which the application will
export the enrollment data. You can create the tables using the built-in function of the

HIPAA Enrollment

Master.

After you have defined the connection parameters and tested that the data connection
works (see Setting up Database Connection), you can create the tables. Follow the

instructions below.

1. Select the Database » Table Creation in the main menu.

FAHIPAA Enrollment Master - 68bit

Fle View | Database | CodeSets Image Setp Log EDIExchange Help
-_E Connection and Data Fields g 0 ®
. Stored Enroliments —

~ Output Tabie Creation

b/ Scmen Create 834 EDI Fies

™ Printer

The "Table Creation” menu

2. The following window will be displayed.
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[ Create SQL Tables =] 3
Database ]
’7 @ Microsoft SGL Server T MySCQL

Enrollment Header | Enrollment Details | Reparting Categories | COMPANY_SETUP |

Enrolliment Header Tahle script:

1 CREATE TABLE [dbo].[EDI_Enroliment] (

[ID] [numeric](18, Q) IDENTITY (1, 1) NOT NULL,
[TradingPartnerlD] [char] (15) NULL.
[EDIFileMame] [varchar] (100) NULL, —
[ImageFilePath] [varchar](300) NULL,

[ImageFileMame] [varchar] (100) MULL.

[LoadDate] [date] NULL,

[Purpose] [char] (2) NULL.

[TransactionlD] [varchar] (50) NULL,

10 [TransactionDate] [varchar] (12) NULL,

11 [TransactionTime] [varchar] (8) NULL,

12 [Action] [varchar] (2) NULL,

13 [MasterPolicyMumber] [varchar] (80) NULL,

14 [EffectiveDate] [date] NULL,

15 [ReportStartDate] [date] MULL,

16 [ReportEndDate] [date] NULL,

17 [MaintenanceEffectiveDate] [date] MULL.

18 [EnrollmentDate] [date] MULL.

19 [PaymentCommencementDate] [date] NULL,

20 [Sponsor] [varchar] (60) MULL,

21 [SponsorlDType] [varchar] (2) MULL.

22 [SponsorlD] [varchar] (80) MULL,

23 [Payer] [varchar] (60) NULL,

24 [PayerlDType] [varchar] (2) NULL, =

b [ L ESFE I T RPN Y BER T A Y U )

|»

] O A L RO

[T+ s-]

Save | Execute Scriptl

Help | Close |

The "Create SQL Tables" window

This window allows you to edit, save and run the table scripts.
3. Define the following options:
e Database
¢ Microsoft SQL Server
e MySQL

¢ Enrollments Table Script — SQL statements to create the Enrollment table in your
database.

e Benefits Table Script — SQL statements to create the Benefits table in your
database.

e Reporting Categories Script - SQL statement to create the Reporting Categories
table

Tip: You can modify the scripts so that they run on your specific database.
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[ Create SQL Tables

Database
E & Microsoft SOL Server ~ MySQL
Enroliment Tables script:

(CREATE TABLE [dbo] [ED_Eneoliment] | -
(D) [rameeric)iA 8, 00 IDENTITY (1,1 MOT NULL |,
[TradingPartnerD] [char] (151 COLLATE SGL_Latind_General _CP1_CL_AS NULL | =l
[EDHF letdmeme] [varchar] (100) COLLATE SEL_Letind _Gensral_CP1_CI_AS MULL |
(ImmgeFierimme] [varchar) (1000 COLLATE SOL_Latind _General_CP1_CI_AS MULL ,
[Purpose] [char] (2) COLLATE SQL_Latind_Gensral_CP1_CI_AS NULL ,
[TransactionD] [varchar] (50) COLLATE SOL_Latind _General_CP1_CI_AS MULL ,
[TransactionDate] [varchar] (12) COLLATE SGL_Latind _General_CP1 _C1_AS NULL |
[TransactionTime] [varchar] (6) COLLATE SGL_Latind_General _CP1_C1_AS NULL |
[Action] [varchar] (2) COLLATE 2QL_Latind _General_CPM_C_AS WULL |
[MasterPolicytumber] [varchar] (800 COLLATE SGL_Latin1_General_CP1_CLAS NULL ,
[EttectiveDate] [varchar] (12) COLLATE SGL_Latind_General_CP1_C_&S NULL |
[Sponsor] [varchar] (B0) COLLATE SGL_L atinl _General_CP1_CI_AS MULL |
[SponsoriDType] [varchar] (2) OOLLATE SGL_Latind _General_CP1_CI_AS MULL ,
[SponzoriD] [warchar] (800 COLLATE S0L_Letind _Gereral_CP1_CI_AS NULL ,
[Panver] [varchar] (B0) COLLATE SGL_Latin _General_CP1_CI_AS NULL |
[PaveriDType] [varchar] (2) COLLATE SGIL_Latind _General _CP1_CI_AS MULL |,

[PayeriD] [varchar] (80) COLLATE SGL_Latin!_General CP1_CI_AS NULL , |
Save Execute Script |
Benefits Table Script:
CREATE TABLE [co] [EDN_Benetts] ( -

[ID) [reameeric)( 18, O) IDENTITY (1,13 NOT NULL |

[EneolmentiD] jrurmenc)(18, 0) NOT MULL |

[MairtenanceType] [varchar] (50) COLLATE SGL_Latind _General_CP1_Cl_AS NULL ,
[Inzuranceline] [varchar] (50) OOLLATE SOL_Latind _General_CPM_CI_AS MULL |
[Descrigtion] [varchar] (500 COLLATE SGL_Latind _General_CP1_Cl_AS MULL |

[Coveragel evel] [varchar] (3) COLLATE SGL_Latind _General_CP1_CI_AS NULL |
[CondtionResponseCode] [varchar] (1) COLLATE SGL_Latind _General_CP1_C1_AS NULL
[SignatureDate] [varchar] (12) COLLATE SGIL_Latind _General_CP1_CI_AS MULL |,
[EftectiveDate] [varchar] (12) COLLATE SOL_Latind _General_CP1_C1_AS MULL ,
[PremiumPaidtoDateEnd) [varchar] (12) COLLATE SOL_Latind _General_CP1_CI_AS MULL |,
[BereftBenin] [varchar] (12) COLLATE S0L_Latind _General_CP1_CI_AS MULL |
[BenafiEnd] [varchar] (12) COLLATE S0L_Laftind_General _CP1_CI_AZ NULL |
[LastPremiumPaidDate] [varchar] (12) COLLATE SGL_Latind_General_CP1_CI_AS NULL |
[PreviousPeriod] [varchar] (173 COLLATE S0L_Lstind _General_CP1_C1_AS NULL
[Policyhumber] [varchar] (50) COLLATE SGL_Latind _Genersl_CP1_C_&S NULL |
[CherdReportingCategory] [varchar] (500 COLLATE SGL_Latind _General_CP1_CI_AS MULL |
[PavmentPianType] [varchar] (50) COLLATE SGL_Latind _Genersl_CP1_CI_AS NULL , j

Save Execute Script |

i P
The "Create SQL Tables" window

Once you have modified the script, click "Save."

[ClertReportingCategory] [varchar] (500 COLLATE SGL_Latind _General_CP1_CI_&S MULL ,

[PaymentPlanTyps] [varchar] (50) COLLATE SGL_Latind_General_CP1_Cl ; |
i Save | | Execute Script |
i

: 7z

The "Save" button

For each script, click "Execute Script” to create the corresponding table in the database.

[ClenReportingCategory] [warchar] (50) COLLATE S0L_Latind _General _CP1_CI_A%S MULL ,

[PaymentPlanType] [varchar] (50) COLLATE SGL_Lafind_General CP1_CI_AS MULL ,
Save | Execute Script

. - =
The "Execute Script” button
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Once the table has been created successfully, you will see the following notification:

[Success T

Table successhuly created

The success message

Warning: Executing the scripts will wipe out any previous tables that you created. Remove the
script files once you are satisfied so nobody can destroy the tables by accident.

Make sure there are no any error messages for successful table creation.

Understanding and Altering the Scripts

The scripts come from two files (EDI _Enrol | ment. sql and EDI _Benefits.sql ) that are
distributed with the application.

Scripts for two databases are supplied:
e MS SQL Server
e MySQL - The open source database.

Below are the scripts for Microsoft SQL Server. The supplied SQL script files can be
modified to conform to your database specific SQL syntax. If you have other databases,
modify the supplied scripts to conform to the specific database syntax. Please, contact
HIPAAsuite if you need help with the database setup.

The tables are created using the SQL "CREATE TABLE" statement. Both tables have an I D
column that is self incrementing. The field Enrol I ment 1 D in the child table is the foreign
key and points to the ID in the header table.

CREATE TABLE [dbo].[EDI _Enrollnment] (
[ID] [numeric](18, 0) IDENTITY (1, 1) NOT NULL,
[ Tradi ngPartner|I D] [char] (15) NULL,
[EDI Fi l eNane] [varchar] (100) NULL,
[ I mageFi |l ePat h] [varchar] (300) NULL,
[ I mageFi | eNane] [varchar] (100) NULL,
[ LoadDat e] [date] NULL,
[ Purpose] [char] (2) NULL,
[Transactionl D] [varchar] (50) NULL,
[ TransactionDate] [varchar] (12) NULL,
[ TransactionTinme] [varchar] (8) NULL,
[Action] [varchar] (2) NULL,
[ Mast er Pol i cyNunber] [varchar] (80) NULL,
[EffectiveDate] [date] NULL,
[ Report StartDate] [date] NULL,
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[ Report EndDat e] [date] NULL,

[ Mai nt enanceEffectiveDate] [date] NULL,
[Enroll ment Date] [date] NULL,

[ Paynment Conmencenent Dat e] [date] NULL,
[ Sponsor] [varchar] (60) NULL,

[ Sponsor | DType] [varchar] (2) NULL,

[ Sponsor I D] [varchar] (80) NULL,

[ Payer] [varchar] (60) NULL,

[ Payer | DType] [varchar] (2) NULL,

[ PayerI D] [varchar] (80) NULL,

[ BrokerEntityCode] [char] (3) NULL,

[ Broker] [varchar] (60) NULL,

[ Broker| DType] [varchar] (2) NULL,
[BrokerlI D] [varchar] (80) NULL,

[ Broker Account] [varchar] (35) NULL,
[ Broker Account 2] [varchar] (35) NULL,
[ Subscri berl ndi cator] [varchar] (1) NULL,
[Rel ationship] [char] (2) NULL,

[ Mai nt enanceType] [char] (3) NULL,

[ Mai nt enanceReason] [char] (3) NULL,
[BenefitStatus] [char] (1) NULL,

[ Medi car ePl anCode] [char] (1) NULL,

[ Medi careEligibilityReason] [char] (1) NULL,
[ COBRACode] [char] (2) NULL,

[ Empl oynment St atus] [char] (2) NULL,

[ Student Status] [char] (1) NULL,

[ Handi capl ndi cator] [varchar] (1) NULL,
[ Deat hDat e] [varchar] (12) NULL,

[ ConfidentialityCode] [char] (1) NULL,
[BirthSequence] [varchar] (3) NULL,

[I nconeFrequency] [char] (1) NULL,
[WageAmount] [numeric] (8, 2) NULL,

[ Hour sWor ked] [numeric] (3, 0) NULL,
[WorkLocation] [varchar] (30) NULL,

[ Sal aryGrade] [varchar] (5) NULL,

[ Subscri ber Number] [varchar] (50) NULL,
[PolicyNumber] [varchar] (50) NULL,

[ Mermber | DTypel] [char] (3) NULL,

[ Menmber | D1] [varchar] (50) NULL,

[ Menber | DType2] [char] (3) NULL,

[ Menber |1 D2] [varchar] (50) NULL,

[ Member | DType3] [char] (3) NULL,

[ Menmber 1 D3] [varchar] (50) NULL,

[ Menber | DTyped] [char] (3) NULL,

[ Menber |1 D4] [varchar] (50) NULL,

[ Member | DType5] [char] (3) NULL,

[ Menmber | D5] [varchar] (50) NULL,

[ Menber | DType6] [char] (3) NULL,

[ Menber 1 D6] [varchar] (50) NULL,

[ Mermber | DType7] [char] (3) NULL,

[ Menmber | D7] [varchar] (50) NULL,

[ Menber | DType8] [char] (3) NULL,

[ Menber 1 D8] [varchar] (50) NULL,

[ Member | DType9] [char] (3) NULL,

[ Menmber 1 D9] [varchar] (50) NULL,

[ Menber | DTypel0] [char] (3) NULL,

[ Menber | D10] [varchar] (50) NULL,

[ Member | DTypell] [char] (3) NULL,

[ Member | D11] [varchar] (50) NULL,

[ Menber | DTypel2] [char] (3) NULL,

[ Menmber |1 D12] [varchar] (50) NULL,
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[ Menber | DTypel3] [char] (3) NULL,
[ Member |1 D13] [varchar] (50) NULL,
(50) NULL,

[ PriorCoverageMont hs] [varchar]
[ Dat eTypel] [varchar] (3) NULL,
[ Dat el] [varchar] (12) NULL,
[ Dat eType2] [varchar] (3) NULL,
[ Dat e2] [varchar] (12) NULL,
[ Dat eType3] [varchar] (3) NULL,
[ Dat €3] [varchar] (12) NULL,

[ Member Last Nanme] [varchar] (60) NULL,

[ Menmber Fi rst Name] [varchar] (35) NULL,
[ Menber M ddl eName] [varchar] (25) NULL,
[ Menber | DType] [varchar] (3) NULL,

[ Member I D] [varchar] (50) NULL,
[ CommQual 1] [varchar] (2) NULL,

[ Communi cati onNunber 1] [varchar]

[ CommQual 2] [varchar] (2) NULL,

[ Communi cati onNunber 2] [varchar]
[ Menmber Addr ess1] [varchar] (55) NULL,
[ Menber Addr ess2] [varchar] (55) NULL,
[ MenberCity] [varchar] (30) NULL,

[ Member State] [varchar] (2) NULL,

[ Menmber Zi p] [varchar] (15) NULL,

[ Menber Country] [varchar] (3) NULL,

[ Menber Area] [varchar] (30) NULL,

[ Member County] [varchar] (30) NULL,

[ Member Subdi vi si on] [varchar] (3) NULL,
[ Menber Bi rt hday] [varchar] (12) NULL,

[ Menber Sex] [varchar] (1) NULL,

[ Member Maritial Status] [varchar]

[ Member Racel] [varchar] (3) NULL,
[ Menber Race2] [varchar] (30) NULL,
[ Menber RaceCol | ection] [varchar]
[ Menmber Ci ti zenshi pStatus] [varchar]

[ Col nsurance] [money] NULL,
[ CoPayment] [nmoney] NULL,

[ Deducti bl e] [noney] NULL,
[Prem unl [roney] NULL,

[ Heal t hRel at edCode] [char] (1) NULL,

[ Hei ght] [varchar] (6) NULL,
[ Wei ght] [varchar] (10) NULL,

[ LanguageCodeli st] [varchar] (2) NULL,

[ Language] [varchar] (3) NULL,
[ LanguageDescri ption] [varchar]

[IncorrectFirstName] [varchar]
[I'ncorrect M ddl eName] [varchar]

[ Mai | i ngSubdi vi si on] [varchar]

[ Empl oyer Nanme] [varchar] (60) NULL,
[ Empl oyer 1 D] [varchar] (50) NULL,

(50) NULL,

(30) NULL,

(80) NULL,

[ LanguageUse] [varchar] (2) NULL,

[IncorrectlLast Name] [varchar] (60) NULL,

(35) NULL,
(25) NULL,

[Incorrect| DType] [varchar] (2) NULL,

[IncorrectI D] [varchar] (30) NULL,

[IncorrectBirthday] [varchar] (12) NULL,

[I'ncorrectSex] [varchar] (1) NULL,

[ Mai i ngAddress1] [varchar] (55) NULL,

[ Mai l'i ngAddress2] [varchar] (55) NULL,

[MailingCity] [varchar] (30) NULL,

[MailingState] [varchar] (2) NULL,

[ Mai l'ingZi p] [varchar] (15) NULL,

[Mai lingCountry] [varchar] (3) NULL,
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[ Empl oyer CormmQual 1] [varchar] (2) NULL,

[ Enmpl oyer CommNunmber 1] [varchar] (50) NULL,

[ Empl oyer CommQual 2] [varchar] (2) NULL,

[ Empl oyer CommNumber 2] [varchar] (50) NULL,

[ Empl oyer Address1] [varchar] (55) NULL,

[ Enpl oyer Addr ess2] [varchar] (55) NULL,

[ Empl oyerCity] [varchar] (30) NULL,

[ Enpl oyer State] [varchar] (2) NULL,

[ Empl oyer Zi p] [varchar] (15) NULL,

[ Enpl oyer Country] [varchar] (3) NULL,

[ Empl oyer Subdi vi si on] [varchar] (3) NULL,

[ School Name] [varchar] (60) NULL,

[ School CommQual 1] [varchar] (2) NULL,

[ School CommNunber 1] [varchar] (50) NULL,

[ School CommQual 2] [varchar] (2) NULL,

[ School CommNumber 2] [varchar] (50) NULL,

[ School Address1] [varchar] (55) NULL,

[ School Addr ess2] [varchar] (55) NULL,

[ School City] [varchar] (30) NULL,

[ School State] [varchar] (2) NULL,

[ School Zi p] [varchar] (15) NULL,

[ School Country] [varchar] (3) NULL,

[ School Subdi vi si on] [varchar] (3) NULL,

[ Cust odi anLast Name] [varchar] (60) NULL,

[ Cust odi anFi rst Name] [varchar] (35) NULL,

[ Cust odi anM ddl eName] [varchar] (25) NULL,

[ Cust odi anl DType] [char] (2) NULL,

[ Custodi anl D] [varchar] (80) NULL,

[ Cust odi anCommQual 1] [varchar] (2) NULL,

[ Cust odi anCommNunber 1] [varchar] (50) NULL,
[ Cust odi anConmQual 2] [varchar] (2) NULL,

[ Cust odi anCommNunber 2] [varchar] (50) NULL,
[ Cust odi anAddress1] [varchar] (55) NULL,

[ Cust odi anAddress2] [varchar] (55) NULL,
[CustodianCity] [varchar] (30) NULL,

[ Custodi anState] [varchar] (2) NULL,

[ Custodi anzi p] [varchar] (15) NULL,

[ Cust odi anCountry] [varchar] (3) NULL,

[ Cust odi anSubdi vi si on] [varchar] (3) NULL,

[ Responsi bl eType] [varchar] (3) NULL,

[ Responsi bl eLast Name] [varchar] (60) NULL,

[ Responsi bl eFirst Name] [varchar] (35) NULL,
[ Responsi bl eM ddl eNanme] [varchar] (25) NULL,
[ Responsi bl el DType] [varchar] (2) NULL,

[ Responsi bl el D] [varchar] (30) NULL,

[ Responsi bl eConmQual 1] [varchar] (3) NULL,

[ Responsi bl eCommNunber 1] [varchar] (50) NULL,
[ Responsi bl eConmQual 2] [varchar] (3) NULL,

[ Responsi bl eCommNurnber 2] [varchar] (50) NULL,
[ Responsi bl eAddress1] [varchar] (55) NULL,

[ Responsi bl eAddr ess2] [varchar] (55) NULL,

[ Responsi bl eCity] [varchar] (30) NULL,

[ Responsi bl eState] [varchar] (2) NULL,

[ Responsi bl ezip] [varchar] (10) NULL,

[ Responsi bl eCountry] [varchar] (3) NULL,

[ Responsi bl eSubdi vi si on] [varchar] (3) NULL,
[DropOf f Locati onLast Name] [varchar] (60) NULL,
[ DropOf f Locati onFirst Nane] [varchar] (35) NULL,
[ DropOf f Locati onM ddl eNane] [varchar] (25) NULL,
[ DropOf f Locati onAddress1] [varchar] (55) NULL,
[DropOf f Locati onAddress2] [varchar] (55) NULL,
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[DropOf fLocationCity] [varchar] (30) NULL,

[DropOf fLocationState] [varchar] (2) NULL,

[DropOf fLocationZip] [varchar] (10) NULL,

[ DropOf fLocati onCountry] [varchar] (3) NULL,

[ DropOf f Locati onSubdi vi sion] [varchar] (3) NULL,

[DisabilityType] [varchar] (3) NULL,

[Di sabilityDi agnosi sQual] [varchar] (2) NULL,

[Di sabilityDi agnosi s] [varchar] (20) NULL,

[Di sabilityBegin] [varchar] (12) NULL,

[Di sabilityEnd] [varchar] (12) NULL,

CONSTRAI NT [ PK_EDI _Enrol I ment] PRI MARY KEY CLUSTERED

(

[1D] ASC

YW TH (PAD_I NDEX = OFF, STATI STICS NORECOMPUTE = OFF, | GNORE_DUP_KEY = OFF, ALLOW ROW L(X

) ON [ PRI MARY]

CREATE TABLE [dbo].[EDI _Benefits] (
[1D [bigint] IDENTITY (1, 1) NOT NULL,
[Enroll ment1 D] [numeric] (18, 0) NOT NULL,
[ Mai nt enanceType] [varchar] (50) NULL,
[I'nsurancelLine] [varchar] (50) NULL,
[Description] [varchar] (50) NULL,
[ CoverageLevel] [varchar] (3) NULL,
[ Condi ti onResponseCode] [varchar] (1) NULL,
[ SignatureDate] [varchar] (12) NULL,
[EffectiveDate] [varchar] (12) NULL,
[ Prem unPai dt oDat eEnd] [varchar] (12) NULL,
[ BenefitBegin] [varchar] (12) NULL,
[BenefitEnd] [varchar] (12) NULL,
[ Last Prem unmPai dDate] [varchar] (12) NULL,
[ PreviousPeriod] [varchar] (17) NULL,
[PolicyNumber] [varchar] (50) NULL,
[ClientReportingCategory] [varchar] (50) NULL,
[ Payment Pl anType] [varchar] (50) NULL,
[ Count yCode] [varchar] (50) NULL,
[ PriorCoverageMont hs] [varchar] (50) NULL,
[ Col nsurance] [varchar] (10) NULL,
[ CoPayment] [varchar] (10) NULL,
[ Deducti bl e] [varchar] (10) NULL,
[Premium [varchar] (10) NULL,
[Provider Type] [varchar] (50) NULL,
[ Provi der Last Name] [varchar] (60) NULL,
[ Provi der First Name] [varchar] (35) NULL,
[ Provi der M ddl eName] [varchar] (25) NULL,
[Providerl DType] [varchar] (2) NULL,
[Providerl D] [varchar] (30) NULL,
[ Provi derRel ati onshi p] [varchar] (2) NULL,
[ Provi der Address1] [varchar] (55) NULL,
[ Provi der Address2] [varchar] (55) NULL,
[ProviderCity] [varchar] (30) NULL,
[ProviderState] [varchar] (2) NULL,
[ ProviderZzip] [varchar] (15) NULL,
[ Provi der Country] [varchar] (3) NULL,
[ Provi der LocationQualifier] [char] (2) NULL,
[ Provi der Location] [varchar] (30) NULL,
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[ Provi der Subdi vi sion] [varchar] (3) NULL,
[ Provi der Phone] [varchar] (20) NULL,

[ PCP_ChangeReason] [varchar] (2) NULL,

[ PCP_ChangeDate] [varchar] (12) NULL,

[ Provi der2Type] [varchar] (50) NULL,
[Provi der2Last Name] [varchar] (60) NULL,
[ Provi der 2Fi rst Name] [varchar] (35) NULL,
[ Provi der 2M ddl eName] [varchar] (25) NULL,
[ Provi der 21 DType] [varchar] (2) NULL,
[Provider2I D] [varchar] (30) NULL,

[ Provi der 2Rel ati onshi p] [varchar] (2) NULL,
[ Provi der 2Addr ess1] [varchar] (55) NULL,
[ Provi der 2Addr ess2] [varchar] (55) NULL,
[Provider2City] [varchar] (30) NULL,
[Provider2State] [varchar] (2) NULL,

[ Provider2zip] [varchar] (15) NULL,

[ Provi der2Country] [varchar] (3) NULL,
[Provi der2Locati onQualifier] [char] (2) NULL,
[ Provi der 2Location] [varchar] (30) NULL,
[ Provi der 2Subdi vi si on] [varchar] (3) NULL,
[ Provi der 2Phone] [varchar] (20) NULL,

[ PCP2_ChangeReason] [varchar] (2) NULL,
[ PCP2_ChangeDat e] [varchar] (12) NULL,

[ COB_Sequence] [varchar] (1) NULL,

[ COB_Policy] [varchar] (30) NULL,

[ COB_Code] [varchar] (1) NULL,

[ COB_ServiceTypeCode] [varchar] (2) NULL,
[ COB_GroupNo] [varchar] (50) NULL,
[COB_Type] [varchar] (2) NULL,

[ COB_Nane] [varchar] (50) NULL,

[ COB_|I DType] [char] (2) NULL,

[COB_ID [varchar] (30) NULL,

[ COB_Addressl] [varchar] (55) NULL,

[ COB_Address2] [varchar] (55) NULL,

[COB _City] [varchar] (30) NULL,
[COB_State] [varchar] (2) NULL,
[COB_zip] [varchar] (15) NULL,

[ COB_Country] [varchar] (3) NULL,

[ COB_Subdi vi sion] [varchar] (3) NULL,
[COB_CommQual ] [varchar] (3) NULL,

[ COB_ConmmNum [varchar] (50) NULL,

[ COB_Begin] [varchar] (12) NULL,

[ COB_End] [varchar] (12) NULL,

[ CcOB2_Sequence] [varchar] (1) NULL,
[COB2_Policy] [varchar] (30) NULL,

[ COB2_Code] [varchar] (1) NULL,

[ COB2_ServiceTypeCode] [varchar] (2) NULL,
[ COB2_GroupNo] [varchar] (50) NULL,
[COB2_Type] [varchar] (2) NULL,

[ COB2_Nane] [varchar] (50) NULL,

[COB2_I| DType] [char] (2) NULL,

[coB2_I D] [varchar] (30) NULL,

[ COB2_Address1] [varchar] (55) NULL,

[ COB2_Address2] [varchar] (55) NULL,
[COB2_City] [varchar] (30) NULL,
[CcOB2_State] [varchar] (2) NULL,
[CcoB2_zip] [varchar] (15) NULL,

[ COB2_Country] [varchar] (3) NULL,

[ COB2_Subdi vi si on] [varchar] (3) NULL,
[CcOoB2_CommQual ] [varchar] (3) NULL,
[CcOoB2_CommNuni [varchar] (50) NULL,
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[ COB2_Begi n] [varchar] (12) NULL,
[COB2_End] [varchar] (12) NULL,
CONSTRAI NT [ PK_EDI _Benefits] PRI MARY KEY CLUSTERED
(
[ID ASC
YW TH (PAD_I NDEX = OFF, STATI STICS NORECOMPUTE = OFF, | GNORE_DUP_KEY = OFF, ALLOW ROW L(X
) ON [ PRI MARY]

CREATE TABLE [dbo].[ EDI _ReportingCategories] (
[1D [bigint] IDENTITY (1, 1) NOT NULL,
[Enroll mentI D] [numeric] (18, 0) NOT NULL,
[ Nanme] [varchar] (60) NULL,

[ Ref erenceQual 1] [char] (3) NULL,

[ Ref erencel D1] [varchar] (50) NULL,
[ Ref erenceQual 2] [char] (3) NULL,

[ Ref erencel D2] [varchar] (50) NULL,
[ Ref erenceQual 3] [char] (3) NULL,

[ Ref erencel D3] [varchar] (50) NULL,
[ Ref erenceQual 4] [char] (3) NULL,

[ Ref erencel D4] [varchar] (50) NULL,
[ Ref erenceQual 5] [char] (3) NULL,

[ Ref erencel D5] [varchar] (50) NULL,
[EffectiveDateStart] [date] NULL,
[EffectiveDat eEnd] [date] NULL,
CONSTRAI NT [ PK_EDI _Cat egori es] PRI MARY KEY CLUSTERED

(
[1D] ASC
)W TH (PAD_I NDEX = OFF, STATI STI CS_NORECOMPUTE = OFF, | GNORE_DUP_KEY = OFF, ALLOW ROW LOC
) ON [ PRI MARY]

7.5 Browsing Exported Data

You can access the enrollment records in the database. Follow the instructions below.

1. Select Database » Stored Enrollments in the main menu.

EHiPaa Enrollment Master - 32bit

File  View (| Database | CodeSets Setup Log

Ea Connection and Cuats Fields |

= | Stored Eneoliments |

 Output Mo Create 834 EDI Files
& Screen Table Creation

The "Stored Enrollments” menu option

2 ¥

2. The "Stored Enrollments” window opens. The application immediately accesses all the
records in the database and selects the first record of the set to display. The window
allows you to navigate through the records; to create queries and select a certain
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subset of your records.

Stored Enrollments

| SELECT TOP 28 = FROM Enrollment - Execute Query

Clear Query
- Create 834 EDI File

Enrollment Tables | Build your own queryl

w2y i [ewke]

Io: |1 Query MemberLasthame: | Query

Sponsarll: | Queery MemberFirstiame: | Query
Filename: |834_I39.ad| Query MemberlD: I |mw I
Sponsor | |ouew |

Enrollment Header: Enrollment Details:

Field Yalue I0 | EnrollmentiD MaintenancelType Insuranceline Descripti

1
TradingPartnerlD 90123457 20000
EDIFileMame G34_09 edi

ImageFilzPath

Help | Cancel L

The "Stored Enrollments" window

3. To access only the records that you want to see or work with, you can enter a SQL
query into the text box on top and click "Execute Query."

Stored Enrollments

1'SELECT *
2 FROM Enrollment

Clear Query
- Create 834 EDI File

Enroliment Tables | Build your own querrl
i 1 of4 | b ¥l |ViewRecord

o i Query MemberLastName: | Query

SponsorD: | Query MemberFirstiame: | Query
Filenarme: [534_09 edi Query MemberlD: | lGuer\' |
Sponsar: | [uery |

Enroliment Header: Enroliment Details:

Field Walue {[n] | EnrollmentID MaintenanceType Insuranceline Descripti

_1

TradingPartnerlD 90123457 20000

EDIFileName 183409 edi

ImageFilePath [l r

Help | Cancel L

The query field and the "Execute Query" button

Alternatively, type a desired value in the text boxes below and click on "Query".
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Stored Enrollments M=
1 SELECT * - Execute Query
2 FROM Enrollment -
Clear Query
= Create 834 EDI File

Enrollment Tables | Build your own queryl

i 4|1 ofd | b M |mnamrd

Io: | {1 Query MemberLastName: | |Lasthame uery |1
SponsorD: |222 Qusery MamberFirsthamea: IFlrstNama Gluery
Filename: | 534_09.edi Query MemberlD: |[111 [ cuery |
Sponsor | |Sponsor | query | - o
Enrollment Header: : Enmlln;nnt Details:
|Field | Value ID | EnrolimentlD | MaintenanceType | Insuranceline
1
TradingPartnerlD 90123457 20000
EDIFileMame 834_09 edi
ImageFilePath Ml

Specify values in the fields and click "Query"”

You can also use the "Build your own query" tab.

Stored Enrollments H[:l E
1 SELECT * - Execute Query
2 FROM Enrollment -
Clear Query
- Create 834 EDI File
Enrollment Tables (E""ﬂ your own H"ﬂllfj

Figld Usein gquery | Condiion Crteria or
I— 2
TradingParnerD - =
EDIFilename r |
ImageFilePath - |
ImageFileMame - |

Help | Cancal L

The "Build your own query" tab

4.To preview a record in a separate window, click on the "View Record" button.
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stored Enrollments

1 SELECT *
2 FROM Enrollment

Enrollment Tables | Build your own query |

The "View Record"” button

4 4 |1

A preview window will open.

View Enrollment Record

: Print | Close = 1/1 — | Help |
Enrollment Record
Transaction: Pupose 1] Date Time Ref. Transaction ID Action Code | Polioy Number | Effective Date
Original DHCS834-DA-2011 | 090172011 Update
Sponzer California Department of Fayer  Dental Plan 4912 [TPNB reker l #poount Number
L Fl 68-0317191 L FI 777888999 L
Insured Infermation
SubiDep Relationship Maint. Type Maint. Reason Ben, Status Medicare Plan Code Handicap
Subscriber Sell No Reason Ghven Clive Medicare A and B
CDBERA Qualifying Event Employment Status Student Status Birth Order Death Date
Active
Subgcribiel Numbed Blember Folicy Hummber Clignt Mumber Caze Humber Cross Reterence Humber
111111111 0;20100204; 1101111113735 RAYGA1178
Mamber Lart Nama First Hame Middle Talaphone
MCGEORGE GEORGE (702) 555-1212
Address City State | Zip Country | County Bith Date Sex
777 GEORGE AVENUE APT 222 LOS ANGELES CA CA | 90020-1101 19
B aritial Status Raoe | Citizenship Language Hiealth related Codes Height Weight
Memherlnromellncome Frequency lHnuls'll'l‘mlted lDepaHmenl Salany Grade Drizablity Type Dizability ICD-2 Code
Framium Amount | Deductible Amount | Co-Fayment Amount | Co-Insurance - Acual Dizability From Dizability To
Mailing Address Information
Balling Address City State Zip
PO BOX 12345 LOS ANGELES CA CA S0048-1234
Coverage Inférmation:
Elaintenance Type Insurance Ling Dascaiption Covarage Leval
1 Addition Dental 491;01
Benefit Begin Benefit End
0912011 09730:2011 | |
blaintenance Type Irsuranoe Ling Dresctiplion I Coverage Lewel
2 Addition Dental 491:01 [
Beneiil Begin Benefit End
08012011 08312011

The "View Enrollment Record” window

Clicking on the "Create 834" button is described in Creating 834 EDI Files from the
Attached Database.

Stored Enrollments

1 SELECT *
2 FROM Enrollment

Clear Query

b ( Create 634 EDI File

Enroliment Tables | Build your own query |
The "Create 834 EDI File" button
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7.6 Troubleshooting

Errors while Configuring Database

Study the errors in detail and see what went wrong.

Fields do not exist

This error means the fields do not exist in the database that you specified.

[ SqL Errors

=]

======= Table EDI_Benefits =======

Irealid column name ‘CondionResponseCode’.

Irvalid column name "SignatureDate’.

Irealid column name ‘PremiumPaidtoDateEnd’.
Irvalid column name ‘LastPrermiumPaidDate’.
Irvalid column name "PreviousPeriod”.

Irealid column name "ClientReportingCategory’.
Irwalid column name 'PaymentFlanType’
Irvalid column name ‘CountvCode'.

Irvalid colurmn name "ProrCoveragebaonths'.
Irvalid column name ‘FrovderCountry'.

[rvalid column name ‘FroviderLocationCualifier'.

Irvalid column name ‘ProwderLocation'.
Irealid column name ‘ProviderSubdnazion”.
Irvalid column name ‘ProviderPhone’,
Irvalid column name 'PCP_ChangeDate’.
Irvalid column name "COB_Policy’.

Irvalid column name "COB_SericeTypeCode’.
Irvalid colummn name ‘COB_Type'.

Irvalid colurmn name "COB_IDType".

Irvalid column name "COB_Address1",
Irealid column name "COB_Address 2",
Irvalid colurn name "COB_City',

Irvalid column name "COB_State’

Irvalid colurnn name "COB_Zip".

[rvalid column name "COB_Country'.
Irvalid column name "COB_Subdmasion’.

Help - What is going on |

| ¥

=
C_Uncheck Fields in EHDID{}(

The error screen you will see if the field selection contains non-existing fields

In our example, our best option is to click the "Uncheck the Fields in Error" button and

return to the field selection screen.

© <2003> Martin Scholl Consulting, Inc.




102 HIPAA Enrollment Master

Fields o be exported
Header Table:
¥ Trading PartnerlD
| TransactionMNo
7| Flename
» | HandiingCoda
[*] Tota 1Ameurt
| Effective Date
| SenderAccounts
|| Recaiverfooount
[ PaymentsMethod

J.Cl:-'.'emge Period
| ReceverMame
| Feceiver D

The fields in error are now unchecked

Error while establishing connection
If the ODBC connection is not set properly, you can receive an error message like this:

Eror x|

@ Error has oooured whibs establishing connection

[ 1]

Errors while Data Export

When you start exporting claims into the staging tables, you might encounter errors at
first. This usually results from table definition issues. The HIPAA Enrollment Master
displays a detailed error message that tells you which claim failed, at what field and if
applicable which line. This information should help you to troubleshoot the problems.

By carefully analyzing the message, you can clearly identify the problem and eliminate
those errors quickly. Feel free to consult with support if you run into problems.

Below you can find a number of typical error messages.

Error writing to a table

Below is an error message. It tells that the Table EDI _Enrol | ment is missing the column
"MaintenanceType."
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Error while writing to "EDI_Enrollment” Table

x|
Error 3265: Item cannot be found in the collection corresponding bo the requested name or ordinal. in Sub
Write_SOL_Enroliment’ while writing to Table EDI_Enrolment”

ak Field: MaintenanceType’
withe the value: '050°

O | Cancel

Error in the Header Table

Error while writing to "EDI_Benefits” Table

.
Errior 32651 Irem cannot be found in the collection corresponding bo the requested name of ordinal. in Sub
"Wirite_S0L_Enroliment’ while writing to Table "EDI_Benefits'

at Field: MaintenanceType'

withe the value: '021°

ak Benefit Mumber 1

Error in the Detail Table

Error: The data type in the target database does not allow certain characters or nulls

Error: The column width is too small for the data
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8 Creating 834 EDI Files
8.1 Setting up Company

When you create EDI files there are a few elements needed to identify your company as
the sender, the producer of this EDI file. For this matter we have the company setup
screen. You can specify your company information and other setting related to your
company in the HIPAA Enrollment Master's Company Setup.

1. To configure the program options, select Setup » Company Setup in the main menu.

FAHIPAA Envollment Master - 32bit

File Wiew Database (CodeSets Image | Setup | Log EDIExchange Help

E &% Options

Spreadsheet File Stup

Dutput Mode E Company 5
o

g Creabe Company Setup Table
i Prinker

The "Company Setup” menu

2. The following screen will appear.

Company Setup H=E

] ® Indicates Mandatony Fields
Company Informalion

Name | = IS4 Segment Sender |dantifier | *
Address1 | Qualifier [ j -
Address2 | Application Sender's Code GS_2 [ .
City | = Tax ID [ :
State I j -  Plan ID " Payor ID [
Three letter identifier to prepend

ap | Plus 4 | ta all outgoing EDI files |

EDI Yession

T onh 4010 4010 in original, otherwise 5010 T only 5010

Contact Information ISA 14 and 15
Contact Person | * || EDIFiles wil be:
Telephone [ - =  Eut | Fax [y . T Test * Production
E-Mail | ® | |[T Acknowledgement (TAT) reg.

Sawve Help | Cancel

The "Company Setup” window
You can configure the following options:
e Company Information
¢ EDI Version

¢ Contact Information
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¢ ISA 14 and 15
Read the detailed descriptions further.

3. Once you have finished editing the options, click "Save."

Save

The "Save" button

Company Information
e Name — Company name. Obligatory option.
e Address 1
e Address 2
e City — Obligatory option.
e State

e ZIP — Obligatory option.

¢ |SA Segment Sender Identification — Important option. It identifies your
organization for all EDI transactions. Most commonly the Qualifier is "ZZ" and a free

form ID up to 15 character. Obligatory option.

¢ Qualifier — Unique key to the trading partner database file. The qualifier has to be

2 bytes. Obligatory option. Approved qualifiers are:
¢ 01 Duns (Dun & Bradstreet)
¢ 14 Duns Plus Suffix

e 20 Health Industry Number (HIN)

e 27 Carrier Identification Number as assigned by HCFA

e 28 Fiscal Intermediary Identification Number as assigned by HCFA

e 29 Medicare Provider and Supplier Identification Number as assigned by HCFA

e 30 U.S. Federal Tax Identification Number

¢ 33 National Association of Insurance Commissioners Company Code (NAIC)

e 77 Mutually Defined
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® Indicates Mandaton Fislds
Company Information
Mame | * IS4 Segment Sender Identifier [ *
Address1 | Qualifier { :]"7
Address2 | Application Sender's Code G&_2 (01 - Duns (Dun & Bradstrest) <) ¥
; . = |14 - Duns Plus Suffix L
City | Tax ID 20 - Health Industry Number
= 27 - Carmier ID Number
State | = " Plan ID  PayorID 28 - Fiscal Intermediary 1D Nurr
bl | Plus 4 | Three letter identifier to prepend | |29 - Medicare Provider and Sup
; _ to all outgoing EDI files 30 - U.S. Federal Tax ID Numbs—
EDI Version 1|33 - MAIC Company Code hd )
T onhe 4010 4D010ifin original, othemise 5010 " only 5010 —
Contact Information I5A 14 and 15
Contact Persan [ EDI Files will be:
) - ~ & ’
Telephone [ _- ~ Ext| Fax [y - Test Praduction

E-tail | * | [T Acknowledgement (TAT) reg,

Save Help Cancel

The "Qualifier” drop-down menu

e Application Sender's Code GS_2 — The option represents the program or machine
that created the file. Usually the same as the ISA Segment Sender Identification.
You can select other ID if you need. Obligatory option.

e Tax ID — Obligatory option. Also called an Employer Identification Number (EIN).

e Plan ID / Payor ID — Fill in your Payer ID and Plan ID if you have one; this is only
important for the 271 and 277 transactions. Optional setting.

e Three letter identifier to prepend to all outgoing EDI files — Optional setting.
Makes your files easily identifiable.

EDI version
Specify EDI version:
e only 4010
® 4010 if in original, otherwise 5010
e only 5010
Contact Information
The contact information goes into the PER segment of outgoing transactions:
¢ Contact Person
e Telephone

e Ext
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e Fax
¢ E-mail
ISA 14 and 15

¢ EDI files will be — ISA element 14 determines if the resultant file contains test or
production data:

* test
e production

e Acknowledgement (TA1) req. — ISA element 15 indicates whether you want a TA1
acknowledgement for files that you send out.

8.2 Creating Company Setup Table
You can create the Company Setup Table by following the steps below in the HIPAA
Enrollment Master.

1. To configure the program options, select Setup » Create Company Setup Table in the
main menu.

FAH1PAA Envoliment Master - 32bit

File Wiew Database (CodeSets Image | Setup | Log EDIExchange Help

Eﬂ % Options

Spreadshest File Setup

fl.':upm L Company Setup
+ Screen r

[ Create Company Setup Table )
" Prinker o —

The "Create Company Setup Table" menu

2. The following screen will appear.
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Creabe Tahle -mm

 Database
& Wicrosoft S0L Server  MySOL/Generc

Cnrrm Setup Table seript:

CHEATE TABLE [dbe].[CoMPANY_SETUP]( -
[1o] blq:mt] IDENTITY(1,1) NOT NULL,
[Name] [varchar] (68) NULL,
! [Addressl] [varchar](55) NULL.
5 [Address2] [varcharIISS' NULL,
i [city] [varcharl(38) NuLL,
[state] [char](2) NULL,
[Zip] [char]({5) NULL,
[Zip_4] [char]li4) wNuLL,
[senderID] [varcharl(15) NULL,
11 [SenderIDQualifier] [charl(2) NULL,
12 [EdiNo] [wvarchar](15) NULL,
13 [EIN] [varchar](&8) MULL,
14 [F1leID] [charl(3) NULL,
15 [Contact] [varchar]{88) NULL,
16 [Tell [varchar]{28e) MULL,
17 [Ext]) [varchar]l(1®) MULL, —
15 [Fax] [varchar]l(2e) NULL,

19 [Emarl] [wvarchar](88) NULL,
20 [Ack] [char]{1) NuLL,
[TP] [char]i1) NuLL,

[PayorID] [varcharl(28) NULL,
81 anTh] Twarcharl{2a) s ;l

Help I Save Execute Script |

The "Create Table" window

3. This window allows you to edit, save and run the table scripts.
4. Define the following options:
e Database
¢ Microsoft SQL Server
e MySQL/Genetic

e Company Setup Table Script — SQL statements to create the Company table in
your database.

Tip: You can modify the scripts so that they run on your specific database.

5. Once you have you modified the script, click "Save."

(m Execute Script |

The "Save" button

%

4
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6. Click "Execute Script” to create the table in the database.

Save I'I_-.-Eue:ute Seript ]\l

A

The "Execute Script” button

7.0nce the table has been created successfully, you will see the following notification:

[Success ]

Table successfully created

&

The success message

Warning: Executing the script will wipe out any previous table you have created. Remove the script
files once you are satisfied so nobody can occasionally destroy the database table.

Make sure there are no any error messages for successful table creation.

8.3 Creating 834 EDI Files from the Attached Database

The HIPAA Enrollment Master has the capability to create 834 EDI files from the records
in the attached database. In general, any enrollment record that has been imported by
the HIPAA Enrollment Master can be exported as EDI file.

Records that have been added through other processes outside of the HIPAA Enrollment
Master have to be vetted for completeness. One way to do this is to create the records
and let the HIPAA Enrollment Tool generate the EDI file. Now you can test the EDI file for
compliance with a free tool such as Softshare's EDI Notepad or full-fledged HIPAA
compliance tools. If you use the EDI Exchange module, you can check outgoing EDI files
on the fly and even withhold individual records that generate warning messages.

1. Select Database v Create 834 EDI Files in the main menu.

B H1PAA Enrollment Master - 64bit
File  View (| Database |)CodeSets Setup Log
T Connection and Data Fields

Stored Eneoliments
~ Output Mo Create 834 EDI Files b
€ Scresr |_ Table Creation - |

The "Create 834 EDI Files" menu

Alternatively, access the "Stored Enrollments” window. For details, see Browsing
Exported Data. Then click on the on the "Create 834" button.
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2. The "Create 834 Transaction Sets" window will be displayed.

Create B34 TransactionSets H=E
1 BELECT" +| ~Version | [ Effective Date 1
FROM © 4010 ¢ 5010 12212013 vI
Select Trading Pariner |
Exit I Gol | Write to File | View EDI File I Help I
ISA segment i ]
Passwerd ID Type SenderID ID Type Receiver ID Date Time htechange ID  Ack /P
ISA [00 | oo | [= [ =l 130122 1206 [ | [ozz120655 [ = =l
GS segment ST segment
Sender Code Receiver Code Varsion Trensaction 1D 501010
[Gs [BE[ [ [20130122 1206 [022120655 [x| [T [834[022120655 |
BGN segment
Pupose Trensaction 1D Date Time Time Zone Referencing Transaction 1D Action
BGN | =|lo22120655 [20130122 [1206 | =l [ =
' =

The "Create 834 Transaction Sets" window

3. Before starting, enter values into the empty fields. The HIPAA Enrollment Master
will store most of the values for later use. The next time you call up this screen, it will

be completed.

4. On top we see the query. Here you can enter any query that you want or you use the
query builder discussed before and carry the query over into this screen.

Tip: Please, be reasonable, creating a file with many thousand records will take a few minutes.

5. The next block is concerned with the ISA Segment.

Note: Some values are filled in and shaded out, they are created by the program. Other fields are

blank and you have to fill them out.

Note: Once you have filled the fields out, the program will remember your values. Next time you
access the window, the program will repeat your last configuration.

e Sender ID Type, Sender ID — Your identifier. You can select "ZZ" and your name (up
to 15 letters) or your tax ID, etc. Fil in the sender’s ID qualifier and ID.

e Receiver ID Type, Receiver ID — An identifier that you can get from your trading
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partner.
6. In the "GS Segment” add the following:
e Sender Code — Repeat your sender ID from ISA_06.
e Receiver Code — Your trading partner should tell you the Receiver Code. If you are

in doubt, repeat "ISA_08."

7. For the "BGN Segment” fill out:

e Purpose — The purpose code of this transaction.
e TimeZone — Your time zone.

e Action — The action code.
e Referring Transaction ID — In rare circumstances the Transaction Id of another file

that you want to refer to may be specified.

8. A properly filled out form looks like this:
= B

— Effective Date ———

Create B34 TransactionSets
e —
F‘ 4010 5010 | [Ty;22/2013 |

1 SELECT "
2 FROM EDI_Enroliment
3 WHERE EDIFilename="834 ed
- Select Trading Pariner ‘
Exit I Gol | Write to File I View EDI File ‘ Help |
[ 'SA sagmant Password 1D Type SenderID 1D Type Receiver ID Date Inferchange D Ack
[isa oo | Joo | [zz =][mPAaAsuITE |zz ~]IrecEVER [130122 |12(15 [~ [00501 [022120655 | ”_
-GS segment ST seglnanl
Sender Code Receiver Code Transaction 1D 5010 1D
[GS [BE[HIPAASUITE  |RECEIVER [20130122 1206 [022120655 |x |uu.»uwxuum 5T [¢34[022120655 [005010x220A
— BGN segment
Purposs Transaction ID Date Time Time Zone Referencing Transaction ID Action
BGN (00 - Original ~||022120655 (20130122 [1206 |ED - Eastern Daylight Tir = | |4 - Verify |
The properly filled out screen to create a valid 834 file
9. Click the "Go!" button.
Create B34 TransactionSets "mm
1 SELECT * ~ | —Vermion =
2 FROM EDI_Enroliment ~ = Iﬁ
3 WHERE EDIFlename~"634 ed ( o |l yzens
- Select Trading Partner ‘
Exit I ( Gol D Write to File I View EDI File I Help |
[LEmE s Poseword 1D Type Sender ID ID Type Rscaiver (D Date iterchange 1D Ack
[iIsaoo | Joo | [zz =][rPAAsUITE [zz ~][rRecevER [130122 |12(15 [~ [00s01 [022120655 | |[_
-GS segment ST segment
Sendar Code Recaiver Code Varsion Transaction ID 5010 1D
[GS [BE[HIPAASUITE  |RECEIVER 20130122 [1206 [022120655 [x [005010x220A1 | [ST [834]022120655 00501032204 |
— BGN segment
Purpose Transaction ID Date Time Time Zone Referencing Transaction ID Action
BGN |00 - Original =||022120655 (20130122 [1206 |ED - Eastern Daylight Tir = | [4 - verity =l
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10.You will see an error message when some information is still missing. The information
you put in the screen is now saved for future transactions and will come up the next
time you bring up this screen.

11.The EDI transaction is now displayed in the text box below.

ISA*00* *0o* *ZZ*SENDER *ZI*RECEIVER  *100901*1554*U=00401*2441 5541 4*0*T*:~
GS*BE*SENDER*RECEIVER*1009071*1554* 24415541 4*X* 00401 0<095A1™
ST*B34*4015541 401

BGN*00*4415541 41201 00901 *1 S54*ES==*2~
REF*38*001ADE™

N1*PS*ADENA CORPORATION*FI*341376430™

N1*P5*EBS OF OHIO*FI*341636604™

N1“P5*ADENA CORPORATION®FI*341376430™

N1*TV*EBS OF OHIO*FI*EBS OF OHIO™

ACT*341696604™

INS*™1 8*001*AI*A*E=FT"

REF*0F*26860120700"

REF*1L*DD1 ADE™

REF*23*26860120700~

REF*QQ*87™

DTP*336*D8*20061027"
NM1T*IL*1*MAUK*ROCKIE*L***34*268601 207~
PER*IP==HP*4197474870~

N3I*1178 AMOY WEST RD™

MNA*MANSFIELD*0OH*44903™

DMG*DE*19550925*M*“M ™

HD*001**MM*ADENA CORP MM MMO PLAN 04/2008*FAM™

The EDI transaction is displayed in the text window

12.The transaction exists only in memory. To save it to the disk, click on the "Write to
File" button.

A dialog box will pop up and ask you for a file name.

Provide a filename and save the EDI file.

13.Now you can click on "View EDI File" to see it in the EDI editor. Read more in Using
the EDI Editor.
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w. EDI Editor :C:\tmp' ProcessedEDD Duttest].834 ‘J‘mﬂ
save
ISA*00* *Qo* *ZIYSENDER *ZIYRECEIVER *100901*1554*U*00—
GS*BE*SENDER*RECEI VER* 100901 #1554+24415541 4% X+ 00401 0X0S5A1 ~ —
ST+834+441554141~
BGN*0C0+4415541 41420100901 #1554+ ES+e+ 2~
REF*38+*001 ADE~

NL*+*PS*ADENA CORPORATION*FI*341376430~
il N1*PS*EES OF OHIO*FI*341696604~

=] N1*PS*ADEMA CORPORATION*FI*341376430~
o=] N1L*TV+EBS OF OHIO*FI*EBS OF OHIO-

il ACT+341696504-

INS*Y 184001 *AT *A+E+4FT ~

i REF*0F+*268501 20700~

£ REF*1L*001ADE~

REF*23+ 26860120700~

=4 REF*QQ+*87~

= DTP*336+*Da* 20061027~

ll NM1*+IL*1+*MALK *ROCKI EHL*+*34+ 268601207~
PER*] PedHP#4 197474870~

=1 N3*1178 AMOY WEST RD-~

o] N4*+*MANSFI ELD*OH*44903~

DMG*DE* 195500254 MM~

sewd D001 ++MM*ADENA CORP MM MMO PLAN O4/2008+*FAM-
DTP*348+DE+* 20070401~

COB*P*+G~

IN‘:*N"IQ'Q@].*M JIAJLEQUI#N-.

il REF*OF+*26850120701~

il REF* 1 *001ADE~

The newly created file in the EDI Editor
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9.1

Automating
Using the Command Line Arguments 1 (CLI)

The first part is for those who don't not have the EDI Exchange module enabled!

In order to run the HIPAA Enrollment Master from the command line or have it invoked
through another program, it is necessary to pass command line arguments to the
program to instruct it to perform the desired tasks.

Command line arguments are separated by commas.

1. The first argument after the program name is the file or directory nhame where
the source EDI files are located. The application automatically finds out if this
argument is a file or a directory.

2. The second argument indicates the output option. Valid arguments are:
e P - Printer
e A - ASCII file
e E - Microsoft Excel spreadsheet

e | - TIFF or PDF image file. If "I" is used as an argument, the claim will be saved
as a TIFF or PDF file.

See Creating Image Files from EDI for details on how to set up the Image
printing capabilities.

Be sure that you have tested the Image printing, before trying the command
line mode.

e X - Database export

Example:

This example calls the HIPAA Enrollment Master's executable and gives a folder path as
first argument and specifies database export(x) as second argument.

"C:\ Program Fi | es\ H PAAsui t e\ H PAA Enrol | nent Mast er\ H PAAEnr ol | nrent Mast er . exe" C
\'I nbox\ EDI , X
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C:wrCrsProgram FilesHIPAAPrinter~HIPAAEnrollnentPrinter.exe C:stemnpsEDl“testi, Xmm

Example 1 command entered to the Command Prompt

Using Command Prompt

Follow the instructions below to use the command-line arguments in Windows Command
Prompt.

1. Start a Windows Command Prompt. Go to Start » Programs » Accessories » Command
Prompt.

Alternatively, you can go to Start » Run » type "cmd” without quotes and press <Enter>.
2. Type your command and click Enter.

e CAWINDOWS) system32 cmd.exe

rogran FilesSHIPAAsuite“HIPAR Enrollment Hasterr_

The Windows Command Prompt screen

The command returns a system code which is not displayed to the users:
e .1 means error
® 0 means everything went okay

Testing the command line requires that you check the log (See Accessing Logs). In the
log, you may see a message like following:

Processing of 'C:/\EDI\Inbox\835" started at 3/12/2012 9:21:11 AM
Printer is not found in system
Processi ng stopped at 3/12/2012 9:21:11 AM

The log will help you to debug the command line.
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9.2

101
| Tuesday ., May 23,2012 =] Get Log | Help
AR WL T U A S 0 e o T ) A Bl NSO L )LD A 3

Anoiher instance of HIPAA Enroliment Master is running, Aborting at S/29/201 2 11: 2321 AM
Anciter instance of HIPAL Enrolliment Mazter iz nunning. Aborting at 52972012 11:23:54 AM
Ancifer instance of HIPAA Enrolliment Mazter is running. Aborting st S/29/2012 11:25:08 AM
Anciier instance of HIPAA Enrolinent Mastér is running. Aborling st S/20701 2 11:25:34 AM
Anciher instance of HIPAA Enrcliment Master is running, Aborling ol 502972012 11: 2349 AM
Another instance of HIPAM Enrolliment Master &5 running, Aborting at 52972012 11:23:58 AM

Anciter instance of HPAS Enrollment Mazter is running, Aborting at 5297201 2 11:30:30 AM

Proceszzing of the file 2.02 DHCE824.DA2011071 2-Dental-491 2-Vendor-001 edi began at 572972012 11:30:58 AM

Enroliment Records wil be exported to Excel

The file 'C:Documsnts and Settings\Admint Wy Documents'ED] Spresdshest Outpati2 02 DHCSE34-DAZ0M 1071 2-Dental-491 2-Vendor-001 xig' has been crested
2 Records have been processed

Processing of the file 202 DHCS534-DA2011071 2-Dental-495-HCP-001 edi began at 232012 11:51:04 AM

Enrolimert Records wil be exponed to Excel

The file ‘CiDocuments and Settings\Admind Wy Documents'EDI Spreadsheet Outputi2 02 DHCSE34-DA2011071 2-Dental-495-HCP-001 xds’ has been created
3 Records have been processed

Processing of the file 202 DHCS334-DA2011071 2-Medical-111-HCP-00M edi began ab 52302012 11:31:10 AM

Enraliment Records will be axported to Excel

The: file 'C:\Documents and Settings\Admin iy Documents'EDI Spreadshest Outputi2 02 DHCS834-DAZ01 1071 2-Medical-111-HCP-001 »ds” haz been created
3 Records have been processed

Frocessing of the file 2,02 DHCSE34-DA2011071 2-Medical-123-HCP-00N edi begian o S292012 1131116 AM

Enroliment Records wil be exported to Excel

The file 'C:\Documents and Settings\Admint Wy Documents'EDI Spresdshest Output' 02 DHCSE34-DAZMM 1071 2-Medical-1 23-HCP-001 ods’ has been created
B Records have been processed

Proceszzing of the file 334 adi began of S297201 2 11:31:23 AM

Enroliment Records wil be exported to Excel

The file 'C:\Documents and Settings\Admind Wy Documents'EDI Spresdehest Outputi834 «ds” has been created
6 Records have been processed

Anciher instance of HIPAA Enrolimert Master ks running, Aborting at 5297201 2 11:35.05 AM

3, Ll

The "Transaction Log" window

Using the Command Line Arguments 2

The second part is for those who have the EDI Exchange module enabled!
If you have the EDI Exchange enabled, the command line arguments change.

If you are processing incoming files then you can put all new files in the Inbox
subdirectory of your EDI file root. Now by using the single command line argument
"Auto”

:»Program Files>~HIPAAzuite~HIPAA Enrollment Master*HIPAAEnrollmentMaszter.exe

o

you will process every file in this inbox according to the setting you selected in the EDI
Exchange --> Auto Process Setup. This includes any files in a Trading Partner's remote
FTP server if FTP has been selected as a transfer method for that Trading Partner.

To set up EDI Exchange autoprocessing options, click on Autoprocess Settings under the
EDI Exchange menu:
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EDI Exchange
Check EDI File

Help

Trading Partners
[% Inbox Manager

FTP Client

SEF Files

EDI Exchange Setup
Encryption Setup

Create EDI Exchange Tables
Create 999 Files Tables

Autoprocess Setup

Automatic Scheduler

EDI Receive Log
EDI Send Log

Request EDI Exchange License |

EDI Exchange License Information

Opening the Autoprocess settings

P ™

Get Rles from Trading Partners
[C] Check FTP servers for new files and place them into Inbox

Default Automatic Processing Options
[] Export in Database

]
[11]
[%i]
(1]
Ta
=
[}
i
[¥¢]
i

=]
m
[11]

[T] Print

Saveto: [|Image  [C] Excel [T ASCII

Gancel

EDI Exchange Autoprocess settings

9.3 Creating EDI Transactions from the Database

The arguments above are concerned with the processing of incoming EDI files. But the
export of EDI transactions can also be automated and run through the command line.
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The syntax is as follows:
1. The first command is your SQL Query
2. EDI

3. The filename for the resultant EDI transaction is defined on the third place. If left
blank, then the default path and filename will be used. If you just give a directory
then the default file name will used in that directory.

4. The Trading Partner (optional). If omitted, the last trading partner used in the

Create 834 screen will be used to fill the respective ISA and GS segments.

1 SELECT* + | Version Effective Date
2 FROM EDI_Enroliment ©) 4010 @ 5010 117 32015 O~

-/ Select Trading Pariner ]

Exit || Go! ]
ISA segment =
Password ID Type Sender ID 1D Type Receiver ID Date Time Interchange ID Ack T/P
ISA |00 . 00 Z - HIPMSUITE' I A I 151103 1114 =~ 00501 307111457 0 ~ T = :
GS segment ST segment
Sender Code Receiver Code Version Transaction 1D 50101D

GS BE HIPAASUITE |:|20151103 1114 307111457 X 005010X220A1 ST 834 307111457 005010X220A
| =Tp N EE AT nt

Create 834 screen. Emphasis on Trading Partner fields.

5. The Market Code (optional) for use with Health Insurance Exchanges - "IC", "IR",
"SC", or "SR"

If included, the Market Code will be in the resulting filename. For use with Trading
Partners that expect specific filenaming conventions. To specify a filenaming
convention, go to EDI Exchange v Trading Partners and under the Folders tab
select a filenaming convention from the File Naming Convention dropdown box.

| EDI identifiers | Options | Remote FTP| Contact |Eneryption| Folders
Local Directory Settings

Outgoing Files Root Trading Partner's Outbox
D:\EDNOutbox \ LOCAL (=%

Proce=zed Files Root Trading Partner's Repository

D\EDN\ProcessedFiles \ LOCAL [

File Naming Convention [ Create Folders Using Trading Partner ID ]

6. Frequency (optional) - "D" or "M".
The frequency will be included in the resulting filename. For use with Health
Insurance Exchanges that expect a specific filenaming convention.
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Tip: The application window must be closed. Otherwise the CLI commands do not run.

Example

This example issues a SQL query and gives the file name for the 834 file:

Sel ect * from EDI _Enrol | nent where MenberFirstnane='Frank', EDI, C \Tenp\file.834

=10l |

CisrBelect » from EDI_Enrollment where HemberFirvstname='Frank’ EDI,.G:sTempsl.834

CMD command to create a file using MemberFirstName = 'Frank'’

The above command will create an 834 EDI file named "file.834" in the "C:\Temp\"
directory using the results of the query "Select * from EDI_Enrollment where
MemberFirstname = 'Frank™ and the last trading partner used to create an EDI file in the
Create 834 window.

Example

This example issues a SQL query and specifies both a filename and Trading Partner ID to

use:
Sel ect * from EDI _Enrol | mrent where MenberFirstName='Frank', EDI, C:\Tenp\file2.834, LOCAL

wProgram Files“HIPAAsuwite“~HIPAA Enrollment MHaster>*HIPAAEnrollmentMaster.exe "5
elect = from EDI_Enrollment where MemberFirstMame = *Frank®'".EDI_.C:~Temp~file2.8

CMD command to create a file using MemberFirstName =Frank’ and Trading Partner ID "LOCAL"

The above command will create an 834 EDI file named "file2.834" in the "C:\Temp\"
directory using the results of the query "Select * from EDI_Enrollment where
MemberFirstName = 'Frank™ and the Trading Partner with ID = 'LOCAL'.

Troubleshooting

The HIPAA Enrollment Master logs any use of the command line options and the reason
for a missing or incorrect EDI file can be discovered through it. For example, if the query
yielded no results, the log entry would look similar to the following:

© <2003> Martin Scholl Consulting, Inc.



122

HIPAA Enrollment Master

9.4

e ——

EDI creation started at 11:43:32
SQL CQuery: "SELECT * FROM ED_Enroliment”
Found no records.

Processing ended at 11:43:35

No results from query

A misspelled Trading Partner ID or a correct ID for an inactive Trading Partner will also
log an error in creating a file.

Changing the Default Company

The default company is the identity you assume as the sender when creating EDI files.
This affects the ISA, GS, and NM1 sender segments. A single entity may have a need to
act as multiple sender identities and so has a need to change the information in the EDI
envelopes.

The default company can be changed using command line arguments, affecting the ISA
and GS sender ID segments.

I5A Segment Sender Identifier HIFAASUITEN

Qualifier Z7 - Mutually Defined -
Application Sender's Code G5_2 HIPAASUITE *
Tax ID 9876543210 *

Sender ID segments in Company Setup

To change the default company, a single argument is needed. "Setcompany” followed by
the company ID of the company you wish to set.
"set conpany <I D>"

The Company’s ID in this case is not its EDI identifier, but the value of the ID row in the
COMPANY_SETUP table. It can also be found in the Company Setup window:

Current Company: “0Ea s EiIE v| 4 Default company
1 - TESTRESPOMNDER

2 - HIPAASUITE

3 - HIFAASUITEZ
- Add company -

Company selection in Company Setup

Example
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The command argument set conpany 3

C:~Program Files“HIPAAzuite~HIPAA Enrollment Master>HIPAAEnrollmentMaster.exe =g

will set the default company to ID = 3, which is HIPAASUITE2 in the example picture
above. The log entry for this command will be

ISet default company with ID 3
Company # 3 i= et as a default company

Excerpt from log. Default company changed.

9.5 Running the Application via Scheduler

The HIPAA Enrollment Master can be automated through a scheduler. A scheduler is
software that can be programmed to execute a certain task at a certain time
repeatedly. Windows has such a scheduler built in.

The Windows scheduler can be used to let the HIPAA Enrollment Master execute in regular
intervals without user intervention. Usually one would let the HIPAA Enrollment Master
scan a directory and then print, create image files or export the data and remove the
files to prevent duplicate processing.

Use the command line with the appropriate options as described in Using_ Command Line
Arguments (CLI).

Note: Please consult Windows help files for further information on setting up the scheduler.

1. If the task scheduler is installed on your system, you will find it in the Administrative
Tools menu. To open the Task Scheduler, click Start » Aministrative Tools » Scheduled Tasks.

Note: In different Windows versions, the way to access the Task Scheduler can differ. Consult your
Windows version documentation.
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heduler {Local)
& Task Scheduler Library

° Task Scheduler = '
File  Action Wiew Help
&= =

015 140

cheduler Surmrmanyg (Last refreshed: 1173

rFy
Owerview of Task Scheduler o
i '_'\I.I You can use Task Scheduler to
i/ create and manage comrmon
tasks that your computer will
carty out automatically at the
tirmes you specify, To begin, click
a cormand in the Action menu, _I
b
Tazk Status -
Status of tasks ., ILast M hours j
Surnimary 0 total - 0 running, 0 succeeded, ...
Task Mame Run Res
Last refreshed at 11/3/2015 1:40:59 Ph M

| Actions

Connect to Another Computer. ..

@ Create Basic Task. .
(B Create Task...
Import Task, .,
@ Display All Running Tasks
§:| Enable all Tasks History
AT Service Account Configuration
Wi [ 4

Refresh

B =

Help

The Windows Task Scheduler

2. Click on "Create Basic Task" in the Actions menu and the "Create Basic Task Wizard"
will guide you through the setup process.

3. Fillin a name and description for the new task.
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Create Basic Task Wizard

ﬂ Create a Basic Task

Trigger
Action
Finish

Use this wizard to quickly schedule a cormmon task, For more advanced options or settings
such as multiple task actions or triggers, use the Create Task command in the &ctions pane.

Marne:

Description:

HIPAS Enrollment kaster Daily Autoprocess

Daily autoprocess task for HIPAS Enrallrment Master]

< Back | Mlext = I Cancel

The "Create Basic Task Wizard" window

4. Set the Task Trigger to the desired repetition interval.
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Create Basic Task Wizard
@] Daily

Create a Basic Tazk

- Start: |11,'r 32015 j I L46:21 Ph j r Synchronize across time Zones
rigger

reemovany || ces

Action

Finizh

< Back | Tlext = I Cancel

Setting a time interval

5. Select the "Start a Program™ action.
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Create Basic Task Wizard
(9] Action

Create a Basic Tazk

Trigger YWéhat action do you want the task to perform?

Daily

Action % Start a prograrm
Finish  Send an e-rnail

" Display a message

< Back | Tlext = I Cancel

Selecting an action

6. Select the HIPAA Enrollment Master and type in your desired command line arguments.
The default location for the HIPAAEnrollmentMaster.exe executable file is "C:\Program
Files\HIPAAsuite\HIPAA Enrollment Master\".
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Create Basic Task Wizard

(9| Start a Program

Create a Basic Tazk

Trigger Prograrmyscript:
Ely "Ca\Pragramn Files\HIPAAsuite\HIPAA Enrallment Master\ HIPAAErallr | Brawse... |
Action

Start a Program &dd arguments {optional}: Ir':"-UtC'

Finish

Start in (optional): ||

< Back | Tlext = I Cancel

Selecting the executable and command line arguments

7. In the last screen, make sure you have specified all data correctly. Click "Finish" to
save your task.
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Create Basic Task Wizard
(9| Summary
Create a Basic Task
Trigger Marne: HIPAL Enrallinent baster Daiky Sutoprocess]
Daily Description: Daily autoprocess task for HIPAL Enrallmment baster
Action
Start a Program
Trigger: IDain; At 1:46 PR every day
Action: IStart a prograrm; "ChPrograrn Files\HIPASsuitetHIPAS Enrallment MasteriHI

" Cpenthe Properties dialog for this task when I click Finish
Mithen you click Finish, the new task will be created and added to your Windows schedule,

< Back | Finish I Cancel

Summary window

8. The scheduled task has been added to the system. You can now edit the task by right-
clicking it and selecting "Properties” from the context menu. Here you will be able to

specify additional parameters for the scheduled file, such as what user account to use to
run the executable and to run only when the computer has been idle for a set amount of

time.
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10 EDI Exchange

10.1 Getting Started
10.1.1 About EDI Exchange

EDI Exchange is a module available in most HIPAAsuite EDI applications. It is an option
that you can purchase for an additional cost. Some of our products, such as HIPAA Claim
Master, process EDI files but do not receive or send EDI files to and from your trading
partners. EDI Exchange is created to do that. EDI Exchange is designed for those
organizations that have a large volume of EDI files, need more order and automation and
adhere to tougher compliance rules. The EDI Exchange is an EDI pre-processor that
handles FTP transport, encryption, HIPAA compliance check, trading partner
management, etc. Outgoing EDI files can be checked for compliance; individual records
that do not pass the check can be withheld.

HIPAAsuite products with EDI Exchange module have a main menu item called "EDI
Exchange” with sub-menus to call the module’s functions.

,

File  View Database CodeSets Image Setup Log IEDIExchangeIHeIp

e i ) = Check EDI File
,;‘1. e
E - [.&Bﬂ S L ;_“:,

Trading Partners

D_dm Mode Inbox Manager

LR FTP Client

oAl SEF Files

© Spreadsheet e EDI Exchange Setup

© ASClI File Encryption Setup

() Image File Create EDI Exchange Tables
Create 999 Files Tables

[[] Data Export Autoprocess Setup

Counter . Automatic Scheduler

I PP cDiReceive Lo
Records [ | EDI Send Log

Request EDI Exchange License
b’ " EDI Exchange License Information

The "EDI &chaﬁée" menu in HIPAA Enrollment Master

EDI Exchange performs the following functions:
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¢ Trading Partners Management — The following Trading Partner's parameters can

be stored and transparently managed with the help of EDI Exchange: name,
address, EDI identifiers, delivery methods, encryption parameters, FTP servers,
CORE-Compliant server addresses and credentials, communication numbers and
folders to keep files separated, special requirements specific to this trading
partner. Read more in Setting up Trading Partners.

File Transport — EDI Exchange has a built-in FTP client that can securely connect to
your trading partner's FTP servers. If you employ your own FTP server, you can
utilize the folder structure that EDI Exchange uses to manage incoming files, users,
home directories and permissions so that your Trading Partners can drop off and
pick up EDI files. Supported are:

e Simple FTP
e FTP Secure
e Implicit FTPS
e Explicit FTPS
e Secure Shell FTP or sFTP

Read more in Using FTP Client.

Encryption — Many healthcare-related companies use encryption to cloak the
content of their EDI files. The prevalent method of encryption is PKI (Private Key
Infrastructure) that uses the product of two incredibly large prime numbers as
cipher. EDI Exchange supports PGP (Pretty Good Privacy), the leader in PKI products
as well as the open source GPG project with its Windows sub project PGP4Win. Both
are implementations of the same encryption mechanism. Read more in Using
Encryption.

File Management — EDI Exchange uses a clear directory structure to store EDI files.
The structure is based on root directories for incoming files, outgoing files,
processed files and suspended files. Below these root directories, there are
subdirectories for each trading partner and then each transaction set. Read more
in Defining Root Directory and Initializing EDI Exchange.

EDI Compliance Check — EDI standards are strict and precise; adherence to the
standards is very important so that any organization can work with them regardless
of their backend system software. EDI Exchange has a built-in compliance engine
that checks incoming files for compliance. The engine also generates a report listing
each problem with the exact location. Outgoing EDI files can also be checked and
you have an option to withhold individual records that violate the rules. Read more
in Checking EDI Files.
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e EDI Control for Transactions — The EDI protocols have a few supporting transaction
sets that are useful to the smooth functioning of EDI exchanges. They provide the
sender with an instant feedback on receipt. The following transaction sets are
available:

e TA1 Acknowledgment
® 997/999 Functional Acknowledgment
e 277U/277CA Unsolicited Claim Status Response (in case of Claims)

e Logging — EDI Exchange has several logs that are instrumental to keep processing in
order and allows to forensically investigate mishaps. There are three logs in EDI
Exchange:

¢ Incoming file log — See Accessing EDI Receive Log.

e Outgoing file log — See Accessing EDI Send Log.

e Daily transaction log

10.1.2 Requesting EDI Exchange License

If your trial has expired, you can request an extension to the trial.

If you purchased the product and need a final license key, you should request an EDI
Exchange license.

Follow the instructions below to request a trial or final license key.

1. Select "Request EDI Exchange license" under the "EDI Exchange” menu item.
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|

File  View Database CodeSets Image

1 @ Check EDI File
E — Esmr ]

o

Trading Partners
Tm Mode Inbox Manager
® Sorcen FTP Client
R SEF Files
Ll ErEaralEs EDI Exchange Setup
() ASCIl File Encryption Setup
(Z) Image File Create EDI Exchange Tables

Create 999 Files Tables
[[] Data Export Autoprocess Setup
Counter \ Automnatic Scheduler

s [ ] 8 . EDI Receive Log
Records [ | Bl EDISendlog

Request EDI Exchange License
Run .' | ' a EDI Exchange License Information

Run with

A menu item to request a license key

2. Once you have clicked this menu item, your default email application appears. In our
case, it is Microsoft Outlook. All information necessary to produce the key is
automatically filled out.

From ~ Martin.Scholl@HIPAALuite.com

= ;‘l [
Send L
Ct...

Bic... !

Subject: | [EDI Exchange) 75 DCFEEF]: Request for License

Request for License

Product: EDI Exchange
Veolume ID: JEDCFBBF

Current Key:

KE"'I': - NP - e e

Email message created by EDI Exchange

3.You can add a trial extension or a final key after purchasing or relocating the
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software.

Once you receive the response with the key for EDI Exchange, you can bring the
"Registration Form" screen up again and click on "Register”. Enter the key to unlock EDI
Exchange. In the Result area, you will see that EDI Exchange has been registered.

'__\'* Registration Form [—J..

License Registration Form
EDI Exchange

License Key

Reqister ] | Close

Result

Thank you for evaluating ED| Exchange!
EDN BExchange is fully functional with certain trial limitations.
This evaluation version expires in 14 days

L
Entering the license key

10.1.3 Registering EDI Exchange

EDI Exchange is licensed separately from the host application, HIPAA Claim Master, for
example. The reason is that EDI Exchange will work on all HIPAAsuite Products that are
installed on your particular computer. For example, if you have HIPAA Claim Master and
HIPAA Enrollment Master licensed, only one license of EDI Exchange is needed and the
module will work across two products.

When you first install a HIPAAsuite product of your choice, a 15-day EDI Exchange trial is
included. Once the trial expires, EDI Exchange loses its functionality. The menu items
under "EDI Exchange"” become disabled except the last ones that allow you to license and
enable the product.
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@ s ssmvese s

File  Forms View Search  Claim Entry/Edit DataBase CodeSets Logs Image  Setup | EDIExchange | Help
ﬁ r 2 Z Check EDI File
| < Enr! ; o

Trading Partners -

Output Mode % Inbox Manager

(©) Printer FTP Client

@ S SEF Files

= P AN .

©) Image File B EDI Exchange Setup
Encryption Setup

[ Data h Create EDI Exchange Tables
Create 999 Files Tables

Claim T

- Prof::;znal e Autoprocess Setup

- & Automatic Scheduler

) Institutional S

@ Dental b | EDI Receive Log

) Reporting EDI Send Log

Counter Request EDI Exchange License

EDI Files l:l EDI Exchange License Information

Total Amourt

The "EDI Exchange” menu with menu items disabled

You can register the product by clicking on the "EDI Exchange License Information” option
under the "EDI Exchange"” menu.

Setup Log | EDIExchange | Help
Check EDI File

Trading Partners
Inbox Manager
FTP Client
SEF Files

EDI Exchange Setup
Encryplion Setup

Create EDI Exchange Tables
Autoprocess Setup
Automatic Scheduler

EDI Receive Log

"EDI Exchange License Information” option under the "EDI Exchange”

Then the license screen appears. In the lower left corner you can find the unique
registration number needed to create either trial extensions or final licensing.
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EDI Exchange
1.0
Dayi{=) remaining for trial 8
.|
This software is for evaluation purposes only and has limited
functionality

You will have to purchase this software if you want to continue using it
after a free evaluation has expired.

2E2F5160 [ 1w | o I Riagister I

The license information screen

Once you click on "Register,"” you can enter the license key that you have previously
received via email from us (see Requesting EDI Exchange License.) Click on "Register" and
you will see the registration message in the "Result” area.

License Registration Form
EDI Exchange

License Key

[ Fegister ][ Close

Result

Thank you for evaluating EDI Exchange!
EDN Bxchange is fully functional with certain trial limitations.
This evaluation version expires in 14 days

Extending the trial by entering a license key

Close the "Registration Form" and continue using the EDI Exchange.

10.2 Configuring EDI Exchange (Obligatory Settings)
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10.21

10.2.2

1 Setting up Database Connection

EDI Exchange work is based on the database connection that you define under Database »
Connection and Data Fields in the main menu of the HIPAA host application. Make sure
the connection has already been set up and tested before proceeding with EDI Exchange.

Then proceed to the next step: Creating Database Tables.

2 Creating Database Tables

Once you have configured the database connection (Setting up Database Connection),
follow the instructions below.

1. Select EDI Exchange » Create EDI Exchange Tables in the main menu.

Setup Log | EDIExchange | Help
4 Check EDI File

Trading Partners
Inbox Manager
FTF Chent

SEF Fles

EDI Exchange Satup
Encryption Setup

Create EDI Exchange Tables
Autoprocess Setup
Automatic Scheduler

EDI Receive Log
EDI Send Log

Request EDI Exchange License
: EDI Exchange License Information
The menu item to create the necessary tables.

2.The "Create Tables for EDI_Exchange" screen will appear. Table creation and/or
modification for your database is handled here.
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Create Tables for EDI_Exchange

Database: * Microsoft SQL Server © MySQL/Generic
Trading Partner | TRANS_LOG | TRANS_LOG_ERRORS | SEND_LOG | COMPANY_SETUP |

C:ProgramDatalHIPAA Suite\HIPAA Enrollment Master\Scripts\TradingPartner_5QL Server.sql

1 C‘FtEATE TABLE [dbo] [TradingPartner]|
[TradingPartneslD] [varchar](15) NOT NULL,
3 [TradingPartner D_QUAL] [varchar](s) MULL.
- [ETINMo] [varchar](15) NULL.
[MAME] [varchar](40) NULL
[Contact] [varchar]{100) MULL.
7 [Phane] [varchar](15) NULL.
8 [Extension] [varchar](10) NULL.
[Email] [varchar](75) NULL.
[Fax] [varchar]{15) MULL
[LocalFtpUser) [varchar](20) NULL, =
[LocalFtpPassword] [varchar](20) NLILL,
[Address1] [varchar](100) MULL,
14 [Address2] [varchar](100) NULL.
15 :Clty] :\rﬂrchar]-ﬁﬂj: MULL
[State] [varchar](2) MULL.
[Zip] [varchar](10) NULL,
[FtpAddress] [warchar](50) MULL.
[PutDirectory] [varchar](50) NULL,
[GetDirectory| [varchar]{50) NULL
[DialupNumber] [varchar)(20) NULL,
[FtpUserName] [varchar](20) NULL.
23 IFtoPassword] lvarcharli 201 MULL =

save | Execute Script |

Help Cancel | 4

The screen to create the tables

|

P = O L

P I
P = O 00 00 =J TN

3. Select the database type you use for your host HIPAA application.
¢ Database
e Microsoft SQL Server (SQL Server 2008 and above)
e MySQL

Note: In case your database is not listed, modify the scripts or ask your database administrator to
make the necessary modifications.

4. The following tables are part of EDI Exchange:

e TradingPartner — SQL statements to create the "TradingPartner” table in your
database. This table contains information about trading partners.

e Trans_Log — SQL statements to create the "TRANS_LOG" table in your database.
This table contains incoming file information, keeps track of all EDI files that you
receive and the compliance check report.
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e Trans_Log_Errors — SQL statements to create the "TRANS_LOG_ERRORS" table in
your database. This table collects the results of the compliance check and keeps
track of all sent files.

e Send_Log — SQL statements to create the "SEND_LOG" table in your database.
The table contains information about EDI files created and sent to trading
partners.

e Company_Setup — SQL statements to create the "COMPANY_SETUP" table in your
database. This table collects information about you, the sender of EDI
information.

5. You can modify the scripts so that they run on your specific database. Once you have
you modified the script, click "Save."

Tip: Every database system has their own little syntax idiosyncrasies and the scripts might require
tweaking. You can edit the table scripts in this screen and save your modified scripts. One example
are 'date’ and 'time' or ‘'money' data types that do not exist in SQL Server 2005. You can just rename
those types to 'datetime’ and save you script and it will run fine.

F b

Database
@ Microsoft SQL Server 0 MySQL/Generic

Trading Partner| TRANS_LOG | TRANS_LOG_ERRORS | SEND_LOG | COMPANY_SETUP|

TransLog Table script:

1 CREATE TABLE [dba] [TRANS_LOG]( -
[1D] [varchar](200) NOT NULL, 7]
[PayloadID] [varchar](200) NULL.
[TRADING_PARTMNER] [varchar]{15) NULL
[TRANSACTION_TYPE] [char](3) NULL,
[ORIG_TRANSACTION_TYPE] [char](3) NULL,
[PROCESS_DATE] [date] NULL,
[PROCESS_TIME] [time](0) NULL.
[OPERATOR] [varchar](20) NULL.
[RECORD_IDS] [varchar](2000) NULL.
[RECORD_COUNT] [bigint] h{ULL

LD 00 = N T LD R

—
=

— —
fa =

m

4 [CHECK_MESSAGES] [bigint] NULL,

15 ResponseFlIe] [warchar] (300) MULL,

16 [AcknowledgementFile] [varchﬁr] (300) NULL,

17 |[ExitCode] [smallint] NULL.

18 CONSTRAINT [PK_TRANS_LOG] PRIMARY KEY CLUSTERED
19 (

20 ~ [IDjAsC

]
22 ) ON [PRIMARY]

23 —

-

[ Compare Script with existing Table ” Drop TRANS_LOG schema [ Save ” Execute Script ]

The "Save" button

6. For each script on every tab, click "Execute Script” to create the corresponding table
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in the database.

F ™

Database
@ Microsoft SQAL Server ) MySQL/Generic

 Trading Partrer | TRANS_LOG | TRANS_LOG_ERRORS | SEND_LOG | coMPANY_SETUP |

TradingPartner Table script:

1 CREATE TABLE [dba].[TradingPartner]( .
[TradingPartnerlD] [varchar](15) NOT NULL.
[TradingPartnerlD_QUAL] [char](2) NULL.
[ETINNg] [varchar](15) NULL,

[NAME] [warchar]({40) MULL,

[Contact] [varchar]{100) NULL,

[Phene] [varchar]({15) NULL.

[Extension] [varchar](10) NULL,

[Email] [varchar](75) NULL.

10 [Fax] [varchar](15) MULL, =
11 [LocalFtpUser] [varchar](20) NULL,

12 [LocalFtpPassword] [varchar](20) NULL.

13 [Address1] [varchar](100) NULL,

14 [Address2] [varchar](100) NULL,

15 [City] [warchar](30) NULL,

16 [State] [char](2) NULL,

17 [Zip] [wvarchar](10) NULL,

18 [FtpAddress] [varchar](50) NULL,

19 [PutDirectory] [varchar|(50} MULL.

20 [GetDirectory] [varchar](50) NULL.

27 [FtpArchive] [varchar](20) NULL,

22 [FtpUserName] [varchar]{40) NULL.

23 [FtpPassword] [varchar](40) NULL.

24 [FTPPort] [varchar]({12) MULL,

25 [Outbox] [varcharl{50) NULL, -

’ Compare Script with existing Table ] Save ” Execute Script l

[felye-RL s S PR FLY K )

The "Execute Script” button

Notice: Creating tables means clicking the "Execute Script” button in all five tabs of the "Create Tables
for EDI_Exchange" window. Then close this window.

7.0nce the table has been created successfully, you will see the following notification:

)

Table 'TradingPartner' successfully created

The Create Table script success message

Warning: Double-execution of a script wipes out the previous table you have created. A prompt will
warn you before deleting an existing table. To Add/Remove fields use the "Compare Script..."
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button. Remove the script files once you have created the tables so nobody can destroy the tables
by accident.

I -

:] This action will wipe cut all your data in TradingPartner table. Proceed?

(= [ % ]

. B 1
The double-execution warning message.

Make sure there are no error messages and the table creation has been completed
successfully.

Compare Script with existing Table

HIPAAsuite products go through continual development and improvements. Often these
changes lead to new fields in the database. While it is easy to drop a table and
regenerate it with the new fields, you will loose all the data in the table. To avoid this
trouble there is the button "Compare Script with existing Table". | you click this, the
table structure in your database will be compared with the script. There are two possible
outcomes. Your table is up to date

. )

You have all the fields in your table,
There is nothing to do

1 |

Table is up to date

or if your table is missing recently added fields, you will see a window pop up that shows
an ‘Alter Table' script with which you can add those fields to the table without interfering
with existing data.
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n'J Changes to your tab_ll LI_IQ

1 Alter Table TradingPartner

Add
[SourceEntitylD] [char](2) NULL.
[SourcelDQualifier] [char](2) NULL,
[SourceMame] [varchar]{50) NULL.
[SourcelD] [varchar](50) MULL

N LT ek L P

-

Execute Script ]

The 'Alter Table' script that shows as a result of missing fields

You can now click the "Execute Script” button and the field will be added and a message
will confirm your changes

. =)

Table successfully altered

| |

Alter Table statement successfully executed.

Once you have created the tables, you can start setting up the other application options.
See the next step: Defining Auto-Processing Options.

10.2.3 2b Creating 999 File Tables

Once you have configured the database connection (Setting up Database Connection),
follow the instructions below.

1. Select EDI Exchange » Create 999 Files Tables in the main menu.
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EDI Exchange | Help

Check EDI File

— Trading Partners -
é Inbox Manager
FTP Client
SEF Files

EDI Exchange Setup
Encryption Setup

Create EDI Exchange Tables
Create 999 Files Tables

Autoprocess Setup

Automatic Scheduler

EDI Receive Log
EDI Send Log

Request EDI Exchange License

EDI Exchange License Information
g [ - — L | Smm—————

The menu item to create the necessary tables

2. The "Create Tables for 999 Files" screen will appear. Table creation and/or
modification for your database is handled here.
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F ™

Database
@ Microsoft SQL Server ) Oracle O MySQL/Generic

ImplementationAck |Transac1.ionF{espcmse | SegmentErrors | Elemenﬂ'\lutes|

ImplementationAck Table script:

1 CREATE TABLE ImplementationAck( -
[ID]int IDENTITY NOT NULL.
[FileName] varchar{100) NULL.
[SenderlD] varchar(15) MULL,
[SendTime] datetime NULL.
[GroupControlNo] varchar(9) NULL,
[TransactionControlNo] varchar(9) NULL,
[FuncitionallD] char(2) NULL,
[OnginalGroupControlMa] varchar(9) NULL,
10 [Version] varchar{12) NULL.
1 [AckCode] char(1) NULL,

[IncludedTS] int NULL.
13 [ReceivedTS] int NULL,

[AcceptedTS] int MULL.

LD 00 s O 0N fe LIPS

[ErrorCode1] char{3) MULL.

[ErrorCode?] char({3) NULL,
7 [ErrorCode3] char{3) MULL.

[ErrorCode4] char{3) NULL.
19 [ErrorCode5] char{3) NULL,
20 PRIMARY KEY ([1D])

’ Compare Script with existing Table Save l [ Execute Script l

The screen to create the tables
3.Select the database type you use for your host HIPAA application.
e Database
e Microsoft SQL Server (SQL Server 2008 and above)
e Oracle
e MySQL

Note: In case your database is not listed, modify the scripts or ask your database administrator to
make the necessary modifications.

1. The following tables are part of EDI Exchange:

¢ ImplementationAck — SQL statements to create the "ImplementationAck” table in
your database. This table contains information about Acknowledgments.

¢ TransactionResponse — SQL statements to create the "TransactionResponse” table
in your database. This table contains individual transactions contained in 999 files.
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e SegmentErrors — SQL statements to create the "SegmentErrors” table in your
database. This table contains individual segments in error contained in 999
transactions.

e ElementNotes — SQL statements to create the "ElementNotes" table in your
database. The table contains the elements in error in a specific segment.

5. You can modify the scripts so that they run on your specific database. Once you have
you modified the script, click "Save."

Tip: Every database system has their own little syntax idiosyncrasies and the scripts might require
tweaking. You can edit the table scripts in this screen and save your modified scripts. One example
are 'date’ and 'time’ or ‘'money' data types that do not exist in SQL Server 2005. You can just rename
those types to 'datetime’ and save you script and it will run fine.

Database

ImplementationAck |Transac1ionF{esponse | SegmentErrors | EIementhrtes|

F B

@ Microsoft SQL Server ) Oracle @ MySQL/Generic

ImplementationAck Table script:

1 CREATE TABLE ImplementationAck(
[1D] int IDENTITY NOT NULL.
[FileName] varchar(100) NULL
[SenderlD] varchar(15) MULL.
[SendTime] 5 NULL.
[GroupContralMNo] varchar(9) NULL,
| TransactionCaontrolMo] varchar(9) NULL,
[FuncitionallD] char(2) NULL,
[CnginalGroupControlMNa] varchar(9) NULL,
10 [Version] varchar(12) NULL.
1 [AckCode] char{1) NULL,
12 [IncludedTS] int NULL.
13 [ReceivedTS] int MULL,
B lAcceptedTS] int MULL.
15 [ErrorCode1] char{3) NULL,
16 [ErrarCade2] char{3) NULL,
7 [ErrorCode3] char{3) NULL,
)
)

[Telye-TL ey A g RN - SN LN

18 [ErrarCade4] char{3) NULL,
19 [ErrorCodeb] char{3) NULL.
20 PRIMARY KEY ([ID])

-

[ Compare Script with existing Table Save ] [ Execute Script ]

The "Save" button

6. For each script on every tab, click "Execute Script” to create the corresponding table

in the database.
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F ™

Database
@ Microsoft SQL Server ) Oracle O MySQL/Generic

| Implementationfck | TransactionResponse |SegmentError3| Elemenﬂnlntes|

SegmentErrors Table script:

1 CREATE TAELE SegmentErmors( -
[ID] int IDENTITY NOT MULL,

[TS_ID] int NOT NULL,

[Ack_ID] int NOT NULL,

[SegmentlDCode] char(3) NULL.

[SegmentPosition] int NULL.

[LooplD] varchar{4) NULL.

[ErrorCode] varchar(9) NULL.

LD 0O ] O LT e La B

10 fFCTX

11 [CTX1_ContextName] varchar{35) NULL.

12 [CTX1_ContextReference] varchar(35) NULL,
13 [CTX1_SegmentlD] char(3) NULL,

14 [CTX1_LooplD] varchar(4) NULL,

15 [CTX1_SegmentPosition] int MULL,

16 [CTX1_ElementPosition] int NULL.

17 |[CTX1_ComponentDataElementPos] int NULL.
18 [CTX1_RepeatingDataElementPos] int MULL.
19 [CTX1_ElementReferencel] varchar(4) NULL,
20 [CTX1_ElementReference?2] varchar(4) NULL,

22 [CTX2_ContextName] varchar(35) NULL,

23 |[CTX2_ContextReference] varchar(35) NULL,

24 [CTX2_SegmentlD] char(3) NULL,

25 [CT*2_LooplD] varchar(4) NULL, -

[Compare Script with existing Table ] Save ] [ Execute Script ]

The "Execute Script” button

Notice: Creating tables means clicking the "Execute Script” button in all four tabs of the "Create
Tables for 999 Files" window. Then close this window.

7.0nce the table has been created successfully, you will see the following notification:

)

Table 'ElernentMotes’ successfully created

Ok

The Create Table script success message

Warning: Double-execution of a script wipes out the previous table you have created. A prompt will
warn you before deleting an existing table. To Add/Remove fields use the "Compare Script..."
button. Remove the script files once you have created the tables so nobody can destroy the tables
by accident.
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# ™
I -

:] This action will wipe out all your data in ElementMotes table, Proceed?

The double-execution warning message.

Make sure there are no error messages and the table creation has been completed
successfully.

Compare Script with existing Table

HIPAAsuite products go through continual development and improvements. Often these
changes lead to new fields in the database. While it is easy to drop a table and
regenerate it with the new fields, you will loose all the data in the table. To avoid this
trouble there is the button "Compare Script with existing Table". | you click this, the
table structure in your database will be compared with the script. There are two possible
outcomes. Your table is up to date

. )

You have all the fields in your table,
There is nothing to do

1 |

Table is up to date

or if your table is missing recently added fields, you will see a window pop up that shows
an ‘Alter Table' script with which you can add those fields to the table without interfering
with existing data. In the latter case, you can click the "Execute Script” button and the
field will be added and a message will confirm your changes
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Table successfully altered

Alter Table statement successfully executed.

10.2.4 2c Updating Database Tables

To update an existing table (in the event of an update, for example), follow the
instructions below.

1. Start with the table creation script window of the table you want to update. In this
example, we will use the Trading Partner table.
Create Tables for EDI_Exchange E[=E |

Database: * Microsoft SQL Server © MySQL/Generic

Trading Partner | TRANS_LOG | TRANS_LOG_ERRORS | SEND_LOG | COMPANY_SETUP |

C:\ProgramDatalHIPAA Suite\HIPAA Enroliment MasterScripts\TradingPariner_5QL Server.sql

1 CREATE TABELE [dba] [TradingPartner](
[TradingPartnerD] [varchar]{15) NOT NULL.
[TradingPartner D_QUAL] [varchar](s) MULL.
[ETINMag] [varchar]{15) NULL.
[MAME] [varchar](40) NULL,
[Contact] [varchar]{100) MULL.
[Phone] [varchar](15) NULL.
[Extension] [wvarchar]( 10) NULL.
9 Emsail] [varchar](75) MULL.
10 Fax] [varchar](15) NULL
1 [LocalFtpUser) [varchar](20) NULL, =
12 [LocalFtpPassword] [varchar](20) NLILL,
13 [Address1] [varchar](100) MULL,
14 [Address2] [varchar](100) NULL,
15 [City] [varchar]{30) MULL,
16 [State] [varchar](2) MULL.
17 [Zip] [warchar](10) MULL.
18 [FtpAddress] [varchar](50) MULL.
19 [PutDirectory] [varchar](50) NULL,
20 [GetDirectory| [varchar]{50) MULL,
21 [DialupMumber] [varchar](20) NULL,
22 [FtpUserName] [varchar](20) NULL.
73 IFtoPassword] [varcharl 200 NULL |

save | Execute Script |

Help | Cancel |3

The table creation script for the Trading Partner table.

|

LIPL ] e ]

00 =J TN LY b
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2. In the case of modifying a table to include/exclude/change a field or fields required by
a program update, the script will have been updated for you and clicking the Compare
Script with existing Table button will bring you to the next step. To modify the table
yourself in order to conform to your particular database, first edit the script text to
suit your database system, click the Save button, then the Compare Script with
existing Table button, and proceed to the next step.

Tip: Every database system has their own little syntax idiosyncrasies and the scripts might require
tweaking. You can edit the table scripts in this screen and save your modified scripts. One example
are 'date’ and 'time’ or ‘'money’ data types that do not exist in SQL Server 2005. You can just rename
those types to 'datetime’ and save you script and it will run fine.

3. Having clicked Compare Script with existing Table, the script will be compared to the
existing table and any additional fields will be presented. In this example, the Trading
Partner table's Address fields will be added.

a5 Changes to your table — N Y

1 Alter Table TradingPartner

J Add
[Address1] [varchar]{100) NULL,
[Address?Z] [varchar](100) MULL,
[City] [warchar](30) NULL.
[State2] [char](2) MULL,
[Zip] [varchar] (107 NULL

o LT e L

Execute Script Cancel

Changes to be made to Trading Partner table.

4. Click Execute Scipt. This will perform the additions/changes stated in the alter table
script and a prompt will appear informing you of the change. The table has now been
modified.

Table successfully altered

oK

Table has been altered.
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10.2.5 3 Defining Auto-Processing Options

In the "Auto-Process Setup” you can instruct the program on what to do after analyzing
and decrypting the received files in the Inbox Manager. The auto processing enables you
to combine and run multiple fulfilment steps together (for example, export, saving,
printing.) These options are important for the hand-over from EDI Exchange to the other
HIPAAsuite program that hosts EDI Exchange.

Follow the instructions below to specify the Auto Process Options.

1. Select EDI Exchange » Autoprocess Setup in the main menu.

Setp Log | EDIExchange | Help
? Check EDI File

Tradrug Partriers

Inboo Manager

FTP Client

SEF Fles

EDI Exchange Setup
Encryption Setup

Create EDI Exchange Tables
Autoprocess Setup
Automatic Scheduler

EDI Receive Log
EDI Send Log

Request EDI Exchange License
EDI Exchange License Informatbion

The "Autoprocess Setup” menu item

2. The following screen will appear if the host HIPAA application is Enrollment Master.

Automatic PI‘CH.'!P‘.‘I’H] ﬂphﬁﬂﬂ- !EE
— Check path options
[T Check FTP servers for new files
I Export in Database I"| Create Autoresponse
™ Print

Saveto: [ Image [ Excel ™ AsCl

__save | __Cancel |,

Defining the Auto Processing Options
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3. The following options can be specified:

Check Path Options

e Check FTP servers for new files — If checked, EDI Exchange automatically looks for
new files for all trading partners that have FTP connection set up. Then the program
gets all the waiting files and puts them into the Inbox. In the second step, it goes
through every file.

Default Automatic Processing Options
e Export in Database — If selected, the module exports new files to the database.
e Print — If selected, the module prints files using the selected printer.

e Create Auto-Response — If selected, the module creates an auto-response to the
received files.

e Save to — If selected, the system automatically saves files as:
¢ Image
e Excel
e ASCII
4. Click "Save."

-

Automatic Processing Options l = | (] |_i3-]

Get Rles from Trading Partners

/| Check FTP servers for new files and place them into Inbox

Default Automatic Processing Options
¥| Export in Database

4| Print  Use printer: Fax -
Save to: ¥l Image J| Excel < ASCI
Save | Cancel |

The "Save" button

Once you have saved the auto-processing options, the files will not only be analyzed but
also processed according to the defined settings. Proceed to the next step: Defining
Communications Directory.
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10.2.6 4 Defining Communications Directory

EDI file directory is an obligatory setting you need to set up before starting using the EDI
Exchange. In order to keep track of the thousands of EDI files that accumulate over
time, EDI Exchange uses a folder structure which we call the "HIPAAsuite Communications
Directory” or "HIPAAsuiteCommDir" in short. In it, you will find all your EDI files sorted
into several categories:

¢ Inbox

e Outbox

® ProcessedFiles
e EncryptedFiles
e SuspendedFiles

Within these directories, there will be folders for each Trading Partner and type of
transaction. The location and names of the sub-folders are handled in the "Trading
Partner Setup.” See Setting up Trading Partners.

Follow the instructions below to specify EDI communications root directory.

1. Select "EDI Exchange Setup” under the "EDI Exchange” menu item.

Setup log | EDIExchange | Help
4 Check EDI File

Tradrug Partriers
Inbox Manager

EDI Exchange Setup
Encryption Setup

Create EDI Exchange Tables
Autoprocess Setup
Automatic Scheduler

EDI Receive Log

EDI Send Log

Request EDI Exchange License
EDI Exchange License Informatbion

The "EDI Exchange Setup” menu item

2. The following window will appear.
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EDI Exchange Setup

i EDI Exchange Directory Setup

Root Directory Path [p«la

— Email Server nf

Browse I

Email Notification 1
SMTP Server Sender’s email address I™ Send email nofice of newly arrived Files? __Test |
[ I I Add |
User Name Password -y
Recipients
™ SMTP server requires Logon | | d
™ Connectio the SMTP server via the SSL protocol Use Port
+ Outgoing Files 1 Other options
I Validate outgoing files " Rejectincoming Files with more ermors than
e = . (set Count below)
I Halt records if EDI compliance 1
warnings are found |J e e
]
@ EDI Exchange is NOT yet initialized! initialize EDI Exchange | Save Help | Closo J/
! e

The "EDI Exchange Setup” window

Note: The icon in the lower left corner indicates that EDI Exchange has not been initialized yet.

3. Under "EDI Exchange Directory Setup” specify the following setting:

¢ Root Directory Path — Define the root path in the "Root Directory Path" text field.
The root path is the folder where all your EDI files reside. EDI Exchange will later

create sub-directories required to operate.

EDI Exchange Setup

[~ EDI Exchange Directory Setup

Root Directory Path 13

The root communications directory setup

4. Click "Save."”

-
EDI Exchange Setup

EDI Exchange Directory Setup

Browse |

Root Directory Path  p/\EDI

Email Server Information

SMTP Server Sender's email address
User Name Password

[C] SMTP server requires Logon

[[] Connectto the SMTP server via the SSL protocol Use Port

Outgoing Files Other options

[[] Validate outgoing files [[] RejectIncoming Files with more errors than

. . (set Count below)
Halt records if EDI compliance

warnings are found

® EDI Exchange is NOT yet initialized! Initialize EDI Exchange ]

Browse

Email Notification

i

Add

[C] Send email natice of newly arrived Files?

Recipients

EDI Fles with Other Type in Inbox
@ Leave file for other program

) Auto process if other program is available

The "Save" button
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After setting the root directory, you can click the "Initialize EDI Exchange" button. Read
more in Initializing EDI Exchange.

10.2.7 5 Initializing EDI Exchange

Before you can use EDI Exchange, and after you have configured the obligatory settings,
you have to perform the initialization. Follow the instructions below.

1. Select "EDI Exchange Setup” under the "EDI Exchange” menu item.

Setup Log | EDIEwchange | Help
2 Check EDI File

Trading Partriers
Inbox Manager
FTFP Chent

SEF Files

EDI Exchange Setup
Encryption Setup

Create EDI Exchange Tables
Autoprocess Setup
Automatc Scheduler

EDI Receive Log

EDI Send Log

Request EDI Exchange License

e EDI Exchange License Information
The "EDI Exchange Setup” menu item

2. The following window will appear.
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EDI Exchange Setup

 EDI Exchange Directory Setup
Root Directory Path |23 Browse
SMTP Server Sender’s email address I™ Send email nofice of newly arrived Files? __Test
[ I I Add |
User Name Password -y
Recipients
™ SMTP server requires Logon | | d
™ Connectio the SMTP server via the SSL protocol Use Port
+ Outgoing Files 1 Other options
I Validate outgoing files " Rejectincoming Files with more ermors than
e = . (set Count below)
I Halt records if EDI compliance 1
warnings are found I' e e
® EDI Exchange is NOT yet initialized! initialize EDI Exchange | Save Help | Closo J/
- e

The "EDI Exchange Setup” window

Note: The icon in the lower left corner, indicating that EDI Exchange has not been initialized yet.

3. After setting the root directory (see the previous step Defining Communications
Directory), you can initialize EDI Exchange module. Click the "Initialize EDI Exchange”
button to accomplish the process.

-
EDI Exchange Directory Setup
Root Directory Path  p1gDI, Browse
Email Server Information Email Notification
SMTP Server Sender's email address [C] Send email natice of newly arrived Files?
User Name Password R
[C] SMTP server requires Logon P
[[] Connectto the SMTP server via the SSL protocol Use Port
Outgoing Files Other options
[[] Validate outgoing files [[] RejectIncoming Files with more errors than

. . (set Count below)
Halt records if EDI compliance
warnings are found

EDI Fles with Other Type in Inbox

® =i e Bl p Tl [ Initialize EDI ] @ Leave file for other program
) Auto process if other program is available

The "Initialize EDI Exchange" button

Once the "Initialize EDI Exchange” button is clicked, the system checks if all settings have
been configured correctly.

1. The first thing the initialization process checks is the connection to the database and
the presence of the necessary tables. EDI Exchange relies on the database connection
that is part of the HIPAAsuite application that you are using. EDI Exchange needs
Database Connectivity licensed and enabled. If this part is not yet set up, then you will
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get an error like this:
Processing Results
EDI Exchange inftialization started

Checking SOL settings and tables:
Could not establish connection

EDI Exchange encountarad the above errors

EDI Exchange is not operational until everything checks out

M= E3

Initialization failed because of SQL connection problems

Read more in Setting up Database Connection.

157

2. Once the connection is established, the program checks if the correct tables exist in
the database. See Creating Database Tables. Once the SQL part checks out, you will

see the following message.

Checking SQL settings and tables:

Connection settings are checked. Trading Partners table is checked.
TRANS_LOG table is checked.

TRANS_LOG ERRORS table is checked.

SEND_LOG table is checked.

3. The next step of the initialization processes — the program checks and, if necessary,

creates the root directory and five sub-directories. Within these root directories, there

will be folders for each Trading Partner and type of transactions. The location and

names of the sub-folders are handled in the "Trading Partner” setup. The root folder is

specified via the "EDI Exchange Setup” screen. Read more in Defining Root Directory.

The sub-directories that EDI Exchange creates are as follows:

9\ -:J" ||~ Computer ~ WS2008 (C:) = 3 =

Organize Indudeimlibrary =  Sharewith =  New folder
- Eavories ' Name - Date modfied Type
EncryptedFies 1/31,/2013 5:55 PM File folder
w4l Libraries Inbox 1312013 5:56 PM  File folder
Duthox 1/31/2013 5:56PM  File folder
"-';“‘u::;:; - ProcessecFiles 1312013 5:56PM  File folder
— 2 SuspendedFiles 1312013 5:56PM  File folder
g Data (D:)

The directory structure of EDI Exchange
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4. The next step of the initialization — the program checks if the HIPAA EDI compliance

engine is properly installed.

5. The last thing checked by the system is if the Automatic File Processing options have
been set up. Read more in Defining Auto-Processing Options. The options are

important for the hand over from EDI Exchange to the other HIPAAsuite program that

hosts EDI Exchange.

Once all verifications have been completed successfully, you will see the following

message:

Processing Results
EDI Exchange inifialization started

Checking S0L setings and tables:
Conneclion seflings are checked
Trading Pariners table is chacked.
TRAMNS_LOG table is checked.
TRANS_LOG_ERRORS table is checked
SEND_LOG table is checked.
COMPANY_SETUP table is checked
COMPANY _SETUP data is validated.

Checking for Required Directories:
Inbox Directory is checked
Outbox Directory is checked.
Processed Directory is checked.
Crypt Directory is checked
Suspense Directory is checked.

Checking for EDIDew:
EdiDev is found.

EDI Exchange has been successfully initialized and is ready for use.

M= E3

Successful initialization of EDI Exchange

After that your EDI Exchange is initialized.
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EDI Exchange Directory Setup

Root Directory Path  pAEDI

Email Server Information
SMTP Server Sender's email address

UserName Password

[C] SMTP server requires Logon
[] Connectto the SMTP server via the SSL protocol Use Port
Outgoing Files Other options

[] Validate outgoing files

Halt records if EDI compliance
warnings are found

[[] RejectIncoming Files with more errors than
(set Count below)

J EDI Exchange is successfully inibialized.

Initialize EDI Exchange |

 Browse |
Email Notification
[C] Send email natice of newly arrived Files?
Add
Recipients

EDI Fles with Other Type in Inbox
@ Leave file for other program

) Auto process if other program is available

The "EDI Exchange is successfully initialized” message on the bottom of the "EDI Exchange Setup” window

Troubleshooting Initialization

When you are going through the Initialization process of the EDI Exchange, you can
encounter the following message in the "Processing Results” window:

Checking for EDI Dev:

EDIDev is not installed!
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Processing Results HFIE |

EDI Exchange iniialization started

Checking SOL seftings and tables:
Conneclion setings are checked
Trading Partners table is checked.
TRAMS_LOG table is checked.
TRAMS_LOG_ERRORS table is checked
SEMD_LOG table 15 checked.
COMPANY_SETUF table is checkad
COMFANY _SETUF data is validated.

Checking for Beguired Directones:
Inkox Directory is checked.
Dutbo: Directory is checked
Processed Directory is checked.

Crypt Directony is checked,
suspense Lirectory 15 checked.

Checking for EDIDew,
| EdiDevis not installed! |

EDI Exchange encountarad the abowve errors
EDI Exchange is not operational until everything checks out.

The EdiDev component is not installed
To resolve this issue, do the following.

1. Go to the http://www.edidev.com/ediregis.htm site.

2. Some systems may require Microsoft Redistributable Package to be installed first. In
this case, download one of the following components according to your OS' bit depth.

The recommended minimum system requirement for Framework EDL

+ 256 MB RAM

s 1GB available disk space

o Windows 2000/2003/2008XP/Vista'7

L] Prﬂ’equisiles: Some wywiems may mquise hicoecd Radisribotabls Pacoegs to be installed e 1o mupport:

Frnework EDEMET (32-0d0) - dewalead Microsod Vieoal €+ 200 Redistritucsble Paclape (1886

Frasnewerk EDI NETS (32-bit) - dewnlosd Mlicmsol Visual O+ 2010 Eadiseribuaabls Packaps (xBS)

Fronswork DI NET {§4-hif) - donnload hicronsf Vissal Ce== 2005 Radistritutibls Pldu:\e{x-ﬁﬁ
Froenework EDI NETH (64=bi) - dewnload hlicosod Vismal C+= 2010 Redssributable Package (x64)

o Qo 0

3. Download one of the following components you need according to your OS' bit depth:

e Framework EDI Enterprise evaluation 32-bit
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¢ Framework EDI Professional evaluation 64-bit

4. Install downloaded components and start again the EDI Exchange initialization
procedure.

10.3 Configuring EDI Exchange (Optional Settings)

10.3.1 Setting up Email Notifications

EDI Exchange can send emails to operators and trading partners to notify them about files
and processing results. This functionality of EDI Exchange lies beyond the most basic
setup that the initialization checks for. For this feature to work properly, you need to set up

an email server which EDI Exchange communicates with. You can do this in the "Email
Server Information” frame of the setup screen. Follow the instructions below.

1. Select "EDI Exchange Setup” under the "EDI Exchange" menu item.

Selup Log | EDIExchange | Help
4 Check EDI File

Trading Partners
Inbox Manager
FTF Chent

SEF Fles

EDI Exchange Setup
Encryption Setup

Create EDI Exchange Tables
Autoprocess Setup
Automatic Scheduler

EDI Receive Log
EDI Send Log

Request EDI Exchange License
E EDI Exchange License Information
The "EDI Exchange Setup” menu item

2. The following window will appear.
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EDI Exchange Setup BEE
— EDI Exchange Directory Setup - 1
Root Directory Path |23 Browse
SMTP Server Sender’s email address I Send email notice of newly arrived Files? __Test _|
[ I | Add
User Name Password -y
Recipients
™ SMTP server requires Logon | | d
™ Connectio the SMTP server via the SSL protocol Use Port
I Validate outgoing files " Rejectincoming Files with more ermors than
e = . (set Count below)
I Halt records if EDI compliance 1
wamings are found I' e e
® EDI Exchange is NOT yet initialized! initialize EDI Exchange |  Save Help Closo |/
e

The "EDI Exchange Setup” window

3. Specify the following email options:

Email Server Information
e SMTP server
¢ Sender's email address
e SMTP server requires logon
e Username

Password

Connect to the SMTP server via the SSL protocol

Use port
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EDI Exchange Directory Setup
Root Directory Path  D:\EDIy

Email Server Information Email Notification

SMTP Server Sender's email address [7] Send email notice of newly arrived Files?

smtp.gmail.com example@gmail.com Add
User Name Password

SMTP server requires Logon  yser R

Recipients

[] Connectto the SMTP server via the SSL protocol Use Port

Outgoing Fles Other options

[] Validate outgaing files [] RejectIncoming Files with more errors than
) ) (set Count below)
Halt records if EDI compliance
warnings are found

EDI Files with Other Type in Inbox

® EDI Exchange is NOT yet initialized! Initialize EDI Exchange ]

@ Leave file for other program

) Auto process if other program is available

Setting up the email server

Note: If you do not have this information, please ask your administrator to set this portion up for you.

4. To configure email notifications, specify the following options:

Email Notification

e Send email notice of newly arrived files? — Use this checkbox to define if you want
to send email notice once new files have arrived.

e Recipients — You can add your staff's email(s) and the processing messages will be
sent to these emails.

Enter an email address and click "Add."
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. e
Browse

Email Notification
[] Send email notice of newly arrived Files?

example@email.com Add

Recipients

EDI Files with Other Type in Inbox
@ Leave file for other program

) Auto process if other program is available

Setting up the email recipients

The email address will appear in the list.
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T -
Browse
Email Notification
Send email notice of newly arrived Files?

Add

Recipients

example@email.com

EDI Rles with Other Type in Inbox
@ Leave file for other program

) Auto process if other program is available

e
Added email recipient

5. Click on the "Test" button to verify your settings.

6. Click on the "Save" button.

EDI Exchange Directory Setup
RootDirectory Path  p1gDI, Browse

Email Server Information Email Notification
SMTP Server Sender's email address Send email notice of newly arrived Files?
smtp.gmail.com example@gmail.com Add

User Name Password
SMTP server requires Logon  yser i

Recipients

example@email.com
Connectto the SMTP server via the SSL protocol Use Port

Outgoing Files Other options

Validate outgoing files Reject Incoming Files with more errors than
. . (set Count below)
Haltrecords if EDI compliance =

warnings are found U

EDI Fles with Other Type in Inbox
® EDI Exchange is NOT yet initialized! Initialize EDI Exchange ]

@ Leave file for other program
) Auto process if other program is available

he "Save" button
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Troubleshooting Email Settings

If you have problems with setting up the email server, please contact your administrator. He/
She should know values to specify and how to test the settings.

Below is an example of what happens when the email server does not respond.

[ 2]

Failure!

After a time out, you get a failure notice

After acknowledging the failure, you get a more detailed error message in the process
result screen.

,
ECER . e

Percent Done: |

Sending email to
There was a problem with the email. See the log below.

220 smtp .gmail.com ESMTP p190sm 14579205ywp .56 - gsmip
EHLO 2h0-smtp gmail com at your service,
280-51ZE 35882577
250-8BITMIME
280-5TARTTLS
250-ENHANCEDSTATUSCODES
280-PIPELINING
250-CHUMKING
250 SMTPUTF2
AUTH LOGIN<CRLF= 530 5.7.0 Must issue a STARTTLS command first. p150s
MAIL FROM:<e@mple@gmail com=<CRLF= RCPT TO:zexample @email com:=<C
530 5.7.0 Must issue a STARTTLS command first. p150sm14575805ywp 56 - gsmtp
530 5.7.0 Must issue a STARTTLS command first. p190sm14573805%wp 56 - gsmtp
RSET=CRLF= 250 2.1.5 Aushed p150sm 14575805wp .56 - gsmtp

The process result screen with a detailed error message
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10.3.2 Setting up Incoming and Outgoing Files Options

To check if your files are HIPAA-compliant, EDI Exchange can run a compliance check on
outgoing EDI files. For incoming files, you can specify an acceptable error level. These
settings are especially important with new trading partner relationships or with new
processes since it always takes a while until an EDI process runs without issues and
problems.

Follow the instructions below.

1. Select "EDI Exchange Setup” under the "EDI Exchange” menu item.

Sebp  Log | EDIExchange | Help

i Check EDI File

Trading Partriers
Inbox Manager
FTFP Chent

SEF Files

EDI Exchange Setup
Encryption Setup

Create EDI Exchange Tables
Autoprocess Setup
Automatc Scheduler

EDI Receive Log

EDI Send Log

Request EDI Exchange License

e EDI Exchange License Information
The "EDI Exchange Setup” menu item

2. The following window will appear.
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EDI Exchange Setup

i EDI Exchange Directory Setup
Root Directory Path [p«la Browse I
i~ Email Server Inf Email Notification
SMTP Server Sender’s email address I™ Send email nofice of newly arrived Files? __Test |
[ I I Add |
User Name Password .
Recipients
™ SMTP server requires Logon | | d
™ Connectio the SMTP server via the SSL protocol Use Port
+ Outgoing Files 1 Other options
I Validate outgoing files " Rejectincoming Files with more ermors than
e = . (set Count below)
I Halt records if EDI compliance 1
warnings are found |J e e
]
@ EDI Exchange is NOT yet initialized! initialize EDI Exchange | Save Help | Closo
1

The "EDI Exchange Setup” window
3. Specify the following outgoing files options:
Outgoing Files

¢ Validate outgoing files — Select this checkbox to validate if the outgoing files are
HIPAA-compliant.

¢ Halt records if EDI compliance warnings are found — Select this checkbox to
suppress the sending of files with warnings or errors.

EDI Exchange Directory Setup
Root Directary Path DAEDI,

Email Server Information Email Notification

SMTP Server Sender's email address [7] Send email notice of newly arrived Files?

smtp.gmail.com example@gmail.com -
Add

User Name Password

Recipients
SMTP server requires Logon  user = P

example@email.com

[7] Connectto the SMTP server via the SSL protocol Use Port

Outgoing Fles Other options

Validate outgoing files [] RejectIncoming Files with more errors than

set Count below!

[T] Haltrecords if EDI compliance ¢ J
warnings are found

EDI Files with Other Type in Inbox

@ Leave file for other program

(0 Auto process if other program is available

Validating outgoing files

® EDI Exchange is NOT yet initialized! Initialize EDI Exchange ]

4. Specify the following incoming files options:
Other Options

¢ Reject incoming files with more errors than (set count below) — If checked, the
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incoming files with more errors than defined will not be placed into the "Inbox"
folder.

EDI Exchange Directory Setup
Root Directory Path  pEDI, Browse

Email Server Information Email Notification
SMTP Server Sender's email address [C] Send email natice of newly arrived Files?

smtp.gmail.com example@gmail.com
Add

User Name Password Recipients
SMTP server requires Logon  yser R

example@email.com
[[] Connectto the SMTP server via the S5L protocol Use Port

Qutgoeing Fles Other options

Validate outgoing files Reject Incoming Files with more errors than

set Count below
[] Haltrecords if EDI compliance D ( )

warnings are found

EDI Fles with Other Type in Inbox

@ Leave file for other program

[ se= ] B

The "Reject incoming files with more errors than" option

® EDI Exchange is NOT yet initialized! Initialize EDI Exchange ]

5. Click on "Save."

EDI Exchange Directory Setup
Root Directory Path  pEDI, Browse

Email Server Information Email Notification
SMTP Server Sender's email address [C] Send email notice of newly arrived Files?
smtp.gmail.com example@gmail.com Add

User Name Password

. Recipients
SMTP server requires Logon  yser P

example@email.com
[[] Connectto the SMTP server via the S5L protocol Use Port

Qutgoeing Fles Other options

Validate outgoing files Reject Incoming Files with more errors than

set Count below
[] Haltrecords if EDI compliance D ( )

warnings are found

EDI Fles with Other Type in Inbox

@ Leave file for other program

- -m () Auto process if other program is available

® EDI Exchange is NOT yet initialized! Initialize EDI Exchange ]

10.3.3 Running the Application via Scheduler

EDI Exchange integrates with the Windows Scheduler to allow the automation of the EDI
file exchange process. You can set up EDI Exchange to go out to the trading partner’s
FTP server, download files, decrypt and compliance check them and further process them
with the appropriate HIPAAsuite application, for example load claims into a SQL
database.
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Follow the instructions below to schedule the EDI files exchange process.

1. Select "Automatic Scheduler” under the "EDI Exchange” menu.

EDI Exchange
Check EDI File

Trading Partners
Inbox Manager
FTP Client

SEF Files

EDI Exchange Setup

Encryption Setup

Create EDI Exchange Tables
Create 999 Files Tables
Autoprocess Setup

Autormatic Scheduler

EDI Receive Log
EDI Send Leg

Regquest EDT Exchange License

EDI Exchange License Information

The “Aufomatic Scheduler” menu item

2. In the opened window, right click and choose the "Scheduled Task” menu item.

, ,

File Action View Help
«=|:E H
@ T_E;k Scheduler (Local) Name Status Triggers MNextRun Time Last Run Time Last Run Result  Author Created Acticns
4 [ Task Scheduler Library LIPAASuite R
& [ Microsoft
b 1 MysQL g Create Basic Task...
| HIPAASuite " Create Task...
Import Task...
Create Basic Task... [5 Display All Running Tasks
Create New Task... ] Enable All Tasks History
Loz e e ] MewFolder...
Refresh X Delete Folder
View 4
4 1 r G Refresh
ﬂ Help

Task Scheduler in Windows Vista onwards.

In Windows XP, the Scheduled tasks directory looks like this:
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‘ Scheduled Tasks M= E
File Edit View Favoribes Tooks Advanced Help l‘."
<, L~ T 7 Saarch Folders HH (ﬂ;\ CHHEPOHHBALHA NANKH |

Address | ) Scheduled Tasks B

Name -« | schedule | Next Run Time | Last Run Time | Stabus | Last Result | Cre
|2 add scheduled Task
Other Places e éjn‘r‘; Every 2 hour(s) from 12:00 AM For ... &:00:00PM ... 2:00:004M 1/... Could not start DecDO00142  Ad
} Cortrol Panel

= 3
| My Documents _
Arrange Icons By »

=y Shared Dacuments
Refresh

\J' My Metwark Places

Details ¥ _ — M‘
a _>|

The "Scheduled Task” menu item in Windows XP.

See "Running the Application via Scheduler” in the help of the host HIPAA application for
detailed instructions on how to schedule a task.

10.3.4 Using the Command Line Arguments (CLI)

The only EDI Exchange specific command line argument is "Auto”

The Auto processing options are defined in another screen and, with the command line
argument "Auto,” they will be exercised. Make sure that you have configured them
according to your needs.

10.4 Working with Trading Partners

10.4.1 Setting up Trading Partners

With EDI Exchange you can keep track of your trading partners. You can set up their
identifiers to send them EDI files or 999 acknowledgment, send email notifications and
compliance check results, encryption keys and file transport mechanisms.

Once you have created the trading partner table (see Creating Database Tables) and
initialized EDI Exchange (see Initializing EDI Exchange), you can set up the relationships
with your trading partner. Follow the instructions below.

1. Select "Trading Partners” under the "EDI Exchange” menu.
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Setp Log | EDIExchange | Help
g K Check EDI File

Trading Partners

Inbox Manager
FTP Chent
SEF Files

EDI Exchange Satup
Encryption Setup

Create EDI Exchange Tables
Autoprocess Setup
Automatic Scheduler

EDI Receive Log
EDI Send Log

Request EDI Exchange License
EDI Exchange Livense Informabion

The "Trading Partners” menu item

2. The following screen will appear.

- 1
Trading Partners l&lﬂg
Name and Type List of Trading Pariner
A N DC EXCHANGE
* CALHEERS
FEDERAL EXCHANGE ARKANSAS
®
EDIIdentifiers| Options | Remote FTP | Contact | Encryption | Folders
EDI Version
@ 4010 5010
EDI Identifiers and Qualifier
*
46 -
| Refresh |
[ Mew |

The "Trading Partners” window

3. Click the "New" button to start entering the trading partner information.
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4. Define the necessary options. They are described further.
r'irading Partners @E‘g-‘
Name and Type List of Trading Partner
Hame _ DC EXCHANGE
¥ (Required) CALHEERS
FEDERAL EXCHAMNGE ARKANSAS
Address
City State Zip
EDI File Exchange Method Status
- * -
Email Addresses to send process results Type
| EDI Identifiers | Options ! Remote FTP Contact Encryption

EDI Version

@ 4010 5010

EDI Identifiers and Qualifier

ISA Identifier and Qualifier (Record Key)

*x
ETIN Number and Qualifier Application Sender Code (G302)
46
Application Receiver Code (GS03) Tradirg Parner Assigned ID
Refresh |

= e

e

5. Click on "Save."

The "Save" button

6. The newly added Trading Partner's name will appear in the right pane.

Trading Partner Options

The company information of a trading partner can be specified on the top of the form.

© <2003> Martin Scholl Consulting, Inc.



174

HIPAA Enrollment Master

Trading Partners
Name and Type
Name
¥ (Required)
Address
City State Zip
EDI File Exchange Methed Status
- ®
Email Addresses to send process results Type

&

Top area of the "Trading Partners” window

Name and Type

e Name — Trading partner's company name. Required field.

e Address — Trading partner's company address.

e City
e State

e Zip

e Status — Trading partner’s status. Choose one of the available options:

¢ |[nactive — No upload into a database system through ODBC will be done.

e Test Only — All outgoing EDI messages will be stamped with "Test” (ISA_15).
Records will only be exported to the test environment.

e Approved — All outgoing EDI messages will be stamped with
"Production” (ISA_15). Records will be exported to the Live system with ODBC.

e Type — There are five types of trading partners, select the necessary one:

¢ Providers — Hospitals, doctors or other health care providers.

e VANs — Value Added Networks like clearing houses or EDI Networks.

e Service bureaus — Third party entities such as repricing organizations.

e Sponsors — Entities that sponsor the benefits of subscribers such as MedicAid,

government agencies or large employers.
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e Payers — Entities that pay for health care benefits such as health insurers.

The next block on the form lists the communication methods and preferences.

e EDI File Exchange Method — Obligatory setting. HIPAAsuite supports three
communication methods. Choose a preferred mode of sending EDI communications
to the trading partner:

e FTP — Allows you to transmit files actively to the Trading Partner or his
Clearinghouse.

e Outbox — All files for Trading Partner are stored locally. The Trading Partner is
responsible for picking up files in his special directory of the local FTP or HTTP
server.

e SOAP - Allows you to transmit files to the Trading Partner or his Clearinghouse
using SOAP 1.2 (CORE) by default.

0 SOAP Version - Defaults to CAQH CORE "SOAP 1.2". "SOAP 1.1" is also provided
as a compatibility option for Trading Partners that are not yet CORE-Certified
but use SOAP services.

e MIME - Allows you to transmit files to the Trading Partner or his Clearinghouse
using MIME (CORE). This is one of two CORE options.

e Email Addresses — Enter the email address(es) into the text field.

EDI Identifiers Tab

This tab relates to the EDI identifiers and EDI Version.

EDI Identifiers | Options | Remote FTP| Contact |Encryption| Folders
EDI Identifiers and Qualifier

" . EDI Version
154 Identifier and Qualifier (Record Key)
* 4010 @ 5010
900737353 77
ETIMN Mumber and Qualifier Application Sender Code (G502) to use
46 900737353
Application Receiver Code (G503) to use Trading Partner Assigned D
*
CCHMP

The "EDI Identifiers” tab

e EDI Version — There are two standards for HIPAA:

CORE
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¢ 4010 — This standard was introduced in the original transaction from 2003 to

2011.

® 5010 — From 2012 on all HIPAA transactions must be conducted in the 5010

version.

¢ EDI Identifiers and Qualifier

¢ ISA Identifier and Qualifier (Record Key) — The ISA Identifier and Qualifier are

the unique key to the trading partner database file. The ISA identifier can be up
to 15 bytes long, the qualifier has to be 2 bytes. Approved qualifiers are:

e 01 — Duns (Dun and Bradstreet)

® 14 — Duns Plus Suffix

e 20 — Health Industry Number (HIN)

e 27 — Carrier Identification Number as assigned by HCFA

e 28 — Fiscal Intermediary Identification Number as assigned by HCFA

e 29 — Medicare Provider and Supplier Identification Number as assigned by
HCFA

e 30 — U.S. Federal Tax Identification Number
¢ 33 — National Association of Insurance Commissioners Company Code (NAIC)

e 77 — Mutually Defined. Many organizations use the ZZ qualifier with their
name as the ID, for example ZZ and HIPAASUITE.

e ETIN number — The Electronic Transmitter Identification Number established by

a Trading Partner Agreement. This number occurs only in the 837 transactions.
Often, the ETIN is same as the ISA ID.

Application Receiver Code (GS_02) — A code identifying a part that sends a
transmission or the specific application within the sender's organization. Codes
are agreed by Trading Partners. Again, usually this code is same as the ISA ID.
This code is placed in the GS_02 element in the Functional Group Header (GS).
Some Trading Partners want to send a specific code in GS_03, the application
receiver code. You can enter it into the corresponding field. Most of the time it
is not necessary.

Assigned ID - Some trading partners, like health insurance exchanges will give a

plan an ID that is different from the ISA identifier defined in the Company Setup
screen of the application. Especially in the creation of filenames is this Assigned

ID important.
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Options Tab

EDI Identifiers, Options |Remote FTP| Contact | Encryption| Folders CORE

¥| Send EDI Acknowledgement (397 or 999)
Send e-mail with compliance check and process results
Send e-mail notification when receiving Files
Send e-mail notification when sending Files
Reject Files with Compliance Errors (EDI Exchange)
Create a 277CA for 837 Claims
Cne ST-SE loop per claim

The "Options” Tab
You can choose one of the following options:

e Send EDI Acknowledgment (997 or 999) — This check-box allows sending
Functional Acknowledgment transactions to the Trading Partner.

e Send e-mail with compliance check and process results — This option allows
sending the compliance check results back to your contact at the Trading Partner
via email. No PMI will be transmitted. Adding an email address is important, even
when the Communication method is not "Email.”

¢ Send e-mail notification when receiving files — This option allows sending an
acknowledgment email of EDI files. This option is not necessary when you choose
997 or 999 acknowledgments.

¢ Send e-mail notification when sending files — This option allows sending a file to
the Trading Partner notifying them that a file has been created for them.

¢ Reject Files with Compliance Errors - This option will reject files that have
compliance warnings and move them into the suspended files directory. It also
determines whether the TA1 and 999 indicate acceptance or the 999 lists all the
errors and warning.

e Create a 277CA for 837 claims — This option only applies to 837 Claims. Checking
this option will produce a 277CA Claims Acknowledgment report for received 837
Claim files.

e One ST-SE loop per claim - This option separates all claims into individual
transactions enclosed by their own ST and SE segments.

Remote FTP Tab
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If your trading partner has an FTP Server, then you can set up here the connection
information. Read more in Using Built-in FTP Client.

EDI Identifiers | Options | Remote FTP | Contact | Encryption | Folders CORE

@ FTP Remote Connection and Directories Different Download S
Secure FTP FTP Address
Explicit FTPS fip_healinghospital.com
i
User Name
Implicit FTPS user
SFTP Password
|ser + password Auth e
private Key Auth Port:
After Download 21 . _
Delete Fil Put Directory Get Directory
@ Delete Files
DropOff PickUp

Move to Folder |

| Test Upload Connection | Test Download Connection

The "Remote FTP" tab

The file transfer protocol (FTP) is one of the first internet protocols and goes back to
the 1960's. Transporting electronic files was one of the great achievements of the
internet. During the last 50 years a lot of improvements to this protocol have been
made, mainly to increase the security of the transfer.

e FTP — For security reasons, EDI Exchange supports secure FTP or FTPs.

e Explicit FTPS Connection — The explicit method is a legacy compatible
implementation where FTPS aware clients can invoke security with an FTPS
aware server without breaking overall FTP functionality with non-FTPS aware
clients. In explicit mode (also known as FTPS), an FTPS client must "explicitly
request” security from an FTPS server and then step-up to a mutually agreed
encryption method. If a client does not request security, the FTPS server can
either allow the client to continue insecure or refuse/limit the connection.

¢ Implicit FTPS Connection — The implicit method requires that all clients of
the FTPS server be aware that SSL is to be used on the session, and thus is
incompatible with non-FTPS-aware clients. Negotiation is not allowed with
implicit FTPS configurations. A client is immediately expected to challenge the
FTPS server with a TLS/SSL ClientHello message. If such a message is not
received by the FTPS server, the server should drop the connection. In order
to maintain compatibility with existing non-TLS/SSL aware FTP clients,
implicit FTPS was expected to listen on the IANA Well Known Port 990/TCP for
the FTPS control channel and 989/TCP for the FTPS data channel. This allowed
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administrators to retain legacy compatible services on the original 21/TCP FTP
control channel.

e SFTP — also known as FTP over SSH is deemed the most secure form of FTP and
uses encryption certificates. There are 3 different ways to authenticate a SFTP

connection,
= With user name and password, just like a regular FTP connection,
= User name and a certificate
= User name, certificate and password

Remote Connection and Directories

You need the FTP address, the user name and password to establish the connection
and the directory information where files are picked up and where dropped off. Fill in
the following fields:

e FTP Address - This is usually the IP address of the server

¢ User Name

e Password

e Put Directory - This is the directory where you drop off files

e Get Directory - This is the directory where you download files from

It is possible that a trading partner has two FTP servers, one for ‘put’ and another
one for ‘'get’. If so, check "Different Download Server" and additional fields will
become visible so you can specify the those connection parameters.

After Download: You have two choices. Files on the server will be either deleted or
moved to another folder of your choice

Contact Tab

The Contact Tab stores contact information for your selected Trading Partner.
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EDI Identfiers | Remote FTP ( Contact | Encryption | Foldes |

r Contact Information
Name Communication Numbers

Communication Type Number

I =

1234567
1111

[ A | Fax 9876543
~ Local Acces=s for FTP and HIPAAsuite Web
User Name merﬂd Users

Password

_ A |

The "Contact" tab
Contact Information

Enter the name and the number into the corresponding fields and select the
communication type from the drop-down list.

e Contact Name
e Communication Numbers — Valid Communication number qualifiers are:
e TE — Stands for Telephone.
e FX — Stands for Fax.
e EX — Stands for Extension.
e EM — Stands for email.

Click the "Add" button and the contact will appear in the "Communication
Numbers” table.

Note: The information that you fill in goes also into EDI files in the "PER" segment.

Local Access for FTP and HIPAAsuite Web

To register a user, enter the user name and the password into the corresponding fields
and click the "Add" button. The user will appear in the "Registered Users" table.

e User Name
¢ Password

¢ Registered Users
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Encryption Tab

EDI Exchange supports PKI encryption. Encryption keys are defined by the email address
of the owner. Both supported products, PGP and GnuGP use this logic. Read more in

Using Encryption.

You can set up the encryption parameters for a Trading Partner on the "Encryption” tab.

EDI Identifiers | Options | Remote FTP| Contact @ Encryption | Folders CORE

Encryption Setup
Asymetrical Encryption

Private Key Infrastructure (PGP)

ey (email address of key owner)

@ Mo Encryption

The "Encryption” tab

Encryption Setup
e Asymmetrical Encryption
¢ Private Key Infrastructure (PGP)

Key (email address of key owner)

¢ No Encryption

Folders Tab

Within the HIPAAsuite Communications Directory, each Trading Partner has his own
folder. This keeps files finely separated and in order. Here is where you can set this up.
Read more in Defining Communications Directory.
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 EDI Identifiers | Options | Remote FTP | Contact | Encryption| Folders | CORE

Local Directory Settings

Cutgoing Files Root Trading Fartner's Qutbox -

D:\EDNOutbox \ TXEBS . [*

Processed Files Root Trading Partner's Repository

DAEDNProcessedFiles ‘W TXEBS . ¥
File Naming Convention Create Folders Using Trading Partner 1D I
CMS -

:I'he "Folders” tab

e Outgoing Files Root — This field has a pre-generated path. You can change this
path by changing the EDI Root Directory.

¢ Trading Partner's Outbox — Mandatory setting. Click on the three-dots button to
access the "Select Folder” window. There you choose an existing folder or create a
new one.

¢ Processed Files Root — This field has a pre-generated path. You can change this
path by changing the EDI Root Directory.

e Trading Partner's Repository — Mandatory setting. Click on the three-dots button
to access the "Select Folder” window. There you choose an existing folder or create
a new one.

Once you have specified the directory settings, click on the "Create Folders Using Trading
Partner ID."

 EDI Identifiers | Options | Remote FTP | Contact | Encryption| Folders | CORE

Local Directory Settings
Cutgoing Files Root Trading Fartner's Qutbox -
D:\EDNOutbox \ TXEBS . [*
Processed Files Root Trading Partner's Repository
DAEDNProcessedFiles ‘W TXEBS . ¥
File Naming Convention | Create Folders Using Trading Partner 1D
CMS -

:I'he "Create Folders Using Trading Partner ID" button

¢ File Naming Convention - Health Insurance Exchanges (HIX) demand that a carrier
adheres to more or less complex File naming conventions. Since these conventions
are often really complicated we decided to hard code several schemes. California,
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Maryland, DC and the CMS scheme are among those currently configured and we will
add other schemes if needed.

Rle Naming Convention

Filenaming dropdown menu options

The Custom File Naming Convention option requires some additional setup. This is

covered in Custom File Naming Conventions.

CORE Tab

This tab stores settings for the use of CORE-Compliant SOAP- and MIME-enveloped
transactions. When using a Requester or similar application, these settings apply to the
information source. When using a Responder or similar application, these settings apply
to the information requester/receiver. Soap 1.2 or 1.1 will use the same options.

| EDI Identifiers | Options | Remote FTP | Contact | Encryption| Folders

CORE [

CORE Settings
UzerMame

Password

S5L Certificate

Real Time
MIME Address

SOAP Address

Batch

MIME Submission Address

MIME Retrieval Address

SOAP Submission Address

SOAP Retrieval Address

-CO RE settings tab
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10.4.2

e UserName - UserName portion of the username authentication token. Used to verify a
Trading Partner's Username token's Username or in your own Username token
authenticate yourself to a Trading Partner's CORE-compliant servi e.

e Password - Password portion of the username authentication token. Used to verify a
Trading Partner's Username token's Password or in your own Username token to
authenticate yourself to a Trading Partner's CORE-compliant service.

e SSL Certificate - Instead of Username tokens, use an SSL certificate to verify a
Trading Partner’s identity or access a Trading Partner's CORE-compliant service. Not
currently implemented.

¢ RealTime
0 MIME Address - Trading Partner's web address for MIME Real-Time transactions.
0 SOAP Address - Trading Pertner's web address for SOAP Real-Time transactions.
e Batch

0 MIME Submission Address - Trading Partner's web address for MIME Batch
transactions.

0 MIME Retrieval Address - Some Trading Partners may use a different address to
submit or retrieve batch transactions. Use this field for a retrieval-specific address.

0 SOAP Submission Address - Trading Partner's web address for SOAP Batch
transactions.

0 SOAP Retrieval Address - Some Trading Partners may use a different address to
submit or retrieve batch transactions. Use this field for a retrieval-specific address.

Custom File Naming Conventions

Health Insurance Exchanges (HIX) demand that a carrier adheres to File naming
conventions. These file naming conventions enable a reader to quickly determine the
date, time, sender, recipient, etc. of a particular file among other files without the need
to open them individually. The custom File Naming Convention option enables you to
create a file naming convention scheme tailored to your (or your trading partner’s)
requirements.
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Rle Maming Convention

-_ m _—
CA
CMS
DC
MD
FHH
OR

Custom File Naming Convention option highlighted

Selecting the Custom option in the File Naming Convention dropdown menu option and
clicking the Custom File Naming button below it:

Rle Naming Convention

= 7]

| Custom File Maming |

Custom File Naming button enabled

will bring up the screen pictured below. This screen is used to create file naming
conventions for a particular trading partner. These examples will use the 835 file type as
an example, but all file types the HIPAASuite product represents (as well as TA1s and
999s) can have their own file naming convention applied to each trading partner. The

following picture shows the file name customization screen with the default building
blocks for an 835 EDI file.

gl Customize File Name

- o x
File Name for: [835 v]
Company Fie ID_|X | [ Datein YryymmpD' [ | [ Time in hhmmss' | || Fie Type ||| File Version [x ] | Trading Pattner ID x|
Available additional file name parts:
Yearin YYYY format | X | | Time in ‘hhmssf' [ | [ Company ID [ | [ Company EIN [ | Transaction ID ] | Transaction Type x|
Save file name Close

File Naming Customization screen with default custom file naming convention

Filetype
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Here we can create a custom file naming convention for a specific file type. The file
types available will depend on the HIPAASuite product used to create the file naming
convention. To change the file type, select it from the file type dropdown menu:

o5 Cuctomize File Mame

File Name for: |5 v Resh
]

Compary Fle ID ] 1539 L Tx E
TA1

Changing the filetype

Creating the file naming convention

A coherent file naming convention can be created by clicking and dragging elements into
order. Present elements can be reordered by clicking and dragging them into position:

g5 Customize File Mame

File Name for: |B35

Company File ID | X | | Datein Wﬁ;ﬁmmmss | x| | Fie Type |

Available additional file name parts:

[ Yearin vy fomat | x | | Tmein hhmmsst' | | | Company ID | x | | company EIN

Click-dragging an element into position

Existing elements can be removed by clicking the X to the right of the element:

o5l Custormize File Mame

File Name for: 835 | Restore default fi

Compariy File 10 |}( | | Time in ‘hhmmss’ | X - | File Type |}( | | File Version | X

Available additional file name parts:

Yearin YYYY fornat | | | Time in hhmmssi* | | | Company ID | x| | Comp
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Deleting an element

The greyed-out elements towards the bottom of the screen can be added to the custom
file naming convention by clicking and dragging them into place:

o5 Customize File Mame

File Name for: 835 v|

| Compary File |D |X| | Time in ‘hhmmss’ |)(| | File Type

Available additional file name paris:

| Timein ‘hhmmsst* | % | [ Company 1D | x | | Transactior

Adding a file name element

To discard the current changes and start over with the default file naming convention,
click the Restore default file name button.

o) Customize File Name

File Name for: |335 V| Restore default file name

Company Fie ID_[X | [ Date in "vyyYMMDD' [X ][ File Type [ [ File Version || | Trading Pariner D [ ]

Available additional file name parts:

Time in hmmssf’ | X | | Compary ID [ | | Transaction ID [X ] | Transaction Type || | Company EIN [ ] [ Yearin Y¥¥ fomat ] X | | Time in ‘hhamss' [

Save file name Close

Restore default file name button

Saving or discarding

Finally, the custom file naming convention can be saved by clicking Save file name or
discarded by clicking Close.
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10.4.3

gl Customize File Name

File Name for: [835

v| Restore default file name

Company Fie ID_|X | [ Datein YryymmpD' [ x| [ Time in hhmmss' | || Fie Type | X || File Version [x] | Trading Pattner ID x|

Available additional file name parts:

Save button on file name customization screen

Using Built-in FTP Client

Setup Log | EDIEwchange | Help

Check EDI File

Tradrug Partriers
Inbox Manager

FTP Client

SEF Files

EDI Exchange Setup
Encryption Setup

Create EDI Exchange Tables
Autoprocess Setup
Automatic Scheduler

EDI Receive Log

EDI Send Log

Request EDI Exchange License
EDI Exchange License Informatbion

The "FTP Client" menu item

2. The following window will appear.

Close

EDI Exchange has a built-in FTP client. This utility allows you to drop-off and pick-up files
from a trading partner that you have defined in the "Trading Partners” menu (see Setting
up Trading Partners.)

Follow the instructions below to exchange EDI files with your Trading Partner.

1.To access the FTP client, select "FTP Client” under the "EDI Exchange” menu item.
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o . =)

FTP Server User Password Directory
@ FTP Secure FTP Port 21
Connect To Trading Partner ” Connect ” Disconnect ) SFTP
Remote FTP Server: Local:
Decrypt | = My Computer
Files [ o
3 DA
| —>Get—> |
[crac |

Not Connected

The built-in FTP client

3. Click the "Connect to Trading Partner” button on the FTP client window.

FTP Server User

Password

EEE s e W e

Directory

' FTP Secure FTP

Port 21

Connect To Trading Partner I Connect “ Disconnect :?. SFTP
Remote FTP Server: Local:
il | = Decoypt [ C3 My Computer I
The "Connect to Trading Partner” button
4. The following screen opens.
=lojx
~ List of Trading Partner
Pariner 1
Upload Download Close
¥
2z

Selecting a Trading Partner for FTP transfer

5. Highlight the trading partner that you want to connect to.

6. Click on the "Upload" button to connect to the "Put” directory that you set up in the
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trading partner screen.

1o/
 List of Trading Partner
Partner 1
Upload i Download Close

.
B

The "Upload” button

Or click on the "Download” button to connect to the "Get" directory that you set up in
the trading partner screen.

i
 List of Trading Partner
Parner 1

o
B

The "Download" button

5. Once you have chosen a trading partner, the following fields will contain values derived
from the trading partner's properties. You can change them manually if you need.

e FTP server — IP Address or URL of the FTP server.

e Username

e Password

¢ Directory — If you leave this value blank, the FTP root directory will be opened.

e Secure FTP — If you enable this option, then you can select between implicit
and explicit FTPs. See Setting up Trading Partners for an explanation of the two
secure methods:

e Explicit FTPS Connection

¢ Implicit FTPS Connection

Note: You can also fill in the connection information manually. In this case, the entered credentials
will not be saved once you close the FTP client window. Click on the "Connect” button to establish
connection to the FTP server.
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=101 x|
FTP Server User Password: Directory
ﬁpffuuﬁe.om |example @gmail com .
- =, & FTP | SecureFTP
Connect To Trading Partner Zi Connect I Disconnect |  SFTP
Remote FTP Server: Local:
= I Remote Directory / - Decrypt | C My Computer
L@ fpqusta - — | Files gu,é\
htaccess DM
% emor_log =>Get—> | M En
%‘ :mm —Put I en
< <
B bcensent
Q) pdf
=] put
[ 234 09ed
[B) test_test oci
B readme himi
Connected
4. Once connected, the content of the folder on the server is displayed. On the right
side, you can browse your local PC.
5. To upload a file to the server, select the file on your local PC and click on the "Put”
button.
=101
FTP Server User Password: Directory
[ftp://example con |example@gmail com |
& FTP | Secure FTP
Connect To Trading Partner | Connect | Disconnect |  SFTP
Remote FTP Server: Local: DAEDNnbox
=- I Remote Direct - Decrypt | £ My Computer 1
@ foqueta ! —| . Files = cA sgma
[B) htaccess 2169 DA 234_09edi
[ emorlog —>Get—> 3 SRECYCLEBIN
0 ot £ dvd
[ indexphp <«Puc= || =0 EDI
[® beensena | 8 EncyptedFiles
= fif inbox |
== put €2 Outbox
[®) 834_09ed €3 ProcessedFies
[E) test test edi €3 SuspendedFiles
[® readme himl & EM

The file will appear in the remote folder. You will receive the "File <filename>
successfully uploaded” message on the bottom status bar of the FTP client.

Remote FTP Server: Local: DAEDNnbox
3 T Remote Directory / - Decrypt 3 My Computer i
[ fpqueta " Fites c&cn |g3ted
@ htaccess 28 bA _[Gedi
B erorlog —Get—> € SRECYCLEBIN test_test adk
(-0 0 dvd
[B) index php =6 EDI
[@ licensa bt € EncryptedFies
8 pdf & Inbax
=& put £ Outbax
[B) 834edi 3 ProcessedFiles
@ 234 05ed €3 SuspendedFiles
[B) test_testea £ Galery

Conected Pk 534,00 sccessily wiooded]

6. To download a file from the server, select a file in the left side, and then click on the
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"Get" button.
(=] 3|
FTP Server User Password: Directory
[ﬂp;ﬂmem ll:x-wll:@plﬂ'l.ml | |
& FTP I SecureFTP
Connect To Trading Partner | Connect | Disconnect | C SFTP |
Remote FTP Server: Local: DAEDNnbox
T Remote Directory / - Decrypt | ) My Computer 1bd
B foqueta r Files 3 cA 834 edi
[ htaccess 263 DA 834_09.edi
[®) erorlog —Get—> || ) SRECYCLEBIN
6 omt 8 dvd
[® indexpho <Put<— =6 EDI
[® beensend €3 EncryptedFiles
(= E Inbox
=6 put i € Outbax
F EEEE €3 ProcessedFies
(3 test tested _ 63 SuspendedFies

The file will appear in the local folder. You will receive the "File <filename> successfully
downloaded” message on the bottom status bar of the FTP client.

Remote FTP Server: Local: DAEDMNnbox
! Ramota Directory / =] Decrypt 3 My Computer 1bd
B fipquota r Files [ oY 334 edi
[® htaccess =63 DA 234 D9ed
B erorlog —Get—> ) SRECYCLEBIN L]
(m F-1 S dvd
B ndexphe —Put<— =65 EDI
B lcensent 3 EncryptedFies
0 podf & Inbaxe
= O put € Outbax
(@) 834_09ed € FrocessedFies
[3) test_test.ed €3 SuspendedFies
9 Gabery

Connected File test_test.edi successfully downloaded

10.4.4 Creating a Trading Partner Automatically

When you process a file with EDI Exchange the sender’s ID is compared to the trading
partners on file. If the trading partner does not exist you have the opportunity to create
a rudimentary new trading partner record. Now you have the choice to either create this
new record, process the file without the trading partner record or to abort the
operation.

Mew Trading Partner

The sender of this file with the |D of 'MDSCRIPTS' is not setup as Trading
Parner. Do youwant to create a new record?

[ Yes | | No | |  AbortProcessing

%

The "New Trading Partner” dialog box

If you abort the process, you still will get the EDI file analysis.
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F T |

Inbox Manager o

Loading EDI Files into Inbox Processing Inbox
Download from FTP Server l [ Process Inbox l

Allfiles in Inbox have been processed

Activity Log and Wamings

m

Filename: keyhealth. 837
SEF file "HIPAAClaimMaster. SEF_Files 837_X098A1_SemRef . SEF’ loaded for transaction set: "004010X098A1" |
The Transaction type is 837 . Version: 004010X098A1
The Trading Partner with the ID "MDSCRIFTS' is not set up.

The file's further processing is suspended
346 warming messages were given.
The following Wamings with the X12 implementation were found:
Waming in Line 2 —» GS*HC*MDSCRIPTS*KEYHEALTH*20121012* 1607*00001*X*004010X098A1 at Position: 6: [DESCRIPTION:Lea
Waming in Line 6 —> REF*ZZ*264101398: [DESCRIFTION:Unexpected data segment 'REF" encountered in transaction setimessage '
Wam Line 11 —> NM1*85*2*KEY HEALTH DEMO****** at Position: 8: [DESCRIPTION:No data in mandatory data element "66" ir
Waming in Line 11 —> NM1*85*2*KEY HEALTH DEMO****** at Position: 9: [DESCRIPTION:No data in mandatory data element 67" ir
Waming in Line 14 —> REF* 1J* at Position: 2: [DESCRIPTION:No data in mandatory data element 127" in Data Segment "REF"_J[COL
Warning in Line 14 —> REF* 1J* at Position: 2: [DESCRIPTION:Conditional data element missing. Element="127", Position="2"][CODE:
Waming in Line 14 —> REF* 1J* at Position: 3: [DESCRIPTION:Conditional data element missing. Element="352", Position="3"][CODE:
Waming in Line 14 —> REF* 1J*: [DESCRIPTION:The REQUIRED rule syntax for data segment REF has been violated. At least one of
Wamning in Line 14 —> REF*1J*: [DESCRIPTION:Conditional syntax check failed for segment 'REF’. Buffer="REF*1J*" ][CODE:12459]
Waming in Line 15 —> PER*IC**TE* at Position: 2: [DESCRIPTION:No data in mandatory data element "93" in Data Segment "PER'_J[(
Waming in Line 15 —> PER*IC**TE* at Position: 4: [DESCRIPTION:No data in mandatory data element "364" in Data Segment 'PER".]
Wamning in Line 15 —> PER*IC**TE* at Position: 4: [DESCRIPTION:Conditional data element missing. Element="364", Position="4"][C({
Waming in Line 15 —> PER*IC**TE*: [DESCRIFPTION:The PAIRED rule syntax for data segment PER has been violated. All of the dat:z
Waming in Line 15 —> PER*IC**TE*: [DESCRIPTION:Conditional syntax check failed for segment 'PER’. Buffe="PER*IC**TE*"_]J[CODI
Wamning in Line 24 —> NM1*QC* 1*DEMO*JOHN***MI* 123456789 at Position: 8: [DESCRIPTION:-Value '123456789" not found in Datz
_ Waminn in Lina 24 s MATEO0 T5NEAMC INLIKE S0 17ARRE TR0 =t Broitinn: 8- IMESCRIDTION-Mavimom lanath of d=ts alamant ic
4 1 +

1 Files processed

EDI compliance check results after further processing was aborted.

Files without a valid trading partner will be placed into the "suspended files” directory.
The final action taken after the analysis is recorded at the end of the results.

WaIMINgG In LINE 10/ — LIN N4~ 030,Y 1. £0UU3 8l FOSIIOoN: 12 [UEDLHIF HIUNIUEE SleMment 30U gesignaed Mol Used COon@Ein aaE
Waming in Line 167 —> LIN*N4**63629126003 at Position: 2: [DESCRIPTION:No data in mandatory data element "235" in Data Segm
Wamning in Line 168 —> SE*166*031111112 at Position: 2: [DESCRIPTION:Transaction set/Message header control number "0001" ds
Warmning in Line 169 —> GE*1*1 at Position: 2: [DESCRIPTION:Functional group header control number "00001" does not match traile

The file has 1 Interchanges. 1 Functional Groups and 1 Transaction Sets

The file contains 4 Claims

The file was mowved to: H:\HIPAAsuite\HIPAAsuiteCommDir\Suspense\83keyhealth 837
on 10/17/2012 at 9:50 AM

m

This file's processing was aborted. The file was moved to the suspended files folder

10.4.5 Certificate based authentication in SFTP

SFTP or FTP over secure shell as it is also known is deemed to be the most secure method
of file transport. There are 3 methods of authentication in Sftp.

1. with a user name and password
2. with a user name and a private key cryptographic certificate and

3. with a user name, a certificate and a password
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When you select SFTP as the FTP protocol, you will see two check boxes appear.

@ SFTP
|User + password Auth

private Key Auth

& Fy s 1 L

The sub choices when you select SFTP

Leaving both check boxes unchecked will result in the first option: Authentication with
user name and password. You can also check just the user name and password with the
same result.

In order to use the certificate based authentication you need to create and link to your
own certificate. The certification module that HIPAAsuite employs uses a so called private
key SSH2 certificate in pem format.

How do you create such a certificate? Here is one way:

The free secure shell program putty has the necessary tools. Download putty from
www. putty.org When you install the program you will see several program installed on
your computer.

Organize = Include in library = Share with + Burn MNew folder

. Mezilla Maintenance Service * Marme : Date modified Type Size
-l [ LICENCE 8/6/2013612PM  File 2KB
il 'Q pageant.exe 8/6/2013 6:12 PM Application 144 KB
 MyFree Codec £ plink.exe 8/6/2013612PM  Application 304 KB
) :qi::rSDQL @ pscp.ene 8/6/2013 6:12 PM Application 316 KB
o @ psftp.exe 8/6/2013 6:12 PM Application 328 KB
| Nitre PDF |'_?Q putty.chm 8/6/20132 6:12 PM Compiled HTML ... 438 KB
| Notopad:-< [ putty.cnt 8/6/2013612PM  CNT File 32KB
o @ putty.exe 8/6/2013 6:12 PM Application 484 KB
| PGP @ putty.hip 8/6/2013612PM  Help file 644 KB
L PulTY @ puttygen.exe 8/6/2013 6:12 PM Application 180 KB
T T e [ README 6t 1/23/2007 Text Dacument 2KB
} QuickTime %3 unins000.dat GOM Media file(.d... 4KB
s _ & unins000.exe Application 705 KB
S LS ] website 11/16/2004 11:14 ...  Internet Shortcut 1KB
/ Samsung

The programs and files that come with putty

One of the programs is puttygen.exe. This program creates the necessary keys. When
you start it up, you can generate a key pair.
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.
E PuTTY Key Generator ? 2

File Key Conversions Help

Key
Public: key for pasting into Open55H authorzed_keys file:

zshsa -
AAAARINzaC lyc 2EAAAABJQAAAG EAGIBLNBRIKMOMOFP Sysh5CPhle TINENzo DHS |T:' |
" w3 TulScearsV =
+0rTr2Two3u5¥C In 8D Lpa Dor e Ald ULbedVCip TRXmnfg sV 3Basa Rgwf SRy TOm
OHm/ghulaGrMRVPjnZrkb SCFp0Ve PArWh RH Ta 26ub¥mXSEODHGgbuhikjOIkJJFHE -

Key fingerprint: sshsa 2048 69:2e:37:48:93:90:c2:33:39:2:0ab1:cc: 1 2:ed a3
Key comment: rsadeey-20131230
Key passphrase: Ty

Confimn passphrase: esssssssss

Actions

(Generate a public/private key pair [ Generate ]
Load an existing private key file [ Load ]
Save the generated key Save public key ] [ Save private key ]
Parameters

Type of key to generate:

(71 S5H-1 (R5A) i@ 55H-2 RSA (71 55H-2 DSA

Mumber of bits in a generated key: 2048

Creating a public/private key pair with puttygen

You can save the public and private keys separately as .ppk files but that is not what we
need. But puttygen has also tool to convert the keys to pem files. The top menu has a

g PuTTY Key Generator
File Key [ Conversions | Help
Ky Import key
Public e Exmort OenSSH k vz file:
ssh{sa port pen il
AAAABS Export ssh.com key N ]|
u3VTulA rvll
" . " +0rTr2 Twg3u5¥C Ind 80 Lpa Derl e Aled U dVCip TRXmnfg
tab "Conversions MHm b Na G RV PR Prkh GT FrW= P AR RH T 20 R

Converting the SSH key into a pem certificate

When we click on "Export OptnSSH key" we can then save the key with an .pem ending
and that is it.
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10.5.2

Using Encryption

About Encrytion

EDI Exchange supports the Private Key Infrastructure (PKIl) encryption method. This
type of encryption is the most generally accepted method of protecting EDI Files from
being pried upon by unauthorized persons. Without going further into the details of PKI,
Public-key encryption is a cryptographic technique which enables users to securely
communicate on an insecure public network, and reliably verify the identity of a user via
digital signatures. Read more in Private Key Infrastructure.

A public-key infrastructure (PKI) is a system for the creation, storage, and distribution of
digital certificates which are used to verify that a particular public key belongs to a
certain entity. The PKI creates digital certificates which map public keys to entities,
securely stores these certificates in a central repository, and revokes them if needed.

A PKI consists of:
e A certificate authority (CA) that both issues and verifies the digital certificates.

¢ A registration authority which verifies the identity of users requesting information
from the CA.

e A central directory is a secure location to store and index keys.
e A certificate management system.

EDI Exchange relies on other software to establish the PKI. It only uses the capabilities of
these programs through their Application Programming Interface (APl). You need to
separately install either PGP Desktop or the open source GPG4Win programs and set them
up with the public keys of your trading partners and your own private key.

Setting up Encryption
EDI Exchange allows you to set up the encryption for your EDI files. Follow the steps
below.

1. Access the "Encryption Setup” window by selecting "Encryption Setup” under the "EDI
Exchange” menu.
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TS

Setup Log | EDIExchange | Help

Check EDI File

Trading Partners
Inioi Manager
FTP Chent

SEF Files

EDI Exchange Setup

Encryplion Setup

Creats EDI Exchange Tables
Autoprocess Setup
Automatc Scheduler

EDI Receive Log

EDI Send Log

Request EDI Exchange License
EDI Exchange Livense Informabion

The encryption setup menu

2. The following window will appear.

Encryption Setup

GnuPG

— General Encryption Options
- Onginal Unencrypted Outbound Files

M= E3

¥ Keepa copy inan UnEnCrypled’ Folder
" Delete the original File

& GnuPG

Key Pair Information
Mame (e-mail) for Public Key

Pass Phrase for Private Key

' PGP Desktop

Path to gpg.exe |

The program didn't find GnuP'G executable. Please specify path manually
hittp-ihwownw grupg orgl

or download GnuPG installation from ;

__swe |

Cancel
_ Concet |

197

The encryption setup screen

3. In this window define the following options:

General Encryption Options

¢ Original Unencrypted Outbound Files

e Keep a Copy in an 'Unencrypted’ Folder — When the HIPAAsuite program
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creates an EDI file for a trading partner that has selected encryption, you can
keep an unencrypted copy in the "Outbox/[trading partner]/Unencrypted”
folder. This is useful when you need to go back to the file and check on
problems.

Note: Once you encrypt a file with the public key of your trading partner, you will not be able to
open it again. Only the owner of the private key can decrypt it and read it.

e Delete the Original File — If you do not want to keep the unencrypted copy,
select this option.

e Key Pair Information

e Name (e-mail) for Public Key — Enter name or e-mail that will be used to
encrypt files for you by your trading partners.

e Pass Phrase for Private Key — Enter passphrase here to decrypt files encrypted
previously with the pass phrase.

Note: The keys are identified by the email address of their owner.
e Crypto Program

e GnuPG — Select this option if you have already installed the GnuPG software and
want to use it.

Crypto Program
= | GnuPG PGP Desklop

GnuPG
Path to gpg.exe llﬂ."lPrugmm Files (xB6)NGNUNGnuPG\gpg2 exe

LI __ Cancel | 4

The configuration using GnuPG

Note: When you select GnuPG, the program checks if the executable gpg. exe/ gpg2. exe is present
on your computer. If it is not found, you will have to specify the path manually or install the program
first.

e PGP Desktop — Select this option if you have already installed the PGP Desktop
program and want to use it. You will see a different lower half of the screen,
where you can indicate the location of the keys. PGP Desktop uses "key rings" —
encrypted folders that contain all your keys. The location of these two files is
very important for PGP Desktop.
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— Crypto Program
© GnuPG © PGP Deskiop
Key Rings =
Public |

Private | |
_ save | __ Cancet |

ﬁ.
The configuration using PGP Desktop

4. Once the settings are done, click the "Save" button.

The "Save" button

5. The following notification will appear. Click the "OK" button.

Records Saved

Notification window

10.5.3 Using PGP Desktop

Pretty Good Privacy (PGP) is a data encryption and decryption computer program that
provides cryptographic privacy and authentication for data communication. PGP is often
used for signing, encrypting and decrypting texts, e-mails, files, directories and whole
disk partitions to increase the security of e-mail communications. PGP and similar
products follow the OpenPGP standard (RFC 4880) for encrypting and decrypting data.
For more information, see How PGP works.

EDI Exchange supports PGP encryption and works seamlessly with PGP Desktop and open
source Gpg4Win applications.

PGP Desktop (Symantec’s encryption solutions) is a comprehensive suite of encryption
applications which provides flexible, multi-layered encryption by bundling Drive Encryption
to secure the files stored on local hard drives, and Desktop Email Encryption to secure
confidential data in email. For more information, see PGP Desktop documentation.

PGP Desktop key features:
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1. Hard drive encryption software locks down the entire contents of a laptop, desktop,
external drive, or USB flash drive, including boot sectors, system, and swap files.

2. Enables encrypted email and secure AIM® Instant Messages.

3. Creates storage-independent encrypted containers for transport and sharing of specific
files using included utilities; PGP Self-Decrypting Archive, PGP Virtual Disk, and PGP
Zip.

4. Includes PGP Shredder which can completely destroy unwanted disk-based files and
folders.

5. Drive Encryption can be centrally deployed and managed by Symantec Encryption
Management Server.

PGP Desktop key benefits:

1. Secures email without burdening users, to improve compliance with policies and
regulations without hindering productivity.

2. Allows users to easily and transparently share encrypted files and folders, improving
data security without impacting user productivity.

3. Management by Encryption Management Server centralizes creation, deployment and
management of data security policies and reporting.

PGP Desktop bundles the following products:

1. Drive Encryption. See System Requirements.

2. Desktop Email Encryption. See System Requirements.

3. Encryption Management Server. See System Requirements.

Using GnuPG

GnuPG is an Open Source project for the implementation of the OpenPGP (Pretty Good
Privacy) protocols of encryption. GnuPG allows to encrypt and sign your data and
communication, features a versatile key management system as well as access modules
for all kinds of public key directories. GnuPG, also known as GPG, is a command line tool
with features for easy integration with other applications. Front-end applications and
libraries are also available. Version 2 of GnuPG also provides support for S/MIME.

GnuPG is a free software, so it can be freely used, modified and distributed under the
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terms of the GNU General Public License.

We recommend Gpg4Win for encrypting of your files and emails. Gpg4Win supports both
relevant cryptography standards, OpenPGP and S/MIME (X.509), and is the official GhuPG
distribution for Windows. Gpg4Win contains Kleopatra as one of its Free Software
components. For more information, see Gpg4Win documentation available both in PDF
and HTML versions.

rﬂ Kleopatra (== P
Ly = ¢ (%) %
Import Certificates  Export Certificates Redisplay Stop Operation Lookup Certificates on Server
Find: Wy Certificates - ]
j My Certificates | Trusted Certificates | Other Certificates | E
Name E-Mail Valid From Valid Until Details Key-ID
Martin Sc... Martin.5chol... 2011-12-10 OpenPGP C1F4C4Cs

=

Kleopatra, a certificate manager for OpenPGP and X.509 (S/MIME) and common crypto dialogs

With Kleopatra, it is easy to manage your certificates and create your own ones. It
seamlessly integrates with GnuPG. You can manage the key that you receive from your
trading partners, because there is a screen to view the details of a key.
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10.6

10.6.1

™ Certificate Details ? PS

Cwerview | User-Ds and Certifications | Technical Details | Chain | Dump|

This certificate is currently valid.
User-ID: Chiffaengine Co =chiffaengine@gmail.com=
Validity: from 2011-08-19 12:09 until forever
Certificate type: 2,043-bit RSA
Certificate usage: Signing EMails and Files, Encrypting EMails and Files, Certifying other Certificates
Key-ID: B399D4A0
Fingerprint: BC3FE3157D02D23E12DB8CADIABCBE922B399D4A0
Ownertrust:  unknown

Stored: on this computer
Photo Actions
At the moment, Kleopatra does not support photos Trust Certifications made by this Certificate. ..

in certificates. It has no support for adding, nor for
displaying them. This is for the following reasons:

* Photos give a false sense of security.
* Photos increase the size of cerificates.

Close ] l Help

Certificate details with Kleopatra

Using EDI Exchange Features

Accessing Inbox Manager

Using the Inbox Manager you can access the most important functions of EDI Exchange.
Inbox Manager allows you to download EDI files into the "Inbox" folder and process these
files. This screen handles the post-processing of the EDI files, their compliance check and
auto-processing options.

1. To access the Inbox Manager, click the "Inbox Manager” under the "EDI Exchange”
menu.
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Setup Llog | EDIExchange | Hep

EDI Exchange Setup
Encryption Setup

Create EDI Exchange Tables
Autoprocess Setup
Automatic Scheduler

EDI Receive Log
EDI Send Log

Request EDI Exchange License
ED] Exchange License Information

The "Inbox Manager” menu item

2. The following screen will come up.

Check EDI File Loading EDI Files into Inbox Processing Inbox
| Selectand Check EDIFile | | Download from FTP Server | | Process Inbox ]

Activity Log and Wamings

he "Inbox Manager" window

Read more in:
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e Downloading EDI Files From FTP Server

¢ Processing EDI Files

e Selecting and Checking EDI Files

10.6.2 Checking EDI Files

EDI file analysis based on the HIPAA standards. Compliance with HIPAA EDI rules is an
essential part of the exchange of EDI documents. The standards are the only agreed upon
rules that sender and receiver use to exchange data from completely different backend
systems. Strict adherence is therefore necessary to guarantee frictionless operation.

Unfortunately, HIPAA compliance is difficult and the truth is that many HIPAA EDI files
are truly bad. Syntax errors, omitted loops, missing elements, wrongly formatted
elements — these are the most common EDI errors. Without a true analysis, it is difficult
to say what data ends up in your system.

EDI Exchange has a built-in compliance engine that analyzes each incoming and outgoing
EDI transaction. Line by line, element by element, error reporting provides a powerful
tool to determine the quality of the incoming and outgoing EDI files. All HIPAA file
versions are supported. The compliance check creates a detailed report that lists every
compliance issue. Outgoing files can also be checked and individual transaction in
violation of HIPAA rules can be held back.

Note: You can enable automatic compliance check on outgoing and incoming EDI files. See Setting up
Incoming and Outgoing Files Options.

Follow the instructions below to check EDI files for compliance.

1. Select "Check EDI File" under the "EDI Exchange” menu item.
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EDI Exchange | Help

Check EDI File R

Trading Partners
& Inbox Manager

FTP Client

SEF Files

EDI Exchange Setup
Encryption Setup

Create EDI Exchange Tables
Create 999 Files Tables
Autoprocess Setup

Autormatic Scheduler

EDI Receive Log
EDI Send Leg

Regquest EDT Exchange License

: EDI Exchange License Information

The "Check EDI File" menu item

Alternatively, you can click on the "Select and Check EDI File" button in the Inbox
Manager window. Read more in Accessing Inbox Manager.

Check EDI File Loading EDI Files into Inbox
| Selectand Check EDIFile | Download from FTP Server

| 1| |
Activity Log and Wamings

Filename: 140123142208h.x12
SEF file "HIPAAClaimMaster. SEF_Files 837_005010X222A1. SemRef. SEF" loaded for transaction set: "005010X222A1"
The Transaction type is 837 , Version: 005010X222A1
Passed. No Errors. No Wamings
The file has 1 Interchanges. 1 Functional Groups and 1 Transaction Sets
The file contains 4 Claims

The "Select and Check EDI File" button
2. In the opened file selection dialog, select an EDI file and click "Open.”

3. In the Inbox Manager, you can see the result messages for the operation. The details
are displayed in the "Activity Log and Warnings" area.
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Check EDI File Loading EDI Files into Inbox
_ Selectand Check EDIFile |  Download from FTP Server

Activity Log and Warnings

Filename: 140123142208h.x12
SEF file "HIPAACIaimMaster SEF_Files.837_005010X222A1_SemRef SEF' loaded for transaction set: "005010X222A1"
The Transaction type is 837 . Version: 005010X222A1
Passed. No Ermors. No Wamings
The file has 1 Interchanges. 1 Functional Groups and 1 Transaction Sets
The file contains 4 Claims

The "Activity Log and Warnings" area displaying log messages

10.6.3 Downloading EDI Files From FTP Server

EDI Exchange Inbox Manager allows you to load EDI files into the "Inbox" folder and
process these files. Be sure you have setup FTP settings in the "Remote FTP" tab of the
Trading Partner window (see Setting up Trading Partners).

Follow the instructions below to upload EDI files into the "Inbox" folder.

1. Access the Inbox Manager by clicking the "Inbox Manager” under the "EDI Exchange”
menu.
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SEF Files

EDI Exchange Satup
Encryption Setup

Create EDI Exchange Tables
Autoprocess Setup
Automatic Scheduler

EDI Receive Log

EDI Send Log

Request EDI Exchange License

E EDI Exchange License Information
The "Inbox Manager” menu item

2. Click the "Download from FTP Server" button.

Inbox Manager

Check EDI File ~ Loading EDI Files into Inbox ~— ~ Processing Inbox

[ Selectand Check EDIFile | Download from FTP Server | Process Inbox |
| i

~ Activity Log and Wamings

The "Download from FTP Server" button

3. When the process has been finished, the "Activity Log and Warnings" area displays the
report.
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Inbox Manager M= E
CheckEDIFile — Loading EDI Files into Inbox ~ Pro ing Inbaox
Select and Check EDIFile | | Download from FTP Server | Process Inbox |
Actraty Log and Wamings

Checking FPT zervers at 3:40:15 PM
1 Trading Pariners are set up for FTP transfer
Checking for files at Trading Partner PARTNER 1
Successfully connected to PARTNER 1 s FTP directory
File: test_test edi deleted on server.
1 Files moved from FTP Servers into Inbox

ChProgramData\HIPAAsuite\HIPAA Enraliment v 1 Files mowed fram FTP Servers into Inbox

Activity Log and Warnings information

10.6.4 Processing EDI Files

EDI Exchange Inbox Manager allows you to process EDI files downloaded to the "Inbox"
folder beforehand.

Note: Once you have saved the auto-processing options (see Defining Auto-Processing Options), the
files will not only be analyzed but also processed according to the defined settings. The auto
processing enables you to combine and run multiple fulfillment steps together (for example, export,
saving, printing.)

1. Once Downloading EDI Files From FTP Server is completed, and no errors are displayed,
click on the "Process Inbox" button. This will autoprocess all files present in the EDI
inbox directory.

Inbox Manager M= E
[ Check EDIFile [ Loading EDI Files into Inbax ~ Pro ing Inbax
Select and Check EDIFile | [  Download from FTP Server | Process Inbox )
Activity Log and Warnings

Checking FPT servers at 3:40:15 PM
1 Trading Pariners are set up for FTP transfer
Checking for files at Trading Pariner PARTNER1
Successfully connected to PARTNER1's FTP directory
File: test_test edi deleted on server.
1 Files moved from FTP Servers into Inbox

Ch\ProgramData\HIPAAsuite\HIPAA Enroliment M 1 Files moved from FTP Servers into Inbox

The "Process Inbox" button
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2. Once the processing is completed, review the Activity Log and Warnings information.

Inbox Manager M=
[ Check EDIFile [ Loading EDI Files into Inbox ~ Pro ing Inbox
Selectand Check EDIFile | Download from FTP Server | | Process Inbox |

Alfiles in Inbox have been processed

Activity Log and Wamings:

Filename: 834_09 edi
SEF file "HIPAAEnrolimentMaster SEF_Files 834_X095A1_SemRef SEF loaded for transaction set: "004010X095A1°

Filename: test_test ed:

The file was not recognized as a valid EDI file.

Parser Error: Segment - ISA; Error - ISA segment has not enough elements.
It will not be processed

The file was moved to: CA3\SuspendedFiles\Dtheritest test.edi

on 2/15/2013 at 3:58 PM

2 Files processed

Activity Log and Warnings information

10.6.5 Accessing EDI Receive Log

EDI Exchange has a file log. Each processed file creates an entry in the Trans_Log table.
You can access the "EDI Log" window to query this table and see what files came in and
how they were processed. You can access the EDI Receive Log once the application has
been initialized. Follow the instructions below.

1. To open the "EDI Log" window, select "EDI Receive Log" under the "EDI Exchange” menu
item.

© <2003> Martin Scholl Consulting, Inc.




210

HIPAA Enrollment Master

N

Setup Log | EDIExchange | Help

Check EDI File

Trading Partners
Inioi Manager
FTP Chent

SEF Files

EDI Exchange Satup
Encryption Setup

Create EDI Exchange Tables
Autoprocess Setup
Automatc Scheduler

EDI Receive Log

EDI Send Lag

Request EDI Exchange License
EDI Exchange Livense Informabion

The menu for the EDI Receive Log

2. To display data, specify the time period and select trading partner.

e Time Period — Period of time when the file was processed. Choose one of the

available options:

e Receive Date

¢ Load Date

e Trading Partner Name — You can select your trading partner from the list. If

you select "---All---", all your trading partners will be included.

3. Click on the "Find Log Files" button to see the list of log files corresponding to your

query.
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eoton ~=loix|

— EDI Files

Specify the time period in which the file

was processed

 Time Pesiod

From | 2/26/2013 ~| & Raceive Date

To |z,rzs.'2c|13 -I " Load Date

~ Trading Partner Name

Find Log Files

Specifying the time period

4. The log will be displayed in form of a tree.

eottog =lojx

 EDI Rles:

8 Query

Specify the time period in which the file
was processed
~ Time Period
From | 2/26/2013 *| & Raceive Date

To IZ,I‘ZBJ'ZEHS vI " Load Date

Displayed log

5. You can open the folder icons and see details related to each file.
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1= E
D! Flles Specify the time peniod in which the file
-2 Quesy was processed
=& 1902930005  irt_claim_missing_DTP096.ed

Trans Type: 837 - Time Period
Trading Partner: ~PLEASE FILL THIS RECORD- B = & .
Compliance Check Date: 04/27/2012 From | 2/26/20 Receive Date
Complance Check Time: 1:30 PM To | 22612013 vI  Load Date

Result: Waming in Line 16 => : [DESCRIPTION:Missing mandatory segment in EDI file. Segment PAT is eopecte
Waming in Line 21 -» CLM"A37YH556°3025.0013:A:1 & Pesition: 6: [DESCRIPTION:Mo data in mand
Waming in Line 21 -> CLM™A3TYHS5673025.00™13:A:1 &t Postion: 8 [DESCRIPTION:No data inmand Find Log Files
Waming in Line 21 -> CLM"A3TYH556°3025.00™13:A:1 at Pesition: 9: [DESCRIPTION:Ma data inmand | Trading Partner Mame
Waming in Line 21 -> CLM"A37YHS56"3025.0013:A:1 2 Pesttion: 18: [DESCRIPTION:He data in man
Waming in Line 25 -> HI"BK:T840°ZZ: at Posttion: 2 at SubBlement: 2 [DESCRIPTION:Mo data in mand:
Waming in Line 2B —> NMT71°17"0{" 1285740290 2t Pestion: 3: [DESCRIPTION: Mo data in mandatc
Waming in Line 25 ~> NM1-72*1=="5{"1285740230 at Postion: 3: [DESCRIPTION:No data in mandatc
Waming in Line 25 ~> NM1°72* 175" 1285740230 2t Postion: 4: [DESCRIPTION:No data in mandatc
Waming in Line 37 > SBR™P=Group Name™ 38910 at Position: 3: [DESCRIPTION Value 38910 not f
Waming in Line 37 ~> SBR*F~"Group Name™ 38510 at Position: 3: [DESCRIPTION: Maximum length of
Waming in Line 41 > DMG"DE™19330706°F~RE:E2 &t Postion: 5: [DESCRIPTION: Non-compaste data
Warming in Line 41 > DMG"DE™19330706°F~RE5:E2 at Position: 5: [D

Load Date:

Load Time:

Operator:

[ 0 Records. from to
m-C 310747539 “TEST_EBMC_p_50101x
€3 411479417 Tep0302p

e

Details of the EDI Receive Log

If the records have been exported to the database, you can see the time, date and
record count.

10.6.6 Accessing EDI Send Log

This page contains instructions on how to access the "EDI Send Log" window. It becomes
available once EDI Exchange has been initialized.

1. Select "EDI Send Log" under the "EDI Exchange” menu.

© <2003> Martin Scholl Consulting, Inc.



EDI Exchange 213

Setup Llog | EDIExchange | Help
% | Check EDI File
Trading Partners
Inioi Manager
FTP Chent
SEF Files

EDI Exchange Setup
Encryption Setup

Create EDI Exchange Tables
Autoprocess Setup
Automatic Scheduler

EDI Riecaive Log
EDI Send Log 1
Request EDI Exchange License

P ED] Exchange License Information
The "EDI Send Log" menu

2. The following window will appear:

EDI Send Log

i Specify the time period in which the file
...... was processed

Time Period
From & 52015 ~

To 8/ /2015~

Trading Partner Name

he "EDI Send Log" screen
3. To display the log data, select the time period and a trading partner.

e Time Period — Period of time when the file was processed. Choose one of the
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10.6.7

available options:
e Receive Date
¢ Load Date

¢ Trading Partner Name — Select a trading partner in the list. If you select "---
All---", all trading partners will be included.

4. Click on the "Find Log Files" button to display the list of log files corresponding to your
query.

Listing SEF Files

SEF (Standards Exchange Format) files are repositories of standards information that
define the format of EDI documents. SEF files are the basis for the compliance check
engine that EDI Exchange uses. These files contain all rules of the implementation guide
of a transaction. There is a SEF file for each transaction that EDI Exchange is licensed
for. For example, for 837 transactions we have SEF files for institutional, professional
and dental claims in 4010, 4010A1 and 5010A1 version and the 997 and 999 transactions.

1.To access the list of available SEF Files, select "SEF Files” under the "EDI Exchange”
menu.

Setup Log | EDIExchange | Help
li ; Check EDI File

Trading Partners
Inbox Manager

EDI Exchange Setup
Encryption Setup

Create EDI Exchange Tables
Autoprocess Setup
Automatc Scheduler

EDI Receive Log
EDI Send Log

Request EDI Exchange License
EDI Exchange Livense Informabion

The "SEF Files" menu item

2. The "SEF Files" window will appear.
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[ SEF Files HE=E

* Available Standard Exchange Format (SEF) Files

834_005010220A1. SemRef SEF
834_X095.3EF
834_X09541_SemRefSEF
997_4010.3EF
999_005010%231A1 5EF

A list of SEF files
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11 Bug Reporting and Program Updates
11.1 Reporting an Issue

HIPAAsuite like to make bug fixes fast and transparent. For this purpose we include a
Bug tracker with the HIPAA Enrollment Master. btnet, Bugtracker in ASP.Net is an open
source project. HIPAAsuite implemented Bugtracker.Net in all its products to track bugs
and enhancements. One of the reason we liked btnet was the screen capture capabilities.
We adapted and included this facility.

1. You can reach the Issue Tracker under the Help menu. Click on Help » Report an Issue
in the main menu.

FAHIPAA Envollment Master - 32bit
File Wiew Databasse CodeSsts Image Sebup  Log  EDI Exchangs Hal:nl

o wd  Hel Document akion
t -— Enr - J
g - | £ a w Manal
Dutput Mode About
™ Screen
Check For Update
" Prinker Project History
" Spreadshest Fie = n
& E Report an Issue Chrl+I jl
" ASCI Fia De-Tdentify Ukilicy
| Fil
Mage e Feabures and Licenses

The "Report an Issue” menu item

Alternatively, you can use the arl + | key combination on your keyboard to call the
Issue Tracker. Some screens do not give you access to the menu while they are open,
but the key combination art1 + 1 will call up the issue tracker report screen.

2. Click on "Capture” to snap a picture of your screen.
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B BugTracker.NET Screen Capture

{ Saveas..  CopytoClipboard | Draw with mouse while pressing any key [red arrow ¥| UndolLine

& Create new bug
| Update exitting bug

Bug IDé#: |

The "Capture” button

3. Using the mouse, select the area to make a screenshot which can be attached to the
bug report later.

Selecting the area

4. Once you release the mouse button, the screen capture image appears in the
program.
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] BugTracker.NET Screen Capture Hmm
i | Undo Line Abouk..,

Capiure

% Select aes
© Feieground window
" Cusrent screen

Dulayll] E: Seconds

Dezcophion:

Vou emal bddress

# [Cieste new bug
" Update essting bug

Bugmtl

Screen capture image in the BugTracker

You can enhance your screenshot with drawings. By pressing any key and holding down
the mouse while over the canvas, you can highlight in yellow, free draw in red or make
red arrows. Choose the desired option.

B BugTracker NET Screen Capture

Options for drawing in the BugTracker

You can highlight sections as shown below.

45331 [02/21/2001 | -
___________ oos0z " |oziz1izoon
___________ 99499 7 7 7 | n2/21/2001
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Highlighting a section

You can draw circles as displayed on the following screen-shot.

S

Crraw with mouse while pressing any key | red marker

-

Circling a section

Bl |
£5 Bary Daies 45 Sary Ln
Dara1/z008 11 fUny
92i21/2001 | 1 (UN)
namieoes § 1 (UNY

You can point arrows to pinpoint your concerns.

Unde

Save as.. Copyto Clipboard | Draw with mouse while pressing any key | red arrow &
PR s T R B ]

42 RewCd | 43 Descripion L4 HCPCSRaes 45 Sary Dales 45 Sarv Uni
022112001 1 9 (UN)
kel L4 L) |
D2i21/2001 | 1 (UN)

e T T -

Drawing an arrow

5. Then enter as much information into the Description field as possible.

D_e_s::li:lim

[

Description field

Enler hete ag much dﬁ:mint—;ﬁ
as possible

6. Now enter your email address so that we can get in contact with you.

o
addrezzEgmal.com
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Email Address field

7. Indicate whether this is a new bug or a follow up on an existing issue.

@Emahsnuwh.lg
™ Update essting bug

Bug ID#: I

Options selection

8. Then click on "Send."

i Create new bug
T Update esisting bug

Bug ID#: I

=)

Hel
Exit 2

4

Send button

9. Once the bug information has been submitted successfully, you will receive a
notification. Click "OK."

Posted your descripbion and screenshot to Bug [D# 432

Thank you
LoD

BugTracker notification

10.Then you will receive an email such this.

Mail - - o 0 [ | .- L More ™

BEEZE  HPAA Enroliment Master Issue Report T

Inbox | ) binet@hipaasuite.com

Starred to me [~

Important

Sent Mail Thank you for submitting this issue. It has entered our issue tracking system as bug number :432

Issue report

11. Later you will get updates on the issue by email.
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11.2

Upgrading the Program

By default, the program checks for updates automatically. When the new version is out,
you will see an update report on the "Changes in Versions" window. It shows which
changes have been made and displays all differences between your version and the
current version. To continue with update, click "Update.”

Yersion 3.0.27.1059 of HIPAAEnrollmentMasterbd is now availalbe.
You are using 3.0.26.1253.Do you want to download and install it?

Changes in versions

Iﬁhanga 3 inverzion: 3.0.27.1059

feoed woark with selected printer, added & check if there are insalled pnnters
new databaze field for REF (£X) loop 2300 - CountyCode

added default query. added a check if quiry iz not empty

added CCITT Group 3 (CCITT T 4) comprassion

added CCITT4 and Packbits compression

changed work with log in command line

changed meszage boxwhile check ODBC drver

De-ldentify Uiilite

Cancel "‘

&

The "Changes in Versions" screen with highlighted "Update” button

Then you will need to re-certify the application.

Specify a location on you local PC where to download to download the new version.
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—— — .
- b - =
1O P - Computer ~ 823 [ search Computer ﬂ
Organize - = - ,é,
Sl Recent Places &1 L g ek prives (2)
Local Disk (C:
=l Libraries — = {C:)
@ | ¥ Documents 3.10GB Free of 39.9 GB
¥ Musi
a4 e DATAPARTI (D:)
* = Pictures o -
@ [ videos S0 335GBfree of 422 GB

= Devices with Removable Storage (1)

-] ﬂ Compister
) &y Local Disk (C:) iai VD RW Drive (E2)
® ¢ DATAPARTI (D) vy
€l Metwiork
=
File name: [HiFMErwdmentMerSetm.m El
Save as type: | :I

) Hide Folders ‘ ) Cancel |

The "Save as” window with the "Save"” button highlighted

Then the program will start downloading.

Downloading HIPAAEnrollment™Mastert4

1
Downloading 2% Cancel |

The "Downloading HIPAAEnrollmentMaster” popup

Then you will need to install the application.
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[ HIPAA Enrollment Master [_ ] =]

Welcome to the HIPAA Enrollment Master Setup -
Wizard 249

The installer wll guide you theough the steps requined to install HIFAA Enroliment Master on your
compuiter,

WARNIMG: Thiz computer program is protected by copight law and intermational bieaties.
Unauthonzed duplcation or digtibution of this program, oo any portion of it, may result in severe civil
of criminal penakies, and will be prozecuted to the maximum extent possible undsr the Law,

Cancel Frach ' Hext » I )

jp—

The application installation window with the "Next>" button highlighted

Manual Updates

To switch off automatic updates and stick with the version you have, go select Setup »
Options in the main menu.

E HiPAA Enroliment Master - 64bit

File View Daiabase CodeSets Image _Eeu.p Log EDIExchange Help
» — (s Optons ) |
L Spreadshest Fie Setup
_gllmi Mode e
Sicroen Create Company Setup Table

" Printer

The "Options” menu

Alternatively, you can click on the "Options” button located on the main toolbar.

FEAHIPAA Enroliment Master - G4bit

Fie  View Database CodeSets  Setup  Log  Help

1— 2N Rl *Q Qo

The "Options” button

The following screen will appear. Check the "Never check for update” option.
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~ Excel Files

Output Path for xis Files  |C2 Browse
— ASCII Files

Qutput Path for ASCHI Files IC.'I.E Browse

Processed Files

* Leave in Place T Move " Delete

Moved File Diractory | Erowse
" Leg Document Color

™ Keep a log of every file processed [ On3creen | | OnPaper

e * Red * Red
Eﬁ) T Black " Black

Mever chack for updats
Cancel

s | v | _Concel |,

The "Options” window

Then click "Save."

The "Save" button

To update the application manually, go to Help » Check for Update in the main menu.

FAHIPAA Enrollment Master - 64bit

" Screen
© Printer Project Hstory
" Spreadshest
e Report an Issue Chrl+I
= ASCIl Fle De-Identify Utility
" Image File
Features and Licenses

The "Check for Updates” menu item
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11.3 Accessing Project History

Whether the upgrade is done or you want to know some specific information, you can
open the Project History. This information allows you to know what changes were made
in each version of the HIPAA Enrollment Master.

1. Click the "Project History" under the "Help" menu.

FAHIPAA Enroliment Master - 32bit

File Wiew Database (CodeSets Image Setup Log EDIExchange | Help

5 ’_ lm % @ & wd  Help Documentation

Versions and Changes

(Version 2261700 Releaszed on 2/11/2013 N
SOLExpont334.cs —» fwed izsus with perfarmance while save to SOL Server database, added a check if header table has a primany key
Commandz334, oz -3 to not show enors inlog IF selected Screen mode
Fime34Cieate, cs -> added a check if element G532 is filled

Werzion 2251644 Released on 1/21/2013
EnmclimentFomm,cs > changed print fom
HandleB34 cs - fiwed bug with several 2310 or 2710 loops
FinE3450L5etup. cs, SOLE xportB34 cs. scripts ~> new field in dalabase header table to slore load date.

ersion 3241027 Releazed on 1/1/2003
FimB345S0LE reoliment.cs > fixed bug in header table DataGidyiew after change of quesy
FrmE34Cseate. oz - change: n foim appearance
SOLExport834. cs ~> changed woik with Record |Ds for TRANS_LOG table
FrmE34S 0LE reoliment.cz -> changes in foim appearance, added abdity bo edit database daba n foim

Werzion 3.2.2.1110 Releazed on 11/30/200 2
EDIProcesso.cz, Commands834 o=, SOLExporid34 cs - mprovements in SOL Export performance
FrnZ3dM ain oz > fwed path to image files far viewer
SOLExportd34. o5, CommandsB34.cs -» added a check if there are hields settngs for hle export to database

Werzion 2211628 Releazed on 11/1/2012
EDICommands. oz, Command=34 o= Fim824M ain.cs --» show progress while export
FmExceletup, cs, Exceld34.c -» new field 'BithSequence’ n excel export
FrenS34FvinPrevies, cs - remoneed tool tips 1o avoid unhandled exception
Fing34Main. s, FrmB34Cieate. cs > EDI Exchange added

ersion 30.29.0802 Released on B/227201 2
FimB3450L5aup. o, ST olnayB34 cx SOLExpontB34 cs. scipts > newe database fields Membed D Typed-13, MembeilD4-13, Memberbies
CresteEdif34.cs - fived bugs in INS segment
FimB3450L Setup.cs, SalT ofnayB34 ce SOLExportB34 cs, scipts > neve database fields RepoitStaitD ste, RepaitEndD ale, MaintenanceE flectiveD ate. EniolimentD +

4] | »

Manual |

Dutput Mode Abouk
i

LI Check For Update
" Pinker [ project ristory b
- |

Spreadshest File Report an [ssue Chrl+1
™ ASCI File Die-1dentify Lkiity
™ Imaoe File

! Festures and Licensss
The "Project History" menu item
2. The following window will be opened.
[ Project History M=

&

The "Project History" window

© <2003> Martin Scholl Consulting, Inc.




Index 227

Index
- -

Introduction 2

L -

Loading Benefit and Enrollment Records 6

© <2003> Martin Scholl Consulting, Inc.



	Introduction
	About HIPAA Enrollment Master

	Getting Started
	Starting the Application
	Processing a Benefit Enrollment File
	Working through an Entire Directory
	Understanding Benefit Enrollment and Maintenance Records
	Printing the Records
	Requesting a Trial Extension

	Configuring the Application
	Configuring Program Options
	Using the EDI Editor
	Selecting a Code Set
	Accessing Logs
	Running the Application via Scheduler

	Creating Spreadsheets
	Creating Spreadsheets
	Configuring Spreadsheet Options
	Spreadsheet Limitations

	Creating ASCII Files
	Creating ASCII Flat Files
	Limitations of the ASCII Flat File

	Creating Image Files and PDFs
	Creating Image Files
	Adjusting Image Options
	Viewing Images

	Using the Database
	Exporting the Data
	Setting up Database Connection
	Selecting Fields to Export
	Creating Tables
	Browsing Exported Data
	Troubleshooting

	Creating 834 EDI Files
	Setting up Company
	Creating Company Setup Table
	Creating 834 EDI Files from the Attached Database

	Automating
	Using the Command Line Arguments 1 (CLI)
	Using the Command Line Arguments 2
	Creating EDI Transactions from the Database
	Changing the Default Company
	Running the Application via Scheduler

	EDI Exchange
	Getting Started
	About EDI Exchange
	Requesting EDI Exchange License
	Registering EDI Exchange

	Configuring EDI Exchange (Obligatory Settings)
	1 Setting up Database Connection
	2 Creating Database Tables
	2b Creating 999 File Tables
	2c Updating Database Tables
	3 Defining Auto-Processing Options
	4 Defining Communications Directory
	5 Initializing EDI Exchange

	Configuring EDI Exchange (Optional Settings)
	Setting up Email Notifications
	Setting up Incoming and Outgoing Files Options
	Running the Application via Scheduler
	Using the Command Line Arguments (CLI)

	Working with Trading Partners
	Setting up Trading Partners
	Custom File Naming Conventions
	Using Built-in FTP Client
	Creating a Trading Partner Automatically
	Certificate based authentication in SFTP

	Using Encryption
	About Encrytion
	Setting up Encryption
	Using PGP Desktop
	Using GnuPG

	Using EDI Exchange Features
	Accessing Inbox Manager
	Checking EDI Files
	Downloading EDI Files From FTP Server
	Processing EDI Files
	Accessing EDI Receive Log
	Accessing EDI Send Log
	Listing SEF Files


	Bug Reporting and Program Updates
	Reporting an Issue
	Upgrading the Program
	Accessing Project History


